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Preface

This preface describes the purpose, audience, organization, and conventions of 
this guide, and provides information on how to obtain related documentation.

The preface covers these topics:

• Purpose

• Audience

• Organization

• Related Documentation

• Conventions

• Obtaining Documentation

• Documentation Feedback

• Obtaining Technical Assistance

• Obtaining Additional Publications and Information

Purpose
The Troubleshooting Guide for Cisco CallManager Release 4.0(1) provides 
troubleshooting procedures for the Cisco CallManager. This document does not 
cover every possible trouble event that might occur on a Cisco CallManager 
system but instead focuses on those events frequently seen by the Cisco Technical 
Assistance Center (TAC) or frequently asked questions from newsgroups.
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Audience
Audience
The Troubleshooting Guide for Cisco CallManager Release 4.0(1) provides 
guidance for network administrators responsible for managing the 
Cisco CallManager system, for enterprise managers, and for employees. This 
guide requires knowledge of telephony and IP networking technology.

Organization
Table 1 shows how this guide is organized.

Table 1 How This Document Is Organized

Chapter and Title Description

Chapter 1, “Troubleshooting Overview” Provides an overview of the tools and 
resources that are available for 
troubleshooting the 
Cisco CallManager.

Chapter 2, “Troubleshooting Tools” Addresses the tools and utilities that 
you use configure, monitor, and 
troubleshoot Cisco CallManager 4.0 
and provides general guidelines for 
collecting information to avoid 
repetitive testing and recollection of 
identical data.

Chapter 3, “Installation, Backup, and 
Restore Issues”

Describes solutions for the most 
common issues related to a 
Cisco CallManager installation, 
backup, or restore.

Chapter 4, “Cisco CallManager System 
Issues”

Describes solutions for the most 
common issues related to a 
Cisco CallManager system.
xx
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Organization
Chapter 5, “Directory Issues” Describes solutions for the most 
common issues related to a 
Cisco CallManager DC Directory 
(DCD), the Lightweight Directory 
Access Protocol (LDAP) directory, 
or the Microsoft Active Directory 
(AD).

Chapter 6, “Device Issues” Describes solutions for the most 
common issues related to IP phones 
and gateways.

Chapter 7, “Dial Plans and Routing 
Issues”

Describes solutions for the most 
common issues related to dial plans, 
route partitions, and calling search 
spaces.

Chapter 8, “Cisco CallManager Services 
Issues”

Describes solutions for the most 
common issues related to services, 
such as conference bridges and 
media termination points.

Chapter 9, “Voice Messaging Issues” Describes solutions for the most 
common voice messaging issues.

Chapter 10, “Cisco CallManager 
Attendant Console Issues”

Describes solutions for the most 
common Cisco CallManager 
Attendant Console issues.

Appendix A, “Opening a Case With 
TAC”

Describes what information is 
needed to open a case for TAC.

Appendix B, “Case Study: 
Troubleshooting Intracluster Phone 
Calls”

Describes in detail the call flow 
between two Cisco IP Phones within 
a cluster.

Table 1 How This Document Is Organized (continued)

Chapter and Title Description
xxi
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Related Documentation
Related Documentation
Refer to the following documents for further information about related 
Cisco IP Telephony applications and products:

• Cisco CallManager Administration Guide

• Cisco CallManager System Guide

• Cisco CallManager Serviceability Administration Guide

• Cisco CallManager Features & Services Guide

• Cisco CallManager Quick Start Guide

• Cisco CallManager Installation Instructions

• Cisco CallManager Backup and Restore Procedure

• Cisco CallManager Attendant Console User Guide

• Cisco CallManager Multilevel Administration Access Guide

• Cisco CallManager Directory Services Guide

• Release Notes for Cisco CallManager Release 4.0(1)

• Cisco CallManager Documentation Guide for Release 4.0(1)

• Hardware Configuration Guide for the Cisco Voice Gateway 200

• Software Configuration Guide for the Cisco Voice Gateway 200

• Cisco IP Phone Administration Guide for Cisco CallManager

Appendix C, “Case Study: 
Troubleshooting 
Cisco IP Phone-to-Cisco IOS Gateway 
Calls”

Describes a Cisco IP Phone calling 
through a Cisco IOS Gateway to a 
phone connected through a local 
PBX or on the Public Switched 
Telephone Network (PSTN).

Appendix D, “Case Study: 
Troubleshooting Intercluster Phone 
Calls”

Describes a Cisco IP Phone calling 
another Cisco IP Phone located in a 
different cluster.

Table 1 How This Document Is Organized (continued)

Chapter and Title Description
xxii
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Conventions
• Bulk Administration Tool Guide for Cisco CallManager

• Cisco Technical Solution Series: IP Telephony Solution Guide

• Guide to Cisco Systems VOIP Infrastructure Solution for SIP

Conventions
This document uses the following conventions:

Convention Description

boldface font Commands and keywords are in boldface.

italic font Arguments for which you supply values are in italics.

[ ] Elements in square brackets are optional.

{ x | y | z } Alternative keywords are grouped in braces and separated 
by vertical bars.

[ x | y | z ] Optional alternative keywords are grouped in brackets 
and separated by vertical bars.

string A nonquoted set of characters. Do not use quotation 
marks around the string or the string will include the 
quotation marks.

screen font Terminal sessions and information the system displays 
are in screen font.

boldface screen 
font

Information you must enter is in boldface screen font.

italic screen font Arguments for which you supply values are in italic 
screen font.

< > Nonprinting characters, such as passwords, are in angle 
brackets.
xxiii
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Obtaining Documentation
Notes use the following conventions:

Note Means reader take note. Notes contain helpful suggestions or references to 
material not covered in the publication.

Timesavers use the following conventions:

Timesaver Means the described action saves time. You can save time by performing the 
action described in the paragraph.

Tips use the following conventions:

Tips Means the information contains useful tips.

Cautions use the following conventions:

Caution  Means reader be careful. In this situation, you might do something that could 
result in equipment damage or loss of data.

Warnings use the following conventions:

Warning This warning symbol means danger. You are in a situation that could cause 
bodily injury. Before you work on any equipment, you must be aware of the 
hazards involved with electrical circuitry and familiar with standard practices 
for preventing accidents.

Obtaining Documentation
Cisco provides several ways to obtain documentation, technical assistance, and 
other technical resources. These sections explain how to obtain technical 
information from Cisco Systems.
xxiv
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Obtaining Documentation
Cisco.com
You can access the most current Cisco documentation on the World Wide Web at 
this URL:

http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:

http://www.cisco.com

International Cisco websites can be accessed from this URL:

http://www.cisco.com/public/countries_languages.shtml

Documentation CD-ROM
Cisco documentation and additional literature are available in a Cisco 
Documentation CD-ROM package, which may have shipped with your product. 
The Documentation CD-ROM is updated regularly and may be more current than 
printed documentation. The CD-ROM package is available as a single unit or 
through an annual or quarterly subscription.

Registered Cisco.com users can order a single Documentation CD-ROM (product 
number DOC-CONDOCCD=) through the Cisco Ordering tool:

http://www.cisco.com/en/US/partner/ordering/ordering_place_order_ordering_t
ool_launch.html

All users can order annual or quarterly subscriptions through the online 
Subscription Store:

http://www.cisco.com/go/subscription

Click Subscriptions & Promotional Materials in the left navigation bar.

Ordering Documentation
You can find instructions for ordering documentation at this URL:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm
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Documentation Feedback
You can order Cisco documentation in these ways:

• Registered Cisco.com users (Cisco direct customers) can order Cisco product 
documentation from the Networking Products MarketPlace:

http://www.cisco.com/en/US/partner/ordering/index.shtml

• Nonregistered Cisco.com users can order documentation through a local 
account representative by calling Cisco Systems Corporate Headquarters 
(California, USA) at 408 526-7208 or, elsewhere in North America, by 
calling 800 553-NETS (6387).

Documentation Feedback
You can submit e-mail comments about technical documentation to 
bug-doc@cisco.com.

You can submit comments by using the response card (if present) behind the front 
cover of your document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance
For all customers, partners, resellers, and distributors who hold valid Cisco 
service contracts, the Cisco Technical Assistance Center (TAC) provides 
24-hour-a-day, award-winning technical support services, online and over the 
phone. Cisco.com features the Cisco TAC website as an online starting point for 
technical assistance. If you do not hold a valid Cisco service contract, please 
contact your reseller.
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Cisco TAC Website
The Cisco TAC website provides online documents and tools for troubleshooting 
and resolving technical issues with Cisco products and technologies. The Cisco 
TAC website is available 24 hours a day, 365 days a year. The Cisco TAC website 
is located at this URL:

http://www.cisco.com/tac

Accessing all the tools on the Cisco TAC website requires a Cisco.com user ID 
and password. If you have a valid service contract but do not have a login ID or 
password, register at this URL: 

http://tools.cisco.com/RPF/register/register.do

Opening a TAC Case
Using the online TAC Case Open Tool is the fastest way to open P3 and P4 cases. 
(P3 and P4 cases are those in which your network is minimally impaired or for 
which you require product information.) After you describe your situation, the 
TAC Case Open Tool automatically recommends resources for an immediate 
solution. If your issue is not resolved using the recommended resources, your case 
will be assigned to a Cisco TAC engineer. The online TAC Case Open Tool is 
located at this URL:

http://www.cisco.com/tac/caseopen

For P1 or P2 cases (P1 and P2 cases are those in which your production network 
is down or severely degraded) or if you do not have Internet access, contact Cisco 
TAC by telephone. Cisco TAC engineers are assigned immediately to P1 and P2 
cases to help keep your business operations running smoothly.

To open a case by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227) 
EMEA: +32 2 704 55 55 
USA: 1 800 553-2447

For a complete listing of Cisco TAC contacts, go to this URL:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml
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TAC Case Priority Definitions
To ensure that all cases are reported in a standard format, Cisco has established 
case priority definitions.

Priority 1 (P1)—Your network is “down” or there is a critical impact to your 
business operations. You and Cisco will commit all necessary resources around 
the clock to resolve the situation. 

Priority 2 (P2)—Operation of an existing network is severely degraded, or 
significant aspects of your business operation are negatively affected by 
inadequate performance of Cisco products. You and Cisco will commit full-time 
resources during normal business hours to resolve the situation.

Priority 3 (P3)—Operational performance of your network is impaired, but most 
business operations remain functional. You and Cisco will commit resources 
during normal business hours to restore service to satisfactory levels.

Priority 4 (P4)—You require information or assistance with Cisco product 
capabilities, installation, or configuration. There is little or no effect on your 
business operations.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is 
available from various online and printed sources.

• The Cisco Product Catalog describes the networking products offered by 
Cisco Systems, as well as ordering and customer support services. Access the 
Cisco Product Catalog at this URL:

http://www.cisco.com/en/US/products/products_catalog_links_launch.html

• Cisco Press publishes a wide range of general networking, training and 
certification titles. Both new and experienced users will benefit from these 
publications. For current Cisco Press titles and other information, go to Cisco 
Press online at this URL:

http://www.ciscopress.com

• Packet magazine is the Cisco quarterly publication that provides the latest 
networking trends, technology breakthroughs, and Cisco products and 
solutions to help industry professionals get the most from their networking 
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investment. Included are networking deployment and troubleshooting tips, 
configuration examples, customer case studies, tutorials and training, 
certification information, and links to numerous in-depth online resources. 
You can access Packet magazine at this URL:

http://www.cisco.com/packet

• iQ Magazine is the Cisco bimonthly publication that delivers the latest 
information about Internet business strategies for executives. You can access 
iQ Magazine at this URL:

http://www.cisco.com/go/iqmagazine

• Internet Protocol Journal is a quarterly journal published by Cisco Systems 
for engineering professionals involved in designing, developing, and 
operating public and private internets and intranets. You can access the 
Internet Protocol Journal at this URL:

http://www.cisco.com/en/US/about/ac123/ac147/about_cisco_the_internet_
protocol_journal.html

• Training—Cisco offers world-class networking training. Current offerings in 
network training are listed at this URL:

http://www.cisco.com/en/US/learning/index.html
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C H A P T E R 1

Troubleshooting Overview

This chapter provides the necessary background information and available 
resources to troubleshoot the Cisco CallManager.

The chapter covers following topics:

• Cisco CallManager

• Serviceability

• Hardware and Software Compatibility

• General Model of Problem Solving

• Network Failure Preparation

• IP Telephony Networks

• Where to Find More Information

Cisco CallManager
Cisco CallManager provides the software-based, call-processing component of 
the Cisco IP Telephony Solutions for the Enterprise, part of Cisco AVVID 
(Architecture for Voice, Video and Integrated Data).

The Cisco CallManager system extends enterprise telephony features and 
functions to packet telephony network devices such as IP phones, media 
processing devices, voice-over-IP (VoIP) gateways, and multimedia applications. 
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Serviceability
Additional data, voice, and video services such as unified messaging, multimedia 
conferencing, collaborative contact centers, and interactive multimedia response 
systems interact through Cisco CallManager open telephony application program 
interface (API). 

The Cisco CallManager system includes a suite of integrated voice applications 
for performing voice conferencing and manual attendant console functions. 
Because of this suite of voice applications, no need exists for special-purpose, 
voice-processing hardware.

Supplementary and enhanced services such as hold, transfer, forward, conference, 
multiple-line appearances, automatic route selection, speed dial, last-number 
redial, and other features extend to IP phones and gateways. Because 
Cisco CallManager is a software application, enhancing its capabilities in 
production environments requires only upgrading software on the server platform.

Distribution of Cisco CallManager and all Cisco IP Phones, gateways, and 
applications across an IP network provides a distributed, virtual telephony 
network. This architecture improves system availability and scalability. Call 
admission control ensures that voice quality of service (QoS) is maintained across 
a constricted WAN link and automatically diverts calls to alternate public 
switched telephone network (PSTN) routes when WAN bandwidth is not 
available. 

Cisco CallManager Administration, a web-based interface to the database, 
provides remote device and system configuration and serviceability. This 
interface also provides access to HTML-based online help for users and 
administrators.

Serviceability
Administrators can use the Cisco CallManager Administration service tool to 
troubleshoot system problems. This web-based tool, Serviceability, provides the 
following services:

• Alarms—Saves alarms and events generated by Cisco CallManager services 
for troubleshooting and provides alarm message definitions.

• Trace—Saves trace information generated by Cisco CallManager services to 
various log files for troubleshooting. Administrators can configure, collect, 
and analyze trace information. 
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Hardware and Software Compatibility
• Real-Time Monitoring Tool—Monitors real-time behavior of the components 
in a Cisco CallManager cluster.

• Service Activation—Displays activation status of Cisco CallManager 
services. Administrators use Service Activation to activate and deactivate 
services.

• Control Center—Displays status of Cisco CallManager services. 
Administrators use Control Center to start and stop services.

• Quality Report Tool (QRT)—Provides voice quality and general 
problem-reporting tool for Cisco IP Phones 7940 and 7960.

Access Serviceability from the Cisco CallManager Administration window by 
choosing Applications from the menu bar. Installing the Cisco CallManager 
software automatically installs Serviceability and makes it available.

Refer to the Cisco CallManager Serviceability Administration Guide and the 
Cisco CallManager Serviceability System Guide for detailed information and 
configuration procedures on the serviceability tools.

Hardware and Software Compatibility
Refer to the Cisco CallManager Compatibility Matrix document for compatible 
versions of all Cisco CallManager components.

General Model of Problem Solving
When troubleshooting a telephony or IP network environment, define the specific 
symptoms, identify all potential problems that could be causing the symptoms, 
and then systematically eliminate each potential problem (from most likely to 
least likely) until the symptoms disappear.

The following steps provide guidelines to use in the problem-solving process.

Step 1 Analyze the network problem and create a clear problem statement. Define 
symptoms and potential causes.

Step 2 Gather the facts that you need to help isolate possible causes.

Step 3 Consider possible causes based on the facts that you gathered.
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Network Failure Preparation
Step 4 Create an action plan based on those causes. Begin with the most likely problem 
and devise a plan in which you manipulate only one variable.

Step 5 Implement the action plan, performing each step carefully while testing to see 
whether the symptom disappears.

Step 6 Analyze the results to determine whether the problem has been resolved. It if has, 
the process is complete.

Step 7 If the problem has not been resolved, create an action plan based on the next most 
probable cause on your list. Return to Step 4 and repeat the process until the 
problem has been solved.

Make sure that you undo anything that you changed while implementing your 
action plan. Remember that you want to change only one variable at a time.

Note If you exhaust all the common causes and actions (either those outlined in this 
document or others that you have identified in your environment), contact 
Cisco TAC.

Network Failure Preparation
You can always recover more easily from a network failure if you are prepared 
ahead of time. To determine if you are prepared for a network failure, answer the 
following questions:

• Do you have an accurate physical and logical map of your internetwork that 
outlines the physical location of all of the devices on the network and how 
they are connected as well as a logical map of network addresses, network 
numbers, and subnetworks?

• Do you have a list of all network protocols that are implemented in your 
network for each of the protocols implemented and a list of the network 
numbers, subnetworks, zones, and areas that are associated with them?

• Do you know which protocols are being routed and the correct, up-to-date 
configuration information for each protocol?
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IP Telephony Networks
• Do you know which protocols are being bridged? Are there any filters 
configured in any of these bridges, and do you have a copy of these 
configurations? Is this applicable to Cisco CallManager?

• Do you know all the points of contact to external networks, including any 
connections to the Internet? For each external network connection, do you 
know what routing protocol is being used?

• Has your organization documented normal network behavior and 
performance, so you can compare current problems with a baseline?

If you can answer yes to these questions, faster recovery from a failure results.

IP Telephony Networks
Refer to the Cisco Technical Solution Series: IP Telephony Solution Guide for 
information on troubleshooting IP telephony networks.

Where to Find More Information
Additional Cisco Documentation

• Cisco CallManager Administration Guide

• Cisco CallManager System Guide

• Cisco CallManager Features & Services Guide

• Cisco CallManager Serviceability Administration Guide

• Cisco CallManager Serviceability System Guide

• Cisco WebAttendant User Guide

• BAT Administration Tool User Guide

• Cisco CallManager Quick Start Guide

• Installing Cisco CallManager Release 4.0(1)

• Cisco CallManager Attendant Console User Guide

• Cisco IP Phone Administration Guide for Cisco CallManager

• Cisco VG248 Analog Phone Gateway Software Configuration Guide
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Where to Find More Information
• Cisco Conference Connection Administration Guide

• Cisco IP Conference Station 7935 Administration Guide

• Cisco Technical Solution Series: IP Telephony Solution Guide

• Guide to Cisco Systems VOIP Infrastructure Solution for SIP

• CiscoWorks2000 user documentation at the following URL:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/index.htm
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Troubleshooting Tools

This chapter addresses the tools and utilities that you use to configure, monitor, 
and troubleshoot Cisco CallManager 4.0 and provides general guidelines for 
collecting information to avoid repetitive testing and recollection of identical 
data.

Note To access some of the URL sites listed this document, you must be a registered 
user and you must be logged in.

This chapter contains the following topics:

• Sniffer Traces

• Debugs

• Cisco CallManager Troubleshooting Tools

• Troubleshooting Tips

• Where to Find More Information

Sniffer Traces
Typically, you collect sniffer traces by connecting a laptop or other 
sniffer-equipped device on a Catalyst port that is configured to span the VLAN or 
port(s) (CatOS, Cat6K-IOS, XL-IOS) that contains the trouble information. If no 
free port is available, connect the sniffer-equipped device on a hub that is inserted 
between the switch and the device.
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Debugs
Tip To help facilitate reading and interpreting the traces by the TAC engineer, Cisco 
recommends using Sniffer Pro software because it is widely used within the TAC.

Have available the IP/MAC addresses of all equipment that is involved, such as IP 
phones, gateways, Cisco CallManagers, and so on.

Debugs
The output from debug privileged EXEC commands provides diagnostic 
information concerning a variety of internetworking events relating to protocol 
status and network activity in general.

Set up your terminal emulator software (such as HyperTerminal), so it can capture 
the debug output to a file. In HyperTerminal, click Transfer; then, click Capture 
Text, and choose the appropriate options. 

Before running any IOS voice gateway debugs, make sure that 
service timestamps debug datetime msec is globally configured on the 
gateway.

Note Avoid collecting debugs in a live environment during operation hours.

Preferably, collect debugs during non-working hours. If debugs must be collected 
in a live environment, configure no logging console and logging buffered. To 
collect the debugs, use show log.

Some debugs can be lengthy, so collect them directly on the console port (default 
logging console) or on the buffer (logging buffer). Collecting debugs over a 
Telnet session may have an impact on the device performance, and the result 
could be incomplete debugs, which requires that you recollect them.

To stop a debug, use the no debug all or undebug all commands. Verify that 
the debugs have been turned off by using the command show debug. 
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Cisco CallManager Troubleshooting Tools
Refer to the Cisco CallManager Serviceability Administration Guide and the 
Cisco CallManager Serviceability System Guide for detailed information of the 
following different types of tools that Cisco CallManager Serviceability provides 
to monitor and analyze the various Cisco CallManager systems.

Table 2-1 Serviceability Tools

Term Definition

Real-Time Monitoring 
Tool

This term identifies a program in 
Serviceability that provides real-time 
information about Cisco CallManager 
devices and performance counters.

Alarm Administrators use alarms to obtain 
run-time status and state of the 
Cisco CallManager system. Alarms 
contain information about system 
problems such as explanation and 
recommended action.

Alarm Catalog This term refers to a file containing all the 
Alarm definitions for Cisco CallManager 
services. Serviceability supports multiple 
alarm catalogs that are specific to the 
alarm type.

Alarm Definition Administrators search the alarm 
definitions database for alarm 
information. The alarm definition 
contains a description of the alarm and a 
recommended action.

Alarm Event Levels Administrators determine the level of 
information that an alarm will contain. 
Levels range from general information 
about the system to information for 
debugging purposes only.
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Cisco CallManager Troubleshooting Tools
Alarm Filters Administrators determine the level of 
information an alarm contains and where 
the alarm information gets saved.

Alarm Monitors Cisco CallManager Serviceability allows 
alarms to be sent to different destinations 
called monitors: Windows 2000 Event 
Viewer, CCM trace, SDL trace, SNMP 
trap, and SysLog.

Alert Notify Administrators configure alert 
notifications for performance counters 
and gateway ports/channels by using the 
Real-Time Monitoring Tool. Real-time 
monitoring sends alerts to the 
administrator by e-mail or in a system 
notification (popup) window.

Category Tabs Administrators configure specific 
monitoring windows in real-time 
monitoring for troubleshooting purposes. 
The administrator creates these specific 
windows by using Category tabs.

Chart View The Performance Monitoring Window 
displays performance counters in chart 
view by default. Chart view graphically 
shows the counter information.

Cisco CallManager 
service

Cisco CallManager supports many 
services in the form of software that 
performs a specific function, such as 
TFTP, CTI, or music on hold.

Control Center Control Center tool in Serviceability 
allows administrators to view the status of 
and to start and stop Cisco CallManager 
services.

Term Definition
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Debug Trace Levels Administrators determine the level of 
information that a trace will contain. 
Levels range from general errors to 
detailed errors for debugging purposes 
only.

Device Monitoring Real-time monitoring displays real-time 
information about Cisco CallManager 
devices such as phones and gateways.

Device Monitoring 
Window

The right side of the Real-Time 
Monitoring Tool window displays device 
performance information when the tool is 
monitoring device performance.

Device Name Based 
Trace Monitoring

Administrators obtain trace information 
about selected devices by configuring 
trace parameters for Cisco CallManager 
and Cisco CTIManager services.

Monitoring Objects 
Window

The left side of the Real-Time Monitoring 
Tool window displays 
Cisco CallManager-related objects and 
counters or devices for a cluster. The 
information that displays depends on 
which tab is active in the window.

Objects and counters Windows 2000 provides performance 
data that contains information about 
various objects and counters. Objects are 
the logical groupings of like counters for 
a specific device or feature, such as Cisco 
IP Phones, or Cisco CallManager System 
Performance. Counters measure various 
aspects of system performance. Counters 
measure statistics such as the number of 
registered phones, calls attempted, and 
calls in progress. The Real-Time 
Monitoring Tool monitors the real-time 
statistics generated by these counters.

Term Definition
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Performance Monitoring The Real-Time Monitoring Tool displays 
real-time information about a 
performance counter. Performance 
counters can be system specific or 
Cisco CallManager specific.

Performance Monitoring 
Window

The right side of the Real-Time 
Monitoring Tool window displays counter 
statistics when the tool is monitoring 
counters.

CCM Trace log file 
(formerly SDI Trace) 

Every Cisco CallManager service 
includes a default trace log file. The 
system traces system diagnostic interface 
(SDI) information from the services and 
logs run-time events and traces to a log 
file.

SDL Trace log file This file contains call-processing 
information from services such as 
Cisco CallManager and 
Cisco CTIManager. The system traces the 
signal distribution layer (SDL) of the call 
and logs state transitions into a log file.

Note In most cases, you will only 
gather SDL traces when Cisco 
Technical Assistance Center  
(TAC) requests it of you.

Service status icons Control Center displays three icons that 
represent the status of a service on a 
server:

• Square represents a stopped service.

• Arrow represents a service that is 
running.

• Question mark represents a service 
that is in an unknown state.

Term Definition
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Cisco Secure Telnet
Cisco Secure Telnet allows Cisco Service Engineers (CSE) transparent firewall 
access to the Cisco CallManager node on your site. Using strong encryption, 
Cisco Secure Telnet enables a special Telnet client from Cisco Systems to connect 
to a Telnet daemon behind your firewall. This secure connection allows remote 
monitoring and troubleshooting of your Cisco CallManager nodes, without 
requiring firewall modifications.

Note Cisco provides this service only with your permission. You must ensure that a 
network administrator is available at your site to help initiate the process.

Trace Administrators and Cisco engineers use 
trace files to obtain specific information 
about Cisco CallManager service 
problems.

Trace Analysis This program in presents trace 
information in a format that allows you to 
filter the results.

Trace log file Cisco CallManager Serviceability sends 
configured trace information to this file. 
Two types of trace log files exist: CCM 
and SDL.

Window Status Bar The bottom, right corner of the Real-Time 
Monitoring Tool window displays the 
window status bar. The status bar displays 
five icons: Preferences, Cluster 
Information, Resource Usage, About, and 
Help.

Quality Report Tool This term designates voice quality and 
general problem-reporting utility in 
Cisco CallManager Serviceability.

Term Definition
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Command Line Tools
Command Line Tools prove useful in troubleshooting. The following list gives the 
available command line tools:

• show—Displays the Cisco CallManager database content, the .ini config file, 
memory statistics, and Windows diagnostic information and runs from a DOS 
shell or from a Telnet session into the Cisco CallManager.

• nslookup hostname—Checks for a host-name-to-IP-address resolution.

• netstat - a | more—Checks for socket listens on the correct port number.

• ping hostname—Checks that the machine can be reached via an IP.

• net start—Checks to see whether services are running.

Show Command

Use the Show command line tool to display the contents of the system memory 
statistics and the Windows diagnostic information. You can run the show 
command from a DOS shell or from a Telnet session if Telnet server software is 
enabled. You can display the output data on the console or save it as a text file.

Note Because the show command uses a temporary file in the \Temp directory for the 
output, check to see that you have enough disk space available to receive it. The 
amount that you will need varies depending on a number of factors; for example, 
the number of users and devices being used and the size of the database being used 
by the system.

Alternatively, you can run show.exe from a Telnet session if Telnet server 
software is enabled. 

The following syntax applies for the show command:

show [-f <filename>] [-c <column width>] [-w <console width>] [-v] [command]

Table 2-2 lists options that the show command supports.
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Use the following parameters with the show command:

• ?—Show help message

• db—Show configuration database

• db tables—Show database table names

• db t <tablename>—Show content of the database table

• inst [apps | elem | all]—Show information about installed applications and 
elements.

• isdn [cluster | local | specific]—Show D channel status on gateway.

• ps—Show all processes running on the local system.

• win—Report windows diagnostics. The win command includes, but is not 
limited to, information such as system statistics, storage information, 
software environment, and summary statistics.

Note Show win consumes a significant part of CPU resources to get the 
windows system information and takes a long time to display. 
Execute it only when Cisco CallManager is not busy.

• tech | (none)—Report database and Windows system information.

Note Show tech reports the same multireport output as show command 
without a parameter

Table 2-2 Show Command Options

Command Description

-f  <filename> Name of file to print the report

-c  <col width> Width of each column in the database 
report (default 15)

-w  <con width> Width of the database report area (default 
80)

-v  Verbose mode
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Example:

show -f output.txt -v -w480 db
show tech
show db t ProcessNode

Refer to the Cisco CallManager Serviceability Administration Guide for more 
information on the show command.

Cisco CallManager System Performance Monitoring
Use Windows 2000 Performance to collect and display system and device 
statistics for any local or remote Cisco CallManager installation. This 
administrative tool allows you to gain a full understanding of a system without 
studying the operation of each of its components.It reports both general and 
specific information in real time.

After adding the Cisco CallManager parameters, you can define the terms under 
which Cisco CallManager will display statistics generated by the system.

For more information about Performance, refer to the Microsoft Windows 2000 
documentation.

Path Analysis Operation
Path Analysis, a diagnostic application, traces connectivity between two specified 
points on a network. It analyzes both physical and logical paths (Layer 2 and 
Layer 3) that are taken by packets that flow between those points.

After a call completes, PathTool traces the route of audio packets by specifying 
the directory number of the calling and called parties. This applies to calls among 
any of the following endpoints: Cisco IP Phones, analog devices that are 
connected to a station gateway, or trunk gateways (analog or digital). 

Refer to the Cisco CallManager Serviceability Administration Guide for more 
information.
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System Log Management Process
Although it can be adapted to other network management systems, Cisco 
Syslog Analysis, which is packaged with CiscoWorks2000 Resource Manager 
Essentials, provides the best method to manage Syslog messages from Cisco 
devices. 

Cisco Syslog Analyzer serves as the component of Cisco Syslog Analysis that 
provides a common storage and analysis of the system log for multiple 
applications. The other major component, Syslog Analyzer Collector, gathers log 
messages from Cisco CallManager servers. 

These two Cisco applications work together to provide a centralized system 
logging service for Cisco IP Telephony Solutions. 

Refer to the Cisco CallManager Serviceability Administration Guide for more 
information.

Simple Network Management Protocol Support
Network management systems (NMS) use SNMP, an industry-standard interface, 
to exchange management information between network devices. A part of the 
TCP/IP protocol suite, SNMP enables administrators to remotely manage network 
performance, find and solve network problems, and plan for network growth.

An SNMP-managed network comprises three key components: managed devices, 
agents, and network management systems.

• A managed device designates a network node that contains an SNMP agent 
and resides on a managed network. Managed devices collect and store 
management information and make it available by using SNMP. 

• An agent, as network management software, resides on a managed device. An 
agent contains local knowledge of management information and translates it 
into a form that is compatible with SNMP.

• A network management system comprises an SNMP management application 
together with the computer on which it runs. An NMS executes applications 
that monitor and control managed devices. An NMS provides the bulk of the 
processing and memory resources that are required for network management. 
The following NMSs share compatibility with Cisco CallManager:

– CiscoWorks2000
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– HP OpenView

– Third-party applications that support SNMP and Cisco CallManager 
SNMP interfaces

For detailed information, refer to the Cisco CallManager Serviceability 
Administration Guide and the Cisco CallManager Serviceability System Guide.

CiscoWorks2000
CiscoWorks2000 serves as the network management system of choice for all 
Cisco devices including Cisco CallManager. Because CiscoWorks2000 is not 
bundled with Cisco CallManager, you must purchase it separately. Use the 
following tools with CiscoWorks2000 for remote serviceability:

• System Log

• Path Analysis

• Cisco Discovery Protocol

• Simple Network Management Protocol

Refer to the Cisco CallManager Serviceability Administration Guide and the 
CiscoWorks2000 documentation for more information on CiscoWorks2000 at the 
following URL:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/index.htm

Cisco Discovery Protocol Support
The Cisco Discovery Protocol Support enables discovery of Cisco CallManager 
servers and management of those servers by CiscoWorks2000.

Refer to the Cisco CallManager Serviceability Administration Guide and the 
CiscoWorks2000 documentation for more information on CiscoWorks2000 at the 
following URL:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/index.htm
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Other Tools
Access other available tools, such as the Dick Tracy utility, at the following URL:

http://www-tac/Teams/AVVID/sj/Ttools/ttools.htm

SQL Query Analyzer

The SQL Query Analyzer to find devices, such as endpoints, IP phones, and 
gateways, that are associated with a location. To use the SQL Query, perform the 
following steps.

Note If the value None appears in the Location field in the Cisco CallManager 
Configuration window, the device has not been assigned to a specific location. 
Therefore, devices not assigned to a location do not get returned by the 
SQL Query.

Procedure

Step 1 Choose Start > Programs > Microsoft SQL Server > Query Analyzer on the 
Windows 2000 server console of the Cisco CallManager server to run the SQL 
Server Query Analyzer application. 

The Connect to SQL Server window appears. (The SQL Query Analyzer window 
is dimmed in the background.)

Step 2 In the SQL Server field, type a period character. 

Step 3 Uncheck the Start SQL Server if it is Stopped option. 

Step 4 Click the Windows Authentication button. 

Step 5 Click OK. 

Step 6 The Query (local) window appears. (The SQL Query Analyzer window gets 
dimmed in the background.)

Step 7 From the DB field, click the drop-down arrow and choose the highest numbered 
Cisco CallManager database. 

Cisco CallManager databases are labeled with the following format: CCM03xx 
(where xx is the number of the database).
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Step 8 Enter the following SQL query in the body of the Query (local) window. 

SELECT Device.name, Device.description

FROM Device, Location

WHERE Device.fkLocation=Location.pkid

AND Location.name="enter location name between these quotes"

Step 9 Choose Query > Execute from the main Query Analyzer window to run the 
query. 

You can also click the green arrow from the toolbar or press F5 to run the query.

Step 10 When the results are done, close the SQL Server Query Analyzer window. 

Troubleshooting Tips
The following tips may help you when troubleshooting the Cisco CallManager.

Tip Check the release notes for Cisco CallManager for known problems.

The release notes provide descriptions and workaround solutions for known 
problems.

Tip Know where your devices are registered.

Each Cisco CallManager log traces files locally. If a phone or gateway is 
registered to a particular Cisco CallManager, then the call processing gets done 
on that Cisco CallManager if the call is initiated there. You will need to capture 
traces on that Cisco CallManager to debug a problem.

A common mistake involves having devices registered on a subscriber server, but 
capturing traces on the publisher server. These trace files will be near empty (and 
most definitely will not have the call in them). 
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Another common problem involves having Device 1 registered to CM1 and 
Device 2 registered to CM2. If Device 1 calls Device 2, the call trace occurs in 
CM1 and if Device 2 calls Device 1 the trace occurs in CM2. If you are 
troubleshooting a two-way calling issue, you need both traces from both 
Cisco CallManagers to obtain all the information needed to troubleshoot.

Tip Know the approximate time of the problem.

Multiple calls may have been made, so knowing the approximate time of the call 
helps TAC quickly locate the trouble.

You can obtain phone statistics on a Cisco IP Phone 79xx by pressing the i button 
twice during an active call.

When you are running a test to reproduce the issue and produce information, know 
the following data that is crucial to understanding the issue:

• Calling number/called number 

• Any other number that is involved in the specific scenario 

• Time of call

Note Remember that time synchronization of all equipment is important for 
troubleshooting.

If you are reproducing a problem, make sure to choose the file for the timeframe 
by looking at the modification date and the timestamps in the file. The best way 
to collect the right trace is to reproduce a problem and then quickly locate the 
most recent file and copy it from the Cisco CallManager server.

Tip Save the log files to prevent them from being overwritten.

Files will be overwritten after some time. The only way to know which file is 
being logged to is to choose View >Refresh on the menu bar and look at the dates 
and times on the files.

Tip Verify that the Cisco CallManager services are running.
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Use the following procedure to verify that the Cisco CallManager service is active 
on a server.

Procedure

Step 1 From Cisco CallManager Administration, choose 
Application > Cisco CallManager Serviceability.

The Cisco CallManager Serviceability window displays.

Step 2 Choose Tools > Service Activation as shown in Figure 2-1.

Figure 2-1 Cisco CallManager Serviceability Window Tools Menu

Step 3 From the Servers column, choose the server.

The server that you chose displays next to the Current Server title, and a box with 
configured services displays.

Activation Status column displays either Activated or Deactivated in the 
Cisco CallManager line as shown in Figure 2-2.
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Figure 2-2 Service Activation Window

If Activated, the Cisco CallManager is active on the chosen server.

If Deactivated, continue with the following steps.

Step 4 Check the check box for Cisco CallManager.

Step 5 Click the Update button.

The Activation Status column displays Activated in the Cisco CallManager line.

Cisco CallManager is now active for the chosen server.
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Perform the following procedure if the Cisco CallManager has been in service and 
you want to verify if it is currently active.

Procedure

Step 1 From Cisco CallManager Administration, choose 
Application > Cisco CallManager Serviceability.

The Cisco CallManager Serviceability window displays.

Step 2 Choose Tools > Control Center.

Step 3 From the Servers column, choose the server.

The server that you chose displays next to the Current Server title, and a box with 
configured services displays.

Activation Status column displays Activated in the CallManager line.

Cisco CallManager is active for the chosen server.

Tip Start and stop the Internet Information Server.

Use either of the following procedures to start or stop the Internet Information 
Server (IIS).

Procedure

Step 1 From the Start menu, choose Start > Programs > Administration Tools > 
Services.

A window displays listing the services.

To Stop Services

Step 2 Choose IIS Admin Service.

Step 3 Click the stop button (black square box at the top of the window).

Step 4 Click Yes.
2-18
Troubleshooting Guide for Cisco CallManager Release 4.0(1)

OL-4617-01



 

Chapter 2      Troubleshooting Tools
Troubleshooting Tips
To start Services

Step 5 Click the Start button.

Step 6 Choose World Wide Web Publishing.

Step 7 Click the start button (black square box with right arrow at the top of the window).

The IIS starts.

Procedure

Step 1 From the Start menu, choose Start > Programs > Administration Tools > 
Services.

A window displays listing the services.

To Stop Services

Step 2 Right-click IIS Admin Service.

Step 3 Choose Stop.

The IIS stops.

To start Services

Step 4 Click the Start button.

Step 5 Right-click World Wide Web Publishing.

Step 6 Choose Start.

The IIS starts.

Procedure

Step 1 From the Start menu, choose Start > Programs > Administration Tools > 
Services.

A window displays listing IIS Administration Service.
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Step 2 Right-click IIS Admin Service and choose Stop.

The IIS stops.

Step 3 To start the IIS server:

Right-click IIS Admin Service and choose Start.

The IIS starts.

Where to Find More Information
Additional Cisco Documentation

• Cisco CallManager Serviceability Administration Guide

• Cisco CallManager Serviceability System Guide

• Cisco CallManager Administration Guide

• Installation Guide for Cisco CallManager

• CiscoWorks2000 user documentation at the following URL:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/index.htm
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C H A P T E R 3

Installation, Backup, and Restore 
Issues

This chapter covers solutions for the following most common issues related to a 
Cisco CallManager installation, backup, or restore.

• Quick Upgrade, Backup, and Restore Tips

• Installation Issues

• Upgrade Issues

• Backup and Restore Issues

If the following procedures do not solve your problem, contact TAC for a more 
detailed investigation.

For the latest information to the Cisco IP Telephony Operating System, SQL 
Server, Security Updates, refer to the following URL:

http://www.cisco.com/univercd/cc/td/doc/product/voice/c_callmg/osbios.htm

For the Cisco CallManager Compatibility Matrix, refer to the following URL:

http://www.cisco.com/univercd/cc/td/doc/product/voice/c_callmg/ccmcomp.htm
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Quick Upgrade, Backup, and Restore Tips
Use the following quick tips to help avoid issues when performing upgrades, 
backups, and restores to your system:

• Restore Location When You Have Two Different Versions of 
Cisco CallManager

• BAT for Faster Transfer of Data

• Upgrade, Backup, and Restore

• Back Up the Publisher

• Third-Party Backup Utilities

Restore Location When You Have Two Different Versions of 
Cisco CallManager

Tip Do a system restore on the same Cisco CallManager version. Changes from 
release to release cause problems if you try to restore from a different version.

BAT for Faster Transfer of Data

Tip Build a clean system; then, use the Bulk Administration Tool (BAT) to import 
your phones and users.

Upgrade, Backup, and Restore

Tip Perform your upgrade, run the Cisco IP telephony Applications Backup Utility, 
rebuild the new system from scratch, and restore the backup tape.
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Back Up the Publisher

Tip Back up only the publisher server in a Cisco CallManager cluster. All other 
servers (subscribers) copy over the information on installation.

Third-Party Backup Utilities
For the Unity backup, you need a third-party application.

Note Cisco does not support third-party utilities for backing up the Cisco CallManager 
database. Doing so voids your TAC support.

Tip Use the included Cisco IP telephony Applications Backup Utility to back up the 
Cisco CallManager database to a separate machine. Then, use that separate 
machine to run your third-party backup software.

Installation Issues
For detailed documentation on installation and troubleshooting installs, refer to 
the Installation Guide for Cisco CallManager at the following URL:

http://www.cisco.com/univercd/cc/td/doc/product/voice/c_callmg/

and click Installation Instructions to find the document with the release number 
for your system software version.

Also refer to the Release Notes for Cisco CallManager for any installation issues 
for your current software version.

This document covers the following installation issues:

• Unable to Change the Server Name for Cisco CallManager
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• Boot Failure Recovery

• One Publisher, Two Subscribers: All Three Databases Have Different 
Information After an Install on One Subscriber

Unable to Change the Server Name for Cisco CallManager

Symptom

You attempt to change the name of the Cisco CallManager server and the service 
fails. Other services also fail, such as CTI Manager, Extended Functions, and 
Voice Media Streaming.

Probable Cause

Cisco does not support changing the name of a Cisco CallManager server.

Corrective Action

Change the IP address instead of changing the name of a Cisco CallManager 
server. See Chapter 4, “Cisco CallManager System Issues” to change the IP 
address.

Boot Failure Recovery
The following URL provides detailed Boot Failure recovery procedures:

http://www.cisco.com/warp/public/130/recovery_index.shtml
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One Publisher, Two Subscribers: All Three Databases Have 
Different Information After an Install on One Subscriber

Symptom

Error Message looking for ccmxxxx databases in 
(local).master.dbo.sysdatabases table

Probable Cause

The subscriber build failed.

Corrective Action

Procedure

Step 1 Ensure that the NetBIOS name resolution is working between all servers.

Step 2 Ensure (by editing) that the hosts and LMHOSTS are filled in on the publisher and 
subscriber servers, so each one can resolve the other’s host name and NetBIOS 
name.

Hosts is used for DNS resolution. LMHOSTS uses NetBIOS for name resolution. 
Also, SQL uses NetBIOS for name resolution.

Step 3 From the web, upgrade the Cisco CallManager for the software version on your 
publisher.

The software will download the SQL database to the subscriber(s).
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Upgrade Issues
This section covers the following issues for Cisco CallManager upgrades:

• Subscriber Upgrade Fails: Unable to Find Updated Database

• Blank Enterprise Parameters Page After Upgrade

• Related Information

Subscriber Upgrade Fails: Unable to Find Updated Database

Symptom

During the upgrade of a publisher and a number of subscribers in Cisco 
CallManager 3.x, there are several instances whereby no error messages appear. 
However, when rebooting the servers in the cluster, neither phones or devices 
register with the correct subscribers. 

Often, failover between Cisco CallManager nodes in a cluster also fail. In 
addition, checking the Application Event Viewer will show many instances of the 
Cisco CallManager service stopping and starting repetitively. 

Probable Cause

Access the SQL Enterprise Manager and open both publisher and subscriber 
databases. Check the latest Cisco CallManager database version (CCM030X) on 
the publisher and for each subscriber. If, when viewing the publisher and 
subscriber(s) databases within the SQL Enterprise Manager, you notice that the 
subscriber(s) do not have the most current database, you are probably 
experiencing a naming resolution problem within your network.
3-6
Troubleshooting Guide for Cisco CallManager Release 4.0(1)

OL-4617-01



 

Chapter 3      Installation, Backup, and Restore Issues
Upgrade Issues
Another way to verify this problem is to refer to the newest Database Upgrade log 
found at C:\Program Files\Common Files\Cisco\Logs. Scroll down and look for 
the following: 

4-28-2002 10:54:00 _DBPullSubscription: CALLMAN01 CCM0302 sa 
******** CALLMAN02

CCM0302 sa ******** C:\Program Files\Cisco\Bin\ 0

4-28-2002 11:11:32 Pulling subscription from CALLMAN01 to 
subscribe to the CCM0302 Database.

Return Code = 8 DB_SCRIPT_ERROR

The output shows that, while the subscriber was able to contact the publisher and 
determine the correct database version, there were problems that prevented it from 
being copied or replicated.

Corrective Action

The Microsoft SQL Server uses NetBIOS name resolution for some types of 
remote-procedure call (RPC) tasks. Because of this, the publisher and all 
subscribers should use the LMHOSTS file for NetBIOS name resolution. All 
servers in the cluster should also use HOSTS files for proper name resolution 
between the servers. 

Windows 2000 includes sample HOSTS and LMHOSTS files (HOSTS.SAM and 
LMHOSTS.SAM) in the directory C:\winnt\system32\drivers\etc. Use the 
following process to modify the sample files for your custom installation. 

Procedure

Step 1 Open the file C:\winnt\system32\drivers\etc\hosts.sam from the 
Cisco CallManager publisher using a text editor such as Notepad.

Step 2 Read the comment lines that start with the # symbol. Then delete all lines from 
the file. Windows must parse every line in the file for every attempt at name 
resolution.
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Step 3 Enter the IP address of the publisher, a space, and the hostname of the publisher. 
The hostname can be found by using the ipconfig /all command.

Repeat until the file contains one line for each server in the cluster. The following 
is a sample hosts file: 

127.0.0.1           localhost
172.18.110.90       ICSCM1
172.18.110.94       ICSCM2

Step 4 Save the file as C:\winnt\system32\drivers\etc\hosts without any extension.

Note Notepad appends a .txt extension by default. Therefore, use Windows 
Explorer or a command prompt to remove the .txt extension. 

Note Windows Explorer hides file extensions by default. Therefore, make sure 
you are viewing file extensions or just use the rename command. 

Step 5 Use a text editor such as Notepad and open the file 
C:\winnt\system32\drivers\etc\lmhosts.sam.

Step 6 Read and then delete all of the comment lines. Add one line for each server but 
append the text #PRE after the name of the server. The following is a sample 
lmhosts file:

172.18.110.90     ICSCM1     #PRE
172.18.110.94     ICSCM2     #PRE

Step 7 Save the file as C:\winnt\system32\drivers\etc\lmhosts without any extension.

Note Notepad appends a .txt extension by default. Therefore, use Windows 
Explorer or a command prompt to remove the .txt extension. 

Note Windows Explorer hides file extensions by default. Therefore, make sure 
you are viewing file extensions or, use the rename command. 
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Step 8 Open a command prompt and enter the nbtstat -R command to load the contents 
of the LMHOSTS file into the NetBIOS name cache. Use the nbtstat –c command 
to verify that the LMHOSTS file was successfully parsed and loaded. If no 
information is listed, please see Microsoft Knowledge Base article Q180099 .

Note The NetBIOS Remote Cache will only contain name-to-address 
resolution for remote nodes. 

Step 9 Select Start > Run and type services.msc. 

Step 10 Click OK.

Step 11 Click DNS Client Service, right-click on the service name, and click Restart.

Step 12 Repeat steps 1-11 for each Cisco CallManager server in the cluster.

Step 13 Re-run the Cisco CallManager upgrade on the subscribers. 

Verification

If successful, the subscribers have the current Cisco CallManager database and 
are pulling the subscription successfully from the publisher. 

Blank Enterprise Parameters Page After Upgrade

Symptom

No field or variable information displays on the Enterprise Parameters page. All 
other pages display correctly.

Probable Cause

Refer to CSCdv65210—Issues occur where an upgrade was not moving all the 
information to the database.
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Corrective Action

Reinitialize the pages by running

C:\Program Files\Cisco\bin\Xmltemp\installxml.vbs

Verification

The Enterprise Parameters page displays correctly.

Related Information
For detailed information on upgrading your Cisco CallManager, refer to 
Upgrading Cisco CallManager and locate your release number at the following 
URL:

http://www.cisco.com/univercd/cc/td/doc/product/voice/c_callmg/

Click Installation Instructions to find the document for your specific software 
release. 

The following URL provides information that is located on the TAC site:

http://www.cisco.com/warp/public/130/upgrade_index.shtml

Backup and Restore Issues
This section covers the following issues for backups:

• Backup to Local Tape Drive Is Not Working and Terminates with Error Code 
1165

• When Installing Cisco CallManager, No Prompt Displays for a Backup 
Destination

• Sti Backup Utility in Cisco CallManager Stuck on “Cancelling Backup”

• After a Restore, Database Is Corrupt
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The Cisco IP telephony Applications Backup Utility automatically backs up the 
following items:

• Cisco CallManager database on SQL Server 2000, including the Call Detail 
Records (CDR) database

• Administrative Reporting Tool (ART) database

• DC Directory, LDAP directory

• Distribution .ini, which contains the publisher and subscriber configuration 
information

• Database.dat, if present

• HKLM\Software\Cisco Systems, Inc.

• Cisco Customer Response Applications (CRA)

For detailed information on backing up the Cisco CallManager, refer to the 
Backing Up and Restoring Cisco CallManager and locate your release number at 
the following URL:

http://www.cisco.com/univercd/cc/td/doc/product/voice/c_callmg/

Click Installation Instructions to find the document for your specific software 
release.

Backup to Local Tape Drive Is Not Working and Terminates with 
Error Code 1165

Symptom

Error Message 1165 The device has indicated that cleaning is 
required before further operations are attempted. 
ERROR_DEVICE_REQUIRED_CLEANING

Probable Cause

Issues exist with the tape drive or the tape.
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Corrective Action

Refer to your hardware documentation for details on cleaning the tape drive, or 
try using a different, clean tape.

Verification

Backup successfully completes with no errors.

When Installing Cisco CallManager, No Prompt Displays for a 
Backup Destination

Symptom

You cannot locate the backup folder or the Cisco IP telephony Applications 
Backup Utility.

Probable Cause

If you are installing Cisco CallManager for the first time, you may have clicked 
Cancel on the backup display. If so, the backup destination was not created.

Corrective Action

Two ways exist for you to install the backup utility into the correct folder:

• Copy the “backup” folder from any other blade, which has installed the 
Cisco IP telephony Applications Backup Utility, and run the 
_stBackSetup.exe file.

• Run setup.exe from the “Backup” folder off of the root directory of the 
Cisco CallManager CD.
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Sti Backup Utility in Cisco CallManager Stuck on “Cancelling 
Backup”

Symptom

When running the Sti BackupUtility, the following message displays:

"Cancelling backup process. Please wait.." 

The message does not disappear when you attempt to cancel the backup process 
after noticing that the backup never executed (via the status monitor).

Note Rebooting the server will not solve the problem.

Corrective Action

Procedure

Step 1 Note the value of the Config registry key in the Registry Editor window.

Step 2 From the Windows Start button, choose Run and enter regedit. 

Step 3 From the Registry Editor, choose HKEY_LOCAL_MACHINE > SOFTWARE 
> Cisco Systems > Backup > Config. 

Step 4 Manually change the value of the Config registry key to 0. 

Step 5 Manually stop the StiView.exe process in the Cisco CallManager by pressing 
Ctrl-Alt-Del and choosing Task Manager. 

The Windows Task Manager displays,

Step 6 Click the Processes tab, choose stiView.exe, and click the End Process button. 

Alternate Solution

From your system directory, select C: > WINNT > SYSTEM32 and run the 
StiBack.exe file.
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After a Restore, Database Is Corrupt

Symptom

A backup and restore appear to successfully complete on the publisher and 
subscriber servers. One database is missing information. Each database shows 
different versions of the software.

Probable Cause

A backup was made of one version, and the restore was to a newer software 
version.

Corrective Action

You must do a system restore on the same Cisco CallManager version. Changes 
from release to release would cause problems if you tried to restore from a 
different version.

Use the following procedures to restore databases.

Note Always perform these procedures from the publisher server. Make sure Cisco NT 
services and IIS Admin service are stopped.

Backup the SQL Database

Procedure

Step 1 Choose Start-Programs > Microsoft SQL Server 2000 for Cisco CallManager 
version 4.0.

Step 2 Click Enterprise Manager.

Step 3 Double-click Microsoft SQL Servers.

Step 4 Double-click SQL Server Group.

Step 5 Double-click the machine name (the DNS name of the machine).
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Step 6 Double-click Databases.

Step 7 Click the highest level database beginning with CCM.

Step 8 Choose Tools > Backup Database.

Step 9 Choose Database — complete and Overwrite existing media.

Step 10 Click Add.

Step 11 Enter the type in a file name in the default path.

Step 12 Click OK.

Restore the SQL Database for the Purpose of Viewing the information

Procedure

Step 1 Ensure you have backed up your database (see the “Backup the SQL Database” 
procedure).

Unpublish your current database

Step 2 Ensure that all Cisco NT services and the IIS Admin service are stopped.

Step 3 Choose Start > Programs > Microsoft SQL Server 2000.

Step 4 Click Enterprise Manager.

Step 5 Choose Microsoft SQL Servers > SQL Server Group.

Step 6 Click on your server name.

Step 7 Right-click Server Name > Replication.

Step 8 Choose Configure Publishing > Subscribers > Distribution.

Step 9 Click the Publication Database tab in the pop-up window.

Step 10 Uncheck the name of your currently published database.

Step 11 Click OK.

Restore the Customer Database

Step 12 Ensure that all Cisco NT services and the IIS Admin service are stopped.

Step 13 Place the customer backup file in C:MSSQL2000\BACKUP.
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Step 14 Choose Start > Programs > Microsoft SQL Server 2000.

Step 15 Click Enterprise Manager.

Step 16 Choose Microsoft SQL Servers > SQL Server Group.

Step 17 Double-click Databases.

Step 18 Click the highest numbered database beginning with CCM.

Step 19 Click Restore Database.

If you backed up a database and want to restore that database

Step 20 Choose first backup to restore.

Step 21 Choose Database — complete.

Step 22 Click OK.

Step 23 If you restore a different database to this machine

Step 24 Choose Restore — from device.

Step 25 Click Select Devices.

Step 26 Click Add and enter the filename from which you are restoring.

Step 27 Choose Database — complete.

Step 28 Click OK.

Step 29 The following message displays:
Restore of database CCMxxxx completed successfully.

Now you can view the contents of the database by clicking on it in the main 
window and looking at its tables, users, and other information.

When you are ready to restore your former database, republish it by choosing 
Server Name > Replication and right-click Configure Publishing > 
Subscribers > Distribution and checking your original database.
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Restore a Customer Database to Work With Cisco CallManager on Your Machine

Procedure

Step 1 Repeat the previous procedures for unpublishing your database and restoring the 
Customer Database.

Step 2 From the Enterprise Manager, delete the following three default users: 
CiscoCCMUser, CiscoCCMCDR, and CiscoCCMReader by choosing Tools > 
SQL Server Query Analyzer. 

You can also access the Query Analyzer from Start > Programs > Microsoft 
SQL Server > Query Analyzer.

Step 3 Choose your database from the pull-down menu in the upper right corner of the 
screen.

Note Choosing the correct database name is important. Otherwise, you risk 
deleting users from the wrong database.

Step 4 Enter Sp_dropuser CiscoCCMUser and click Go.

Step 5 Click the Play button.

Step 6 The following message displays:
User CiscoCCMUser successfully removed from database.

Step 7 Enter Sp_dropuser CiscoCCMCDR and click Go.

Step 8 Click the Play button.

Step 9 The following message displays:
User CiscoCCMCDR successfully removed from database.

Step 10 Enter Sp_dropuser CiscoCCMReader and click Go.

Step 11 Click the Play button.

Step 12 The following message displays:
User Cisco CCMReader successfully removed from database.

Add the three default users for your machine

Step 13 Right-click Users in the main screen under your database name.

Step 14 Choose CiscoCCMUser and check the "db_owner" box for this user.
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Step 15 Click OK.

Step 16 Choose CiscoCCMCDR -and check the "db_owner" box.

Step 17 Click OK.

Step 18 Choose CiscoCCMReader and check the “db_datareader" box.

Step 19 Click OK.

Configuring database tables

ProcessConfig table

Step 20 Choose Tables > ProcessConfig. 

Step 21 Right-click ProcessConfig.

Step 22 Choose open > return all rows. 

Step 23 Click the SQL button and Run the following SQL query:

SELECT  *
FROM ProcessConfig
where
tkservice = 9

ORDER by paramname
choose the exclamation point to run

Step 24 Make note of the paramValue for GlassHouseNodeID 
ParamValue for the GlassHouseNodeId in this table matches the fkProcessNode 
string in the Cisco CallManager and pkid string in ProcessNode.

Note The first set of digits are the least significant.

Step 25 Change the Server names in all the DBConnection records to match the machine 
name of your publisher machine.

Step 26 Change the database names in the DBConnection records to match the current 
database name.

ProcessNode table

Step 27 Choose Tables > ProcessNode.

Step 28 Right-click on ProcessNode and choose open > return all rows.
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Step 29 Change the 'name' column for the publisher (pkid=glassHouseNodeID you 
previously noted) to be the ip address or machine name of your machine.

CallManager table

Step 30 Choose Tables > CallManager.

Step 31 Right-click on CallManager and choose open > return all rows.

Step 32 Change the 'processNodeName' column for the CallManager record where 
fkprocessnode=glassHouseNodeID is correct machine name or the IP address you 
changed in the ProcessNode table.

Check the registry settings

Step 33 Open the registry to HKEY_LOCAL_MACHINE > SOFTWARE.

Step 34 Click Cisco Systems, Inc.

Step 35 Click DBL.

Step 36 Note the value of the DBConnection0 key.
In the value, ensure the value of SERVER is the DNS name of the publisher and 
that the database version name is correct.

Publish the database

Step 37 Return to the main tree in Enterprise Manager.

Step 38 Click on the server name.

Step 39 Choose New > Publication.

Step 40 Click Next.

Step 41 Choose your database name.

Step 42 Click Next.

Step 43 Choose Transactional.

Step 44 Click Next.

Step 45 Click Next.

Step 46 Choose publish all tables.

Step 47 Click Next.

Step 48 Click Next.
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Step 49 Click Next.

Step 50 Click Finish.

Related Information
The following few Microsoft utilities will help you find out what OS patches 
apply to your Cisco CallManager.

• Hfnetck.exe—Displays programs and service pack that are installed on the 
box and whether newer patches are available.

• Serverinfo.exe—Displays basic information and statistics on the system.

• Qfecheck.exe—Displays which HotFixes are installed. This utility does not 
work for SQL and Internet Explorer HotFixes. Qfecheck also spikes the 
processor during the time it runs. Cisco recommends that you run this utility 
only in a maintenance window.

To view the HotFixes that apply to Internet Explorer, perform the following 
steps.

Procedure

Step 1 Open your Internet Explorer and click Help > About Internet Explorer.

Step 2 View the Update Versions line.

This line will list the Knowledge Base number for each installed HotFix.
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C H A P T E R 4

Cisco CallManager System Issues

This chapter covers solutions for the following most common issues related to a 
Cisco CallManager system.

• Cisco CallManager System Not Responding

• Replication Fails Between the Publisher and the Subscriber

• Slow Server Response

• JTAPI Subsystem Startup Problems

• Security

• Virus Protection

Cisco CallManager System Not Responding
This section covers the following issues for a Cisco CallManager system not 
responding:

• Cisco CallManager System Stops Responding

• Cisco CallManager Administration Page Does Not Display

• Errors Occur When Attempting to Access the Cisco CallManager 
Administration Page from the Browser

• You Are Not Authorized to View This Page

• Errors Occur When Attempting to Access the Cisco CallManager 
Administration Page from a Browser on a Remote Server

• Name to Address Resolution Failing
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• Default Web Site Under IIS Has Improper Setting

• Port 80 Is Blocked in One or More Routers Between Your Local Browser and 
the Cisco CallManager Server

• You Attempt to Access a Machine Where Access Is Explicitly Denied

• Improper Network Setting Exists in the Remote Machine From Where You 
Are Browsing

• Replication Fails Between the Publisher and the Subscriber

Cisco CallManager System Stops Responding

Symptom

The Cisco CallManager system does not respond.

Probable Cause

When the Cisco CallManager service (ccm.exe) crashes, the following message 
displays in the System Event log: 

The Cisco CallManager service terminated unexpectedly. 

It has done this 1 time. The following corrective action 

will be taken in 60000 ms. Restart the service.

Other messages you may see in the event of a crash are: 

Timeout 3000 milliseconds waiting for 

Cisco CallManager service to connect.
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The Cisco CallManager failed to start due to the following error.

The service did not respond to the start or control request in 
a timely fashion.

At this time, when devices such as the Cisco IP phones and gateways unregister 
from the Cisco CallManager, users receive delayed dial tone, and/or the 
Cisco CallManager server freezes due to high CPU. For event log messages not 
included here, view the Cisco CallManager Event Logs. 

The Cisco CallManager service can crash due to one of the following reasons: 

• An unexpected event occurs in the Cisco CallManager service. This crash 
adds an entry to the existing Dr.Watson log and a user.dmp is generated in the 
C:\Documents and Settings\All Users\Documents\DrWatson folder. 

• The Cisco CallManager service does not have enough resources such as CPU 
or memory to function. Generally, the CPU utilization in the server is at 100% 
at that time. 

Depending on what type of crash you experience, you will need to gather different 
data that will help determine the root cause of the crash. 

Unexpected Event

Use the following procedure as a guide for what to gather and provide to TAC in 
the event of Cisco CallManager crash.

Procedure

Step 1 Collect Cisco CallManager traces fifteen minutes before and after the crash. The 
traces are located at C:\Program Files\cisco\trace\ccm. 

Step 2 Collect SDL traces fifteen minutes before and after the crash. Traces are located 
at C:\Program Files\cisco\trace\sdl\ccm. 

Step 3 Locate the System and Application Event log files in the Event Viewer by 
selecting Start > Programs > Administrative Tools > Event Viewer, clicking on 
System Log, and selecting Action > Save Log as and save the log. Also do this for 
the Application Log. 
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Step 4 Ensure that the SdlMaxUnhandledExceptions parameter is set to 0 (zero) for each 
Cisco CallManager. 

Step 5 Locate the Dr. Watson log file located at
C:\Documents and Settings\All Users\Documents\DrWatson. 

The file is named Drwtsn32.log. 

Step 6 Locate the user.dmp file at C:\Documents and Settings\All 
Users\Documents\DrWatson. 

Note These files can be very large. Zip them before sending them to the TAC. 
It is important to note that these files hold the information the TAC 
engineer and developers need to determine the cause of the crash. 

Step 7 Open the Dr. Watson log file in Notepad and view the most recent entry to see if 
an entry for the ccm.exe has been added. Begin at the bottom of the file, and 
search for Application exception occurred, which takes you to the latest crash. 

The following is an example of the header of a crash entry in the Drwtsn32.log 
file. 

Application exception occurred:
        App:  (pid=680)
        When: 3/8/2003 @ 14:01:06.978
        Exception number: e06d7363 

Along with the date of the crash, there is a PID. If that PID corresponds to the PID 
for ccm.exe in the task list, then you know that Cisco CallManager crashed. 

Note In the following example, the PID = 680. From the list, you see that this 
also corresponds to ccm.exe. 

The task list in the Drwtsn32.log looks similar to the following: 

Example
PID  PROCESS
   8 System.exe
 212 SMSS.exe
 240 CSRSS.exe
 264 WINLOGON.exe
 292 SERVICES.exe
 304 LSASS.exe
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 424 termsrv.exe
 520 svchost.exe
 560 msdtc.exe
 696 DLLHOST.exe
 736 Ipvmsapp.exe
 752 DLLHOST.exe
 824 AudioTranslator.exe
 848 RisDC.exe
 860 LogoutService.E.exe
 884 DCX500.exe
 936 svchost.exe
 980 LLSSRV.exe
1028 sqlservr.exe
1112 ntpd.exe
1140 rcmdsvc.exe
1172 regsvc.exe
1176 mstask.exe
1204 SNMP.exe
1244 WinMgmt.exe
1260 cpqnimgt.exe
1284 cqmgserv.exe
1296 cqmgstor.exe
1308 sysdown.exe
1372 cqmghost.exe
1524 aupair.exe
1552 sqlagent.exe
 276 svchost.exe
2400 inetinfo.exe
2412 explorer.exe
2752 sqlmangr.exe
2700 taskmgr.exe
2704 mmc.exe
 680 ccm.exe
 868 DRWTSN32.exe

If there is no list of the PIDs, look at the timestamp of the last entry of the 
Drwtsn32.log and the timestamp of the error in the Event Log (refer to the 
Cisco CallManager Service Crash Description section). If they are the exact same 
time, it is likely that you experienced an Unexpected Event Cisco CallManager 
crash. 

What makes a crash unique is the stack trace. This is why you will see the 
requested complete Drwtsn32.log file in the Unexpected Event section. 
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If the PID for the day of the crash is not ccm.exe or the timestamp did not 
correspond, then you are most likely running into a lack of resource crash, or a 
crash of another process.

Lack of Resources

Use the following procedure if there is a lack of resources crash.

Procedure

Step 1 Collect Cisco CallManager traces fifteen minutes before and after the crash. The 
traces are located at C:\Program Files\cisco\trace\ccm. 

Step 2 Collect SDL traces fifteen minutes before and after the crash. Traces are located 
at C:\Program Files\cisco\trace\sdl\ccm .

Step 3 Collect perfmon traces if available. 

Step 4 If the traces are not available, start collecting the perfmon traces and track 
memory and CPU usage for each process running on the server. To setup perfmon 
traces go to the Setting up Performance Monitor Counter Logs section. These will 
help in the event of another lack of resources crash.

Checking Settings on the Backup Utility to Avoid High CPU 

In order to avoid a system crash due to the Cisco IP Telephony Applications 
Backup running for an extended period of time at high CPU utilization, ensure 
that you are running the latest Cisco IP Telephony Applications Backup. 

If you are running Cisco CallManager 3.1(3a)spC and later or Cisco CallManager 
3.2(1)spA and later, per Cisco bug ID CSCdt91655 ( registered customers only) , 
the new Backup utility is running at low priority by default. 

Registered customers can download the latest version of Cisco IP Telephony 
Applications Backup from the Voice Software download page under 
Cisco CallManager. 
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Prior to this change, the previous versions used a tab called Performance to 
change the Base Priority of the process running the Cisco IP Telephony 
Applications Backup application. Changing the performance to below normal or 
low ensures that this process does not compete with other processes (that are 
running at normal Base Priority) for CPU, such as ccm.exe. 

Setting up Performance Monitor Counter Logs 

In order to verify the processes running, and the amount of CPU and memory that 
are being consumed, use the following procedure to gather counters for the crash. 

Procedure

Step 1 Choose Start > Programs > Administrative Tools > Performance. 

Step 2 Choose Performance Logs > Alerts > Counter Logs from the Performance 
Monitor. 

Step 3 Choose Action > New log settings and enter a name for the counter log. 

Step 4 Click Add in the counters page.

Use the local computer counters and make sure that you are configuring this 
directly on the Cisco CallManager that is experiencing the crash. 

Step 5 Choose Process in the Performance Object. 

Step 6 Choose List > Select Instances in the Select Counters and click the following 
counters and associated instances: 

% Processor Time / All Instances 

ID Process / All Instance 

Virtual Bytes / All Instances 

Private Bytes / All Instances 

Step 7 Set the interval to 2 and the units as seconds in the Sample Data Every . 

From the Log Files tab, make sure that the log file type is Text File - CSV. Also 
note where these are located. The default is C:\PerfLogs. Select a log file limit of 
20,000 Kb. 

Step 8 Click the Schedule tab.

Step 9 Choose Start Log Manually to start the log.
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Step 10 Choose When the 20,000 Kb Log File is Full to stop the log. 

Step 11 Choose Start a new log file and then click OK when the log closes. 

Step 12 Start logging by selecting the created counter log.

Step 13 Choose Action > Start. 

Note Over time, enabling these performance monitor logs generates a large 
number of files and utilizes a large amount of disk space. Therefore, it is 
necessary to keep an eye on this and, if it is, zip up the older logs and/or 
move them from the local drive. 

Step 14 The event log data may or may not be necessary. However, you should proactively 
dump both the System and Application events and filter out only the events from 
the last 30 minutes before the crash. Investigate these events before sending them 
to the TAC. You might see something that warrants more attention. 

Note Within a highly utilized system, using Event Viewer (a built-in Microsoft 
utility) to dump these events to a text file can easily starve all other 
processes from the CPU, including the Cisco CallManager KeepAlive 
process used to maintain phone registrations. Save the event log file in the 
.csv file format. 

Step 15 In the following order, zip all files before emailing and copying them using 
WinZip version 8. In general, files are copied to a local machine for faster 
evaluation. Zipped files use less space and can be moved around faster than raw 
file formats. 

1. Zip the USER.DMP and DRWTSN32.LOG together. Send and copy this Zip 
file immediately with a descriptive symptom definition and include the exact 
Cisco CallManager version, appropriate device loads, and Cisco IOS® 
versions. If any special patches are in use, ensure this fact is made clear. 

2. Zip and send the Cisco CallManager and SDL trace files together. 

3. Zip and send the Performance Monitor logs together. 

4. Zip and send the event log entries together. 
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Cisco CallManager Administration Page Does Not Display

Symptom

Administration web page does not display.

Probable Cause

The Cisco CallManager service stopped.

Corrective Action

Use the following procedure to verify that the Cisco CallManager service is active 
on a server that is local or remote.

Procedure

Step 1 From Cisco CallManager Administration, choose 
Application > Cisco CallManager Serviceability.

The Cisco CallManager Serviceability window displays.

Step 2 Choose Tools > Service Activation.

Step 3 From the Servers column, choose a server.

The server that you chose displays next to the Current Server title, and a box with 
configured services displays.

Activation Status column displays either Activated or Deactivated in the 
Cisco CallManager line.

If Activated, the Cisco CallManager is active on the chosen server and you need 
to contact TAC for further assistance.

If Deactivated, continue with the following steps.

Step 4 Check the Cisco CallManager check box.

Step 5 Click the Update button.
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The Activation Status column displays Activated in the Cisco CallManager line.

Cisco CallManager is now active for the chosen server.

Perform the following procedure if the Cisco CallManager has been in service and 
you want to check if it is currently active.

Procedure

Step 1 From Cisco CallManager Administration, choose 
Application > Cisco CallManager Serviceability.

The Cisco CallManager Serviceability window displays.

Step 2 Choose Tools > Control Center.

Step 3 From the Servers column, choose the server.

The server that you chose displays next to the Current Server title, and a box with 
configured services displays.

The Activation Status column displays Activated in the Cisco CallManager line.

Cisco CallManager is active for the chosen server. Contact TAC for further 
assistance.

If Deactivated, continue with the following steps.

Step 4 Check the Cisco CallManager check box.

Step 5 Click the Update button.

The Activation Status column displays Activated in the Cisco CallManager line.

Cisco CallManager is now active for the chosen server.

Verification

Repeat the preceding procedure to verify that the Cisco CallManager service is 
activated
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Errors Occur When Attempting to Access the Cisco CallManager 
Administration Page from the Browser

Symptom

One of the following error messages displays when you are trying to access the 
administration page from the same server where the Cisco CallManager resides.

• Internet Explorer—The page cannot be displayed.

• Netscape—Warning box displays: There was no response. The server could 
be down or is not responding.

Probable Cause

The IIS Admin service or the WWW publishing service does not start 
automatically as expected. One of these services stopping represents the most 
frequent reason for the pages not displaying locally.

Corrective Action

Use the following procedure to start the IIS.

Note If the IIS is stopped, the WWW publishing services may also be stopped. Start the 
WWW publishing services, which starts the IIS automatically.

Procedure

Step 1 From the Start menu, choose Start > Programs > Administration Tools > 
Services.

A window displays listing IIS Administration.

Step 2 Right-click IIS Admin Service.
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Step 3 Choose Start.

Step 4 Click Yes.

The IIS starts.

Start the other services using the following procedure.

Procedure

Step 1 From the Start menu, choose Start > Programs > Administration Tools > 
Services.

Step 2 Right-click the service.

Step 3 Choose Start.

Step 4 Click Yes.

The service starts.

Verification

Use the following procedure to verify that IIS is started.

Procedure

Step 1 From the Start menu, choose Start > Programs > Administration Tools > 
Services.

Step 2 Right-click the service.

Step 3 Verify the status, which should display Started.

Step 4 If any service is stopped, perform the following procedures to start the service(s).

Use the following procedure to start the IIS.
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Note If the IIS is stopped, WWW publishing services may also be stopped. Start the 
WWW publishing services, which starts the IIS automatically.

Procedure

Step 1 From the Start menu, choose Start > Programs > Administration Tools > 
Services.

A window displays listing IIS Admin Service.

Step 2 Right-click IIS Admin Service.

Step 3 Choose Start.

Step 4 Click Yes.

The IIS starts.

Start the other services using the following procedure.

Procedure

Step 1 From the Start menu, choose Start > Programs > Administration Tools > 
Services.

Step 2 Right-click the service.

Step 3 Choose Start.

Step 4 Click Yes.

The service starts.

Viruses can also cause the IIS service to stop and display strange messages when 
attempting to access the administration page. See the Virus Protection section for 
more information.
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You Are Not Authorized to View This Page

Symptom

When accessing the administration page, the following error message displays.

Error Message You Are Not Authorized to View This Page

and other similar error messages that may occur include

• You do not have permission to view this directory or page using the 
credentials you supplied.

• HTTP 401.3 Access denied by ACL on resource Internet Information 
Services.

• Server Application Error. The server has encountered an error while loading 
an application during the processing of your request. Please refer to the event 
log for more detailed information. Please contact the server administrator for 
assistance.

• Error: Access is Denied.

Probable Cause

The NTFS permissions have been modified on your C drive off the root directory 
to propagate into child directories on the Cisco CallManager server.

NTFS permissions have been changed from the default settings on the server and 
are no longer sufficient for IIS to run properly.

Corrective Action

Visit the Microsoft site for details on the issue: Q271071 “Minimum NTFS 
Permissions Required for IIS 5.0 to Work” at the following URL:

http://support.microsoft.com/default.aspx?ln=EN-GB&pr=kbinfo&
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Verification

Use the following procedure to verify that IIS is started.

Procedure

Step 1 From the Start menu, choose Start > Programs > Administration Tools > 
Services.

Step 2 Right-click the service.

Step 3 Verify the status, which should display Started.

Step 4 If any service is stopped, perform the following procedures to start the service(s).

Use the following procedure to start the IIS.

Note If the IIS is stopped, the WWW publishing services may also be stopped. Start the 
WWW publishing services, which starts the IIS automatically.

Procedure

Step 1 From the Start menu, choose Start > Programs > Administration Tools > 
Services.

A window displays listing IIS Admin Service.

Step 2 Right-click IIS Admin Service.

Step 3 Choose Start.

Step 4 Click Yes.

The IIS starts.
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Start the other services using the following procedure.

Procedure

Step 1 From the Start menu, choose Start > Programs > Administration Tools > 
Services.

Step 2 Right-click the service.

Step 3 Choose Start.

Step 4 Click Yes.

The service starts.

Errors Occur When Attempting to Access the Cisco CallManager 
Administration Page from a Browser on a Remote Server

If you can access the Administration Web page locally on the Cisco CallManager 
server, but not when you browse from a remote machine, verify whether one of 
the following situations applies to you. They appear in order, from the most 
frequent reason to the least frequent reason.

Problems Displaying or Adding Users With Cisco CallManager

Symptom

You are not able to add a user or conduct a search on the Cisco CallManager 
Administration user pages.
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Probable Cause

You may encounter the following problems if you are working with 
Cisco CallManager 3.x installed on a server that has a special character (such as 
an underscore) in its hostname, or MS Internet Explorer 5.5 with SP2 and a 
Q313675 patch or above. 

• When you conduct a basic search and hit submit, the page returns the same 
page. 

• When you try to insert a new user, the following error message appears.

The following error occurred while trying to execute the command.

Sorry, your session object has timed out.

Click here to Begin a New Search

Corrective Action

You may not be able to add a user or do a search on the Cisco CallManager Admin 
user pages, if your Cisco CallManager hostname contains any special characters 
such as, underscore or period (for example, Call_Manager). Domain Name 
System (DNS)-supported characters include all letters (A-Z, a-z), numbers (0-9), 
and hyphen (-) and any special characters are not allowed. If the Q313675 patch 
is installed on your browser, make sure that the URL does not contain any 
non-DNS supported characters. 

For more information about the Q313675 patch, refer to MS01-058: File 
Vulnerability Patch for Internet Explorer 5.5 and Internet Explorer 6. 

To resolve this problem, you have the following options:

• Access the Cisco CallManager Admin pages using the IP address of the 
server. 

• Do not use non-DNS characters in the Server Name. 

• Use the localhost or IP address in the URL. 
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SQLSvc User Can Not Log In

Symptom

The SQLSvc user can not log in and dependent services do not start.

Probable Cause

The SQLSvc user must log in to the local system before the Cisco CallManager, 
SQLServerAgent, MSSQLServer, and COM+ Event System services can start and 
execute their specific functions. If the SQLSvc password is not configured 
correctly, both locally and within the cluster, the SQLSvc user cannot log in and 
these dependent services do not start. Cisco CallManager and its basic 
functionality can be affected.

Note The SQLSvc password should be the same across the entire cluster.

This problem affects the following: 

• Cisco CallManager 

• Microsoft SQL server for Cisco Call Manager 

• Cisco Music on Hold (MOH) Audio Translator 

• Cisco Trivial File Transfer Protocol (TFTP) 

Corrective Action

Use the following procedure to recover an SQLSvc account password.

Procedure

Step 1 Choose Start > Programs > Administrative Tools > Computer Management. 

Step 2 Click + (the plus sign) beside Local Users and Groups in the left column. 

Step 3 Click Users.

Step 4 Right-click SQLSvc in the right column and choose Set Password. 
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Step 5 Enter the new password and confirm the password.

Step 6 Click OK to confirm and close the Change Password dialog box. 

Step 7 Click + (the plus sign) beside Services and Applications in the left column. 

Step 8 Click Services.

Step 9 In the right column click to highlight MSSQLServer 2000. 

Step 10 Right-click MSSQLServer 2000 and choose Properties.

Step 11 Click the Log On tab. 

Step 12 Change the password and confirm that the password matches the SQLSvc user 
password set in Step 5. 

Step 13 Click OK to return to the Services List. 

Step 14 Click to highlight SQLServerAgent. 

Step 15 Right-click SQLServerAgent and choose Properties. 

Step 16 Click the Log On tab.

Step 17 Change the password to match the SQLSvc user password set in Step 5. 

Step 18 Click OK to return to the Services List. 

Step 19 Close the Computer Management window.

Step 20 Choose Start > Programs > Administrative Tools > Component Services.

Step 21 Click + (the plus sign) beside Component Services. 

Step 22 Click + (the plus sign) beside Computers. 

Step 23 Click + (the plus sign) beside My Computer. 

Step 24 Click + (the plus sign) beside COM+ Applications.

Step 25 Right-click DBL and choose Properties.

Step 26 Click the Identity tab. 

Step 27 Change the password and confirm that the password matches the SQLSvc user 
password set in Step 5.

Step 28 Click OK to go back to the Component Manager. 

Step 29 Right-click DBL and click Shut Down. 
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Step 30 Right-click DBL and click Start.

Step 31 Close the Component Manager window. 

Name to Address Resolution Failing

Symptom

One of the following error messages displays when you try to access the following 
URL:

http://your-cm-server-name/ccmadmin

• Internet Explorer: This page cannot be displayed

• Netscape: Not Found. The requested URL /ccmadmin was not found on this 
server.

If you try to access the same URL using the Cisco CallManager IP address 
(http://10.48.23.2/ccmadmin) instead of the name, the page displays.

Probable Cause

The name that you entered as "your-cm-server-name" is mapping to the wrong IP 
address in DNS or hosts file.

Corrective Action

Procedure

Step 1 If you have configured the use of DNS, check in the DNS to see whether the entry 
for the your-cm-server-name has the correct IP address of the Cisco CallManager 
server. If it is not correct, change it. 
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Step 2 If you are not using DNS, your local machine will check in the "hosts" file to see 
whether there is an entry for the your-cm-server-name and an IP address 
associated to it. Open the file and add the Cisco CallManager server name and the 
IP address. 

You can find the "hosts" file at C:\WINNT\system32\drivers\etc\hosts on your 
Windows station.

Unable to Change the Server Name for Cisco CallManager

Symptom

You attempt to change the name of the Cisco CallManager server and the service 
fails. Other services also fail, such as CTI Manager, Extended Functions, and 
Voice Media Streaming.

Probable Cause

Cisco does not support changing the name of a Cisco CallManager server.

Corrective Action

Use the following procedure to change the IP address instead of changing the 
name of a Cisco CallManager server.

Note You must change the IP address in all applications.

Procedure

Step 1 From the Customer Response Applications Administration, choose System > 
Engine to access the Engine web page.
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Note These steps are required if the Customer has installed Extended Services 
(required in version 3.2 and below for Extension Mobility and required in 
all versions for IP-Auto Attendant or TAPS, which are free applications) 
or a co-resident installation of CRA/CRS on the machine whose IP 
address is being changed. 

Figure 4-1 Engine Window—Engine Status Area

The Engine Status area displays information about the CRA system and its 
subsystems.

Step 2 Click the Stop Engine button to stop the CRA Engine.

Note You can also control the CRA Engine from the Windows Service window, which 
you display by choosing Start > Programs > Administrative Tools > Services.
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Step 3 Click the Engine Configuration hyperlink on the navigation bar of the Engine 
web page to access the Engine Configuration area, which displays information 
you specified during user profile creation.

Figure 4-2 Engine Window—Engine Configuration Area

Step 4 In the Application Engine Hostname field, enter the new IP address of the server.

Step 5 From the Customer Response Applications Administration, choose 
Subsystems > JTAPI.

The JTAPI Configuration web page displays.
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Figure 4-3 JTAPI Configuration Window

Step 6 In the JTAPI Provider(s) field, enter the new IP address of the 
Cisco Media Convergence server (Cisco MCS) running Cisco CallManager CTI 
Manager. 

Step 7 From the Customer Response Applications Administration, choose System > 
Configuration and Repository.

The Directory Setup Window displays.
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Figure 4-4 Directory Setup Window—Configuration Setup Area

Step 8 In the Directory Host Name field, enter the new IP address.

Step 9 Click the Repository hyperlink on the navigation bar of the Directory Setup 
window.

The Repository Setup area displays.
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Figure 4-5 Directory Setup Window—Repository Setup Area

Step 10 In the Directory Host Name field, enter the new IP address.

Step 11 Stop the DC Directory Service on the server by choosing 
Control Panel > Administrative Tools > Services.

Step 12 Select Start > Programs > DC Directory Administrator Directory Manager.

Step 13 Enter the directory manager password that you entered during the installation.

Step 14 Choose Directory > cisco.com > CCN > systemProfile.

Step 15 Double-click Hoteling Profile.

Step 16 Click Modify and enter the new IP address.

Step 17 In the Cisco CallManager Administration, choose System > Server and enter the 
new IP address.
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Step 18 In the Cisco CallManager Administration, choose 
System > Enterprise Parameters and enter the new IP addresses for the URL 
Directories. There are multiple URL entries that may need to be changed. Help, 
Authentication, Directories, Information, and Services all have URLs under 
Enterprise Parameters.

Step 19 In the Cisco CallManager Administration, choose Features > Phone Services 
and enter the new IP address in all URLs. This applies to any URLs that point to 
the server that is being changed. Services can (and in many cases should) point to 
other servers/www sites.

Step 20 Change the Server IP address to the new IP address in Network Properties.

Step 21 Change LMHOST and HOSTS files on all servers in a cluster to the new 
IP address.

Step 22 Change the DHCP Option 150 to the new IP address.

Step 23 Open the SQL Enterprise Manager and change the IP addresses in the URLs in the 
PlugIn table by choosing 
Start > Programs Microsoft SQL Server 2000 > Enterprise Manager.

Step 24 Choose the tree server name > Databases > latest CCM03xx database.

Step 25 Choose Tables > PlugIn.

Step 26 Right-click PlugIn to open the table and choose Return All Rows.

Note Modifications are made immediately. You can not cancel changes.

Step 27 Open the stiBackup configuration by choosing 
Start > Programs Administrative Tools > Services Console > 
stiBack for Cisco IP Telephony Applications and enter the new IP address in all 
the appropriate tabs.

Step 28 In C:\TAPS\TAPSCCM.txt, enter the new IP address
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Default Web Site Under IIS Has Improper Setting

Symptom

One of the following error messages displays when you try to access the following 
URL:

http://your-cm-server-name/ccmadmin

• Internet Explorer: This page cannot be displayed

• Netscape: Not Found. The requested URL /ccmadmin was not found on this 
server.

If you try to access the same page using the Cisco CallManager IP address 
(http://10.48.23.2/ccmadmin) instead of the name, the page displays.

Probable Cause

An incorrect setting in the Default Web Site tab for the IIS has been set on the 
server.

Corrective Action

Procedure

Step 1 Verify in the Internet Service Manager on the Cisco CallManager machine the 
Default Web Site. In the Web Site tab, choose All Unassigned and not the IP 
address of the machine. 

You can verify that setting by choosing 
Start > Programs > Administrative tools/Internet Service Manager. 
Expand the icon that shows your server name. 
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Step 2 Right-click Default Web Site. You have option properties that you must choose. 
Look for the Web Site tab and verify the All Unassigned setting. 

Note If you need to keep the specific IP address setting for any reason, you will not be 
able to use the name instead of IP address from a remote web browser. 

Port 80 Is Blocked in One or More Routers Between Your Local 
Browser and the Cisco CallManager Server

Symptom 

One of the following error messages displays when the port that is used by the web 
server or the http traffic is being blocked by a firewall:

• Internet Explorer: This page cannot be displayed

• Netscape: There was no response. The server could be down or is not 
responding

Probable Cause

For security reasons, the http access from your local network to the server network 
has been blocked.

Corrective Action

Procedure

Step 1 Verify whether other types of traffic to the Cisco CallManager server are allowed, 
such as ping or Telnet. If any of them are successful, it will show that http access 
to the Cisco CallManager Web server has been blocked from your remote 
network.
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Step 2 Check the security policies with your network administrator.

Step 3 Try again from the same network where the Server is located.

You Attempt to Access a Machine Where Access Is Explicitly 
Denied

Symptom 

One of the following error messages displays:

• Internet Explorer: This page cannot be displayed

• Netscape: Not Found. The requested URL / ccmadmin was not found on this 
server.

• From both browers without show friendly http error messages advance 
setting configured: Access to this server is forbidden.

Probable Cause

This represents a security policy that is applied by the network administrator.

Corrective Action

Procedure

Step 1 Check the security policies with your network administrator. Try again from a 
different machine.

Step 2 If you are the network administrator, check the Directory Security tab of the 
Default Web Site in the Internet Service Manager on the Cisco CallManager 
server.

Step 3 You can verify the setting by choosing 
Start > Programs > Administrative tools/Internet Service Manager.

Step 4 Expand the icon that shows your server name.
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Step 5 Right-click Default Web Site. You have the option properties from which you 
must choose.

Step 6 Look for the Directory Security tab and verify the setting.

Improper Network Setting Exists in the Remote Machine From 
Where You Are Browsing

Symptom

There is no connectivity, or there is no connectivity to other devices in the same 
network as the Cisco CallManager.

When you attempt the same action from other remote machines, the 
Cisco CallManager Administration Page displays.

Probable Cause

Improper network configuration settings on a station or on the default Gateway 
can cause a web page not to display because partial or no connectivity to that 
network exists.

Corrective Action

Procedure

Step 1 Try pinging the IP address of the Cisco CallManager server and other devices to 
confirm that you cannot connect.

Step 2 If the connectivity to any other device out of your local network is failing, check 
the network setting on your station, as well as the cable and connector integrity. 

Step 3 If the connectivity to any other device out of your local network is failing, check 
the network setting on your station, as well as the cable and connector integrity. 
Refer to the appropriate hardware documentation for detailed information.
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If you are using TCP-IP over a LAN to connect, continue with the following steps 
to verify the network settings on the remote station.

Step 4 Choose Start > Setting > Network and Dial-up connections.

Step 5 Choose Local Area Connection, then Properties. 

The list of communication protocols will appear checked.

Step 6 Choose Internet Protocol (TCP-IP) and click Properties again.

Step 7 Depending on your network, choose either Obtain an ip address automatically 
or set manually your address, mask and default Gateway.

The possibility exists that a browser-specific setting could be improperly 
configured. 

Step 8 Choose the Internet Explorer browser Tools > Internet Options.

Step 9 Choose the Connections tab and then verify the LAN settings or the dial-up 
settings. 

By default, the LAN settings and the dial-up settings are not configured. The 
generic network setting from Windows is used.

Step 10 If the connectivity is failing only to the Cisco CallManager network, a routing 
issue probably exists in the network. Contact the network administrator to verify 
the routing that is configured in your default gateway.

Note If you cannot browse from the remote server after following this procedure, 
contact TAC to have the issue investigated in more detail.

Refer to the following URL for more information on configuration settings:

http://www.cisco.com/warp/public/63/initial_config.shtml
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Replication Fails Between the Publisher and the 
Subscriber

Replicating the SQL database is a core function of Cisco CallManager clusters. 
The server with the master copy of the database is called the publisher, while the 
servers replicating the database are called subscribers. 

Cannot Update Data Because the Publisher Is Not Available

Symptom

The following error message displays:

Error Message Cannot update data because the publisher is not 
available. Please try again later. (58)

Probable Cause

The subscriber build failed.

Corrective Action

Procedure

Step 1 Ensure that the NetBIOS name resolution is working between all servers.

Step 2 Ensure (by editing) that the hosts and LMHOSTS are filled in on the publisher and 
subscriber servers, so each one can resolve the other’s host name and NetBIOS 
name.

Hosts is used for DNS resolution. LMHOSTS uses NetBIOS for name resolution. 
Also, SQL uses NetBIOS for name resolution.

If the Cisco CallManager fails to update, the database layer on the subscriber 
cannot find the publisher.
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Step 3 Check the SQL “distribution agent” on the publisher for history and errors.

Step 4 Choose Start > Programs > Administrative Tools > Local Security Policy.

Step 5 Choose Audit Policy.

Step 6 Enable Failure auditing for all events.

For SQL, enable Authentication.

Note Users get replicated in the DC Directory, not in SQL.

Step 7 From the web, upgrade the Cisco CallManager for the software version on your 
publisher.

The software will download the SQL database to the subscriber(s).

Subscriber Stops Replicating Data From the Publisher

Symptom

Changes made on the publisher are not reflected on phones that are registered with 
the subscriber.

Probable Cause

Replication fails between the publisher and subscriber.

Corrective Action

Complete the following steps to reestablish the relationship between the two 
systems. First, the subscriber subscription will need to be recreated on the 
publisher. Then, delete the subscription and recreate on the subscriber system.
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Recreating the Subscription on the Publisher 

Procedure

Step 1 Choose Programs > Microsoft SQL Server 2000 > Enterprise Manager from 
the publisher to start the SQL Enterprise Manager. 

Step 2 The subscription can be recreated from the publisher. Under Microsoft SQL 
Server, select New SQL Server Registration... 

The Register SQL Server Wizard displays. Make sure the From now on I want 
to perform the task without using a wizard is not checked. 

Step 3 Click Next. 

The other SQL servers that reside on the Cisco CallManagers should display in 
the Additional Servers box. 

Step 4 Choose all servers and Add them to the Added servers box. 

Step 5 Click Next. 

Click The SQL Server login information that was assigned to me by the 
system administrator.

Step 6 Click Next.

Step 7 On the next screen, use the "sa" account and password for the subscriber system.

Note This is the sa account and password from the SUBSCRIBER system. The 
password was selected when the subscriber system was installed.

Step 8 In the Select SQL Server Group window, choose the option to Add the SQL 
server(s) to the existing SQL Server group.
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Step 9 Click Finish. 

After selecting finish, the wizard will display status of the addition of the added 
server(s).

The display should read "Registered successfully". 

Step 10 Click Close.

The two servers listed in the display means they are recognized by the publisher, 
so data can be shared with them.

Deleting the Subscription on the Publisher 

Use the following procedure to delete the subscription on the publisher.

Procedure

Step 1 Choose Microsoft SQL Servers > SQL Server Group > Machine_name > 
Databases > CCM0301 > Publications from the Enterprise Manager to locate 
the Publication for the CCM0301 database. 

Step 2 Choose the Cisco CallManager subscription that is failing and delete the entry. 

Caution Select the area on the right. Do not delete the book icon on the left.

A warning displays indicating the subscription has been removed at the publisher, 
but not the subscriber and if you want to connect to the subscriber and delete the 
subscription. 

Step 3 Click Yes. 

The next message indicates that the subscription has been deleted but the data has 
not. 

Step 4 Click OK.
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Recreating the Subscription on the Subscriber 

Next, the subscription must be added back into the subscriber SQL server. Use the 
following procedure to recreate the subscription on the subscriber.

Procedure

Step 1 Select the SQL server name of the subscriber that you just deleted from the 
publisher.

Step 2 Right-click to get the menu. 

Step 3 Choose New > Pull Subscription from the menu. 

Note Always choose the latest version of the database, not the earlier version

The Pull Subscription Wizard displays. 

Step 4 Click Next. 

Step 5 On the Choose Publication screen expand the publisher (which should be listed) 
and select the database. 

Step 6 Click Next. 

Step 7 On the Specify Synchronization Agent Login screen, Choose Using SQL Server 
Authentication of this account. 

The login name will be sa and the password will be the same password as the 
publishers 'sa' account. 

Step 8 On the Specify Immediate-Updating Subscription(s) popup, Click Yes, make this 
an immediate-updating subscription(s). 

Step 9 Click Next. 

Step 10 On the Initialize Subscription screen, Click Yes, initialize the schema and data 
at the Subscriber. 

Step 11 Click Next. 

Step 12 On the Set Distribution Agent Schedule popup, Choose Continuously. 

Step 13 Click Next. 

The next step will verify that both the SQL server agent and the Microsoft DTC 
services are running. 
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Step 14 Click Next. 

Step 15 Click Finish in the Completing the Pull Subscription Wizard screen. 

The Wizard will set up the subscription and display a success when completed.

A display indicating success should appear when the process is completed.

Step 16 Now that the subscription has been created, the snapshot agent must be run to get 
the data out to the subscriber for synchronization. 

Step 17 Choose the publisher SQL server and choose Replication Monitor > Publishers 
> Machine_name >CCM0301 subscription. 

Step 18 Choose the Snapshot entry and choose Start. 

The snapshot agent will run at this point. It will take about 3-5 minutes to 
complete the task. Once the snapshot agent completes, the pull agent will start to 
apply the snapshot to the subscriber. This will take another 3-5 minutes. 

Step 19 Once the pull subscription has completed, on the publisher, select the subscriber 
SQL server and open the pull subscriptions for the CCM0301 database. 

The subscription should be in a running state and waiting for updates. 

Note If the last action still reads "Waiting for snapshot agent to become 
available", press F5 to refresh the screen.

At this time, the subscriber is now resynchronized with the publisher and updates 
are getting recorded in the local subscriber SQL database. 

Verification

Use the following procedure to verify that the SQL Subscription is working.

Procedure

Step 1 To test the propogation of data, create a device on the publishing server that is 
easily recognizable. 
4-38
Troubleshooting Guide for Cisco CallManager Release 4.0(1)

OL-4617-01



 

Chapter 4      Cisco CallManager System Issues
Slow Server Response
Note The more recognizable the device is, the easier it will be to find.

Step 2 Click Insert.

The device does not need to be functional. 

Step 3 Click Update and Close. 

Step 4 Go into the SQL Enterprise Manager, expand the SQL subscriber in question and 
look in the database table to see if the new device is present. 

Slow Server Response
This section addresses a problem related to a slow response from the server: 
Mismatched Duplex Port Settings.

Mismatched Duplex Port Settings

Symptom

Slow response from the server occurs.

Probable Cause

Slow response could result if the duplex of the switch does not match the duplex 
port setting on the Cisco CallManager server. 
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Corrective Action

Procedure

Step 1 For optimal performance, set both switch and server to 100/Full. 

Cisco does not recommend using the Auto setting on either the switch or the 
server.

Step 2 You must restart the Cisco CallManager server for this change to take effect.

JTAPI Subsystem Startup Problems
The JTAPI (Java Telephony API) subsystem is a very important component of the 
Cisco Customer Response Application (CRA) platform. JTAPI is the component 
that communicates with the Cisco CallManager, and is responsible for telephony 
call control. The CRA platform hosts telephony applications, such as Cisco 
AutoAttendant, Cisco IP ICD, and Cisco IP-IVR. This section is not specific to 
any of these applications; the JTAPI subsystem is an underlying component that 
is used by all of them.

Before starting the troubleshooting process, ensure that the software versions that 
you are using are compatible. To verify compatibility, read the 
Cisco CallManager Release Notes for the version of Cisco CallManager that you 
are using.

To check the version of CRA, log in to the AppAdmin page by typing 
http://servername/appadmin, where servername is the name of the server on 
which CRA is installed. The current version is located in the lower-right corner of 
the main menu.
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JTAPI Subsystem is OUT_OF_SERVICE

Symptom

The JTAPI subsystem does not start.

Probable Cause

One of the following exceptions displays in the trace file:

• MIVR-SS_TEL-4-ModuleRunTimeFailure

• MIVR-SS_TEL-1-ModuleRunTimeFailure

MIVR-SS_TEL-4-ModuleRunTimeFailure
Search for the MIVR-SS_TEL-1-ModuleRunTimeFailure string in the trace file. At 
the end of the line, an exception reason is given. 

Probable Cause

The following are the most common errors:

• Unable to create provider—bad login or password

• Unable to create provider -- Connection refused

• Unable to create provider -- login=

• Unable to create provider -- hostname

• Unable to create provider -- Operation timed out

• Unable to create provider -- null
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Unable to create provider—bad login or password

The user name or password entered in the JTAPI configuration is incorrect.

Full Text of Error Message 
%MIVR-SS_TEL-4-ModuleRunTimeFailure:Real-time

failure in JTAPI subsystem: Module=JTAPI

Subsystem,Failure Cause=7,Failure

Module=JTAPI_PROVIDER_INIT,

Exception=com.cisco.jtapi.PlatformExceptionImpl:

Unable to create provider -- bad login or password.

%MIVR-SS_TEL-7-

EXCEPTION:com.cisco.jtapi.PlatformExceptionImpl:

Unable to create provider -- bad login or password.

Corrective Action

Verify that the user name and password are correct. Try logging into the CCMuser 
page (http://servername/ccmuser) on the Cisco CallManager to ensure that the 
Cisco CallManager is able to authenticate correctly.

Probable Cause

Unable to create provider -- Connection refused 

The JTAPI connection to the Cisco CallManager is refused by the 
Cisco CallManager.
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Full Text of Error Message 
%MIVR-SS_TEL-4-ModuleRunTimeFailure:Real-time

failure in JTAPI subsystem: Module=JTAPI Subsystem,

Failure Cause=7,Failure Module=JTAPI_PROVIDER_INIT,

Exception=com.cisco.jtapi.PlatformExceptionImpl: Unable

to create provider -- Connection refused

%MIVR-SS_TEL-7-EXCEPTION:com.cisco.jtapi.PlatformExceptionImpl
:

Unable to create provider -- Connection refused

Corrective Action

Verify that the CTI Manager service is running in the Cisco CallManager Control 
Center.

Probable Cause

Unable to create provider -- login= 

Nothing has been configured in the JTAPI configuration page.

Full Text of Error Message 
%MIVR-SS_TEL-4-ModuleRunTimeFailure:Real-time

failure in JTAPI subsystem: Module=JTAPI Subsystem,

Failure Cause=7,Failure Module=JTAPI_PROVIDER_INIT,

Exception=com.cisco.jtapi.PlatformExceptionImpl:

Unable to create provider -- login=

%MIVR-SS_TEL-7-EXCEPTION:com.cisco.jtapi.PlatformExceptionImpl
:

Unable to create provider -- login=
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Corrective Action

Configure a JTAPI provider in the JTAPI configuration page on the CRA server.

Probable Cause

Unable to create provider -- hostname 

The CRA engine is not able to resolve the host name of the Cisco CallManager.

Full Text of Error Message 
%M%MIVR-SS_TEL-4-ModuleRunTimeFailure:Real-time

failure in JTAPI subsystem: Module=JTAPI Subsystem,

Failure Cause=7,Failure Module=JTAPI_PROVIDER_INIT,

Exception=com.cisco.jtapi.PlatformExceptionImpl:

Unable to create provider -- dgrant-mcs7835.cisco.com

%MIVR-SS_TEL-7-EXCEPTION:com.cisco.jtapi.PlatformExceptionImpl
:

Unable to create provider -- dgrant-mcs7835.cisco.com

Corrective Action

Verify that DNS resolution is working correctly from the CRA engine. Try using 
an IP address instead of the DNS name.

Probable Cause

Unable to create provider -- Operation timed out

The CRA engine does not have IP connectivity with the Cisco CallManager.
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Full Text of Error Message 
101: Mar 24 11:37:42.153 PST

%MIVR-SS_TEL-4-ModuleRunTimeFailure:Real-time

failure in JTAPI subsystem: Module=JTAPI Subsystem,

Failure Cause=7,Failure Module=JTAPI_PROVIDER_INIT,

Exception=com.cisco.jtapi.PlatformExceptionImpl:

Unable to create provider -- Operation timed out

102: Mar 24 11:37:42.168 PST %MIVR-SS_TEL-7-EXCEPTION:

com.cisco.jtapi.PlatformExceptionImpl:

Unable to create provider -- Operation timed out

Corrective Action

Check the IP address that is configured for the JTAPI provider on the CRA server. 
Check the default gateway configuration on the CRA server and the 
Cisco CallManager. Make sure there are no IP routing problems. Test connectivity 
by pinging the Cisco CallManager from the CRA server.

Probable Cause

Unable to create provider -- null 

There is no JTAPI provider IP address or host name configured, or when the 
JTAPI client is not using the correct version.

Full Text of Error Message 
%MIVR-SS_TEL-4-ModuleRunTimeFailure:Real-time

failure in JTAPI subsystem: Module=JTAPI Subsystem,

Failure Cause=7,Failure Module=JTAPI_PROVIDER_INIT,

Exception=com.cisco.jtapi.PlatformExceptionImpl:

Unable to create provider -- null
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Corrective Action

Verify that a host name or IP address is configured in the JTAPI configuration. If 
the JTAPI version is incorrect, download the JTAPI client from the 
Cisco CallManager Plugins page and install it on the CRA server.

MIVR-SS_TEL-1-ModuleRunTimeFailure

Symptom

This exception usually occurs when the JTAPI subsystem is unable to initialize 
any ports.

Probable Cause

The CRA server can communicate with the Cisco CallManager, but is unable to 
initialize any CTI ports or CTI route points through JTAPI. This error occurs if 
the CTI ports and CTI route points are not associated with the JTAPI user.

Full Text of Error Message 
255: Mar 23 10:05:35.271 PST 
%MIVR-SS_TEL-1-ModuleRunTimeFailure:

Real-time failure in JTAPI subsystem: Module=JTAPI Subsystem,

Failure Cause=7,Failure Module=JTAPI_SS,Exception=null

Corrective Action

Check the JTAPI user on the Cisco CallManager, and verify that CTI ports and 
CTI route points that are configured on the CRA server are associated with the 
user.
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JTAPI Subsystem is in PARTIAL_SERVICE

Symptom

The JTAPI subsystem is unable to initialize one or more CTI ports or route points.

Probable Cause

The following exception displays in the trace file:

• MIVR-SS_TEL-3-UNABLE_REGISTER_CTIPORT

MIVR-SS_TEL-3-UNABLE_REGISTER_CTIPORT

Probable Cause 

The JTAPI subsystem is unable to initialize one or more CTI ports or route points.

Full Text of Error Message 
1683: Mar 24 11:27:51.716 PST

%MIVR-SS_TEL-3-UNABLE_REGISTER_CTIPORT:

Unable to register CTI Port: CTI Port=4503,

Exception=com.cisco.jtapi.InvalidArgumentExceptionImpl:

Address 4503 is not in provider's domain.

1684: Mar 24 11:27:51.716 PST %MIVR-SS_TEL-7-EXCEPTION:

com.cisco.jtapi.InvalidArgumentExceptionImpl:

Address 4503 is not in provider's domain.

Corrective Action

The error message in the trace will tell you which CTI port or route point was 
unable to be initialized. Verify that this device exists in the Cisco CallManager 
configuration, and is also associated with the JTAPI user on the 
Cisco CallManager.
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Security
This section covers the following security issues and provides information on 
where to find detailed documentation regarding the security process:

• Changing IIS Parameters for Security

• Near-Term Security Solutions

• Long-Term Security Solutions

• Related Information

Changing IIS Parameters for Security

Symptom

You lose settings for locking down the IIS servers to protect the 
Cisco CallManager from hackers, attacks, or threats.

Probable Cause

Whenever you upgrade or reinstall the Cisco CallManager, all the IIS settings 
revert to the Cisco CallManager defaults.

Corrective Action

Test all your settings on a non-production Cisco CallManager before changing the 
settings on your production server.

Note the settings, because they will change every time that you perform an 
upgrade or reinstall, and you will have to reset them.

Caution Ensure that you do not change any settings within the Cisco web directory, or you 
run the risk of losing a Cisco CallManager service due to a missing or moved file.
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Near-Term Security Solutions
Refer to the following documents to ensure that you have quality of service (QoS) 
configured properly throughout your network to help ensure voice quality is 
affected as little as possible during the remainder of cleanup operations:

• Cisco IP Telephony QoS Design Guide

• Cisco IP Telephony Network Design Guide

• IP Telephony Solutions Guide

The following URL provides the guides:

http://www.cisco.com/univercd/cc/td/doc/product/voice/ip_tele/index.htm

Refer to the Cisco IP Telephony Network Design Guide to establish separate 
Voice/Data VLANs.

Note This could provide a long-term solution depending on the size and complexity of 
the network involved.

Long-Term Security Solutions
After the immediate emergency is over, consult the Cisco IP Telephony Solution 
Guide: Security Considerations for IP Telephony Networks at the following URL:

http://www.cisco.com/univercd/cc/td/doc/product/voice/ip_tele/
solution/4_design.htm

The subsection “Securing CallManager Servers” provides details on how to 
properly secure an IP Telephony solution for long term. The Cisco IP Telephony 
Solution Guide provides measures that would prevent Code Red issues on the 
Data network from affecting the IP telephony network.

Related Information
The following URL provides Cisco CallManager Security Patch Process:

http://www.cisco.com/warp/public/cc/pd/nemnsw/callmn/prodlit/cmspp_qa.pdf
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Cisco highly recommends that you do not install any patches from Microsoft. 
Download the wrapped versions from CCO.

You can sign up for Microsoft security patch alerts at the following URL:

http://www.microsoft.com/technet/treeview/default.asp?url=/technet/security/
bulletin/notify.asp

The alerts include an associated rating, which allows you an approximate time of 
a HotFix posting to CCO.

Refer to the following URL for security considerations for an IP telephony 
network:

http://www.cisco.com/univercd/cc/td/doc/product/voice/ip_tele/solution/
4_design.htm#22024

Virus Protection
Refer to the following URL for procedures for stopping an active security attack 
or preventing an imminent security risk:

http://www.cisco.com/en/US/partner/products/sw/voicesw/ps556/prod_security_
advisories_list.html

To verify the server has the latest patches, refer to the following documents:

• Installing Cisco CallManager Release 4.0(1)

• Upgrading Cisco CallManager Release 4.0(1)

• Using Cisco CallManager Upgrade Assistant Utility 4.0(1)
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Directory Issues

This chapter covers the solutions for the most common issues related to a 
Cisco CallManager DC Directory (DCD), which uses a Lightweight Directory 
Access Protocol (LDAP) directory, and the Microsoft Active Directory (AD). 

This chapter covers the following directory issues:

• DC Directory Stability

• Application Profiles Are Not Shown for User Configuration with the DC 
Directory

• Add a New User Does Not Work and You Cannot Access the DC Directory 
Administrator

If the following procedures do not solve your directory issues, contact TAC for a 
more detailed investigation.

Caution Using Katakana, Cyrillic, or other double-byte character sets with DC Directory, 
Netscape Directory, or Active Directory can cause directory database errors. This 
release of Cisco CallManager does not support using any double-byte character 
set with any directory.
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For IP phone directory issues, refer to the following URL for detailed 
information:

http://www.cisco.com/univercd/cc/td/doc/product/voice/c_ipphon/index.htm

Replication Issues
For replication issues, see Chapter 4, “Cisco CallManager System Issues” and the 
section Replication Fails Between the Publisher and the Subscriber.

DC Directory Stability
The DCD Instability procedure is valid for Cisco CallManager servers running 
versions 3.0(5a) - 3.3(2c).

Note Do not use this procedure for Cisco CallManager 3.3(3) and above.

DCD Instability

Symptom

The following issues relate to the instability of the DCD:

• Cisco CallManager publisher server has correct user data and one or more 
Cisco CallManager subscriber servers either do not have user data or the user 
data is out of date with the Publisher's database.

• DC Directory Service on the Cisco CallManager publisher server takes a long 
time to start-up (appears to stall/hang on startup). 

• DC Directory Replication errors are logged to the Cisco CallManager 
publisher and/or subscriber server(s) in the Application Event Viewer. 
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Probable Cause

Examination of C:\dcdsrvr\run\dcx500\dcx500.out shows duplicate and/or invalid 
replication agreements. 

The presence of invalid replication agreements causes the DC Directory database 
(files in C:\dcdsrvr\run\dcx500\database) to grow extremely large (over 100 MB), 
which results in the DC Directory to taking a large amount of time to shutdown 
and startup. 

These duplicate and invalid agreements are caused by one of the following: 

• The customer reinstalling the Cisco Customer Response Application (CRA) 
server (or a Cisco CallManager subscriber) one or more times (each reinstall 
of CRA server/Cisco CallManager server will cause the publisher to have a 
new replication agreement to the subscriber). 

• Decommissioning an existing CRA server (or a Cisco CallManager 
subscriber) without performing the DC Directory reconfiguration procedure 
in the Cisco CallManager cluster.

Note When removing a directory node from a Cisco CallManager cluster, the 
DC Directory replication agreements to the removed subscriber are not 
automatically cleaned up. 

• Manually running the avvid_scfg command on the subscriber more than once 
(for instance, a partial DC Directory reconfiguration procedure was 
attempted). 

Warning Never perform a partial DC Directory reconfiguration procedure, (for example, 
run avvid_scfg without a preceding cleandsa on the publisher and the CRA 
server and/or Cisco CallManager subscriber). 

The root cause of the database growing to such large sizes is that DC Directory 
tries to save state for each and every replication operation that it fails to perform. 
Over a period of time this saved state information for the invalid replication 
agreements causes the database to grow to several hundred MBs. 

DcDirectory replication should not be confused with SQLServer replication. They 
are two completely independent processes.
5-3
Troubleshooting Guide for Cisco CallManager Release 4.0(1)

OL-4617-01



 

Chapter 5      Directory Issues
DC Directory Stability
If you perform a reinstallation of a Cisco CallManager subscriber or CRA server 
2.2(4) and earlier or CRA server 3.0(1) you must perform the DC Directory 
reconfiguration procedure on all of the nodes in the cluster, including the 
standalone CRA servers, starting with the DC Directory publisher. 

Corrective Action

While performing these tasks, it is required to be either directly at the console of 
the Media Convergence Server (MCS) servers, connected through a 
Keyboard/Video/Mouse (KVM) switch, or connected via Telnet to the servers. 
Performing these specific tasks while connected through a Terminal Services 
Client connection has not been fully tested and may produce unexpected results. 

Note Cisco recommends that you schedule a downtime to run the procedure. 

The two steps involved are:

• Installation

• Reconfiguration

Installation 

Step 1 Download DCDScripts.1-0-5.exe from the Cisco CallManager Version 3.2 ( 
registered customers only) website.

Step 2 Copy and run DCDScripts.1-0-5.exe on all the nodes in the Cisco CallManager 
cluster and on the CRA/CRS application servers. Accept the default settings when 
prompted to do so and click Unzip. 

Reconfiguration 

There are two possible scenarios when you go to reconfigure your DC Directory 
after installation. 

Step 1 When the DC Directory database is larger than 100 Mb, refer to the Reconfiguring 
DC Directory on Cisco CallManager Publisher (database more than 100 Mb) 
section. 
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Step 2 When the DCD database is less than 100 Mb, refer to the Reconfiguring DC 
Directory on Cisco CallManager Publisher (database less than 100 Mb) section.

Reconfiguring DC Directory on Cisco CallManager Publisher (database more than 100 
Mb) 

These steps ensure that your user data in DC Directory on the publisher 
Cisco CallManager server is backed up in case of a failure during these steps or 
otherwise when the DC Directory database is larger than 100 Mb 
(C:\dcdsrvr\run\dcx500\database). 

Step 1 Backup your current directory information by either using the MCS backup utility 
or running the dcbckdib /y backup C:\dcdsrvr\backup command from a DOS 
command prompt.

Note The C:\dcdsrvr\backup folder must exist prior to running the preceding 
command.

Step 2 On the Publisher server, while logged in as the Administrator, open a command 
prompt by selecting Start > Run and entering cmd. 

Step 3 Type the command avvid_migrate_save.cmd <servername><password> and press 
any key when prompted.

The output of this command will look similar to the following:

C:\>avvid_migrate_save jayas-w2k ciscocisco
A subdirectory or file C:\dcdsrvr\log already exists.

****************************************
*                                      *
* -- CISCO User Preferences Support -- *
*                                      *
****************************************

A subdirectory or file C:\dcdsrvr\suspense already exists.

Run the perl script avvid_migrate_save.pl
A subdirectory or file C:\dcdsrvr\log already exists.
A subdirectory or file 
C:\dcdsrvr\run\DCX500\config\Migration-Backup already
exi
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sts.
Saving User Information...
Saving Profile Information...
Saving Apps20 Information...
Saving Admin Information...
Saving PA node Information...
Saving E911 node Information...
Saving systemProfile...
Saving MITRA data...
Saving Groups data...

C:\>

Step 4 Stop the DC Directory service by entering net stop dcdirectory from the 
command prompt. 

Step 5 Run cleandsa.cmd or run deletedib.cmd if cleandsa.cmd reports that it is not 
supported. 

Step 6 Run avvid_migrate_cfg.exe. (Usage: avvid_migrate_cfg "<password>") 

Step 7 Run avvid_migrate_restore.cmd. (Usage: avvid_migrate_restore <Server 
Name> <DCDpassword>) 

Step 8 Run reconfig_cluster.cmd. (Usage: reconfig_cluster <DCDAdminPassword>) 

This command establishes replication agreements to all Cisco CallManager 
subscribers; there is no need to perform any tasks on any of the 
Cisco CallManager subscribers.
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Reconfiguring DC Directory on Cisco CallManager Publisher (database less than 100 Mb) 

Use the following procedure to reconfigure DC Directory in the 
Cisco CallManager publisher when the DCD database is less than 100 Mb 
(C:\dcdsrvr\run\dcx500\database). 

Procedure

Step 1 Run reconfig_cluster.cmd.

Step 2 This command establishes replication agreements to all Cisco CallManager 
subscriber servers; no additional steps need to be performed on any of the 
Cisco CallManager subscribers.

Reconfiguring DC Directory on the CRA/CRS Server 

Use the following procedure to reconfigure the DC Directory on the CRA/CRS 
server.

Procedure

Step 1 Stop DC Directory service.

Step 2 Run cleandsa.cmd or run deletedib.cmd if cleandsa.cmd reports that it is not 
supported. 

Step 3 Run avvid_scfg.cmd. (Usage: reconfig_cluster <DCDAdminPassword>)

Note If the network has a single Cisco CallManager server with or without 
co-located CRA/CRS, run reconfig_cluster.cmd. In this case, do not run 
the steps listed for the Cisco CRA/CRS server. 

Note If you upgrade, reinstall, or add a new Cisco CallManager server 3.2(2c) 
and earlier, or CRA 2.2(4) or earlier, and CRA 3.0(1), you must copy and 
run DCDScripts.1-0-5.exe as described in the Installation section. 
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Verification

Use the following procedure to verify that the DCD is stable and efficiently 
running.

Procedure

Step 1 From Cisco CallManager Administration, choose
User > Global Directory.

Step 2 Search for users.

Application Profiles Are Not Shown for User Configuration with 
the DC Directory

Symptom

When you are adding a user to the directory, the Application Profiles (such as 
AutoAttendant, Softphone, and Extension Mobility) do not display, and a user 
cannot be linked to those profiles.

Probable Cause

The Application Profiles were configured incorrectly.

Corrective Action

Use the following procedure to configure the application profile, so you can add 
or view users in the DC Directory.

Procedure

Step 1 Connect to the DC Directory Administrator.

Step 2 Choose Directory > cisco.com > CCN.
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Step 3 Click systemProfile.

Step 4 Right-click systemProfile and choose Properties.

Step 5 Click the Application Install Status tab.

Step 6 Check the values for the applications. If the values for “AA Installed,” “Softphone 
Installed,” “ASR Installed,” and “Hotelling Installed” are blank, go to Step 7.

Otherwise, proceed to Step 11.

Step 7 Choose Modify.

Step 8 Change the values from true to false and those that are false to true.

Step 9 Click Apply.

Step 10 Click OK.

Step 11 Repeat Step 4 and Step 5.

Step 12 Click Modify. 

All values should be visible.

Step 13 Change the value of the installed applications to true.

Step 14 Click Apply.

Step 15 Click OK.

Step 16 Click Services.

Step 17 In the right panel, choose World Wide Web Publishing Service.

Step 18 Click the Restart Service icon.

Step 19 Repeat all steps for all servers in the cluster in which you experienced the 
problem.

Verification

The Application Profiles display in the DC Directory.
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Add a New User Does Not Work and You Cannot Access the DC 
Directory Administrator

Symptom

You cannot add a user from Cisco CallManager Administration. Also, cannot log 
in to the DC Directory Administrator.

Adding a new user returns the following error.

Error Message Sorry your session object has timed out. Click here 
to Begin a New search.

Searching for a new user results in the page refreshing and waiting for input.

Probable Cause

The Directory Manager user password contains special characters, such as “^”.

Corrective Action

Use the following procedure to change the DC Directory password to one that 
does not contain special characters.

Note You must have superuser account privileges before you can change the DC 
Directory Manager password.

Note When you have a publisher server and one or more subscriber servers in a cluster, 
you must perform the steps in the following procedures on all 
Cisco CallManagers within the cluster.
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Procedure

Step 1 From Cisco CallManager Administration, choose Start > Programs > DC 
Directory Administrator.

Step 2 Click Next.

Step 3 In the Password field, enter the default password, cisco, and click Finish.

The DC Directory Administrator window displays.

Step 4 From the Tools menu, choose Change Password.

The Change User Password window appears.

Step 5 In the Old Value field, enter cisco.

Step 6 In the New Value field, enter a new password, without special characters.

Step 7 In the Confirm New Value field, reenter your new password.

Step 8 Click OK.

The DC Directory password is changed.

Step 9 Continue with Configuring the Windows Registry.

Cisco CallManager Administration also uses the Directory Manager account to 
perform add, remove, or update operations on the DC Directory LDAP server.

Configuring the Windows Registry

Use the following procedure to update the information that is stored in the registry 
to ensure that the registry is pointing to the correct directory.

Procedure

Step 1 Open a command line and enter c:\dcdsrvr\bin.

Step 2 Enter the passwordutils.exe password.

passwordutils.exe password

Step 3 Press Enter.

You need the Encrypted Password value information for the registry.
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Step 4 Choose Start > Run.

Step 5 In the Open field, enter regedit.

The Registry Editor window displays.

Step 6 Go to My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, 
Inc.\Directory Configuration.

LDAPURL must point to the correct directory.

ldap://host:port

Step 7 Double-click DCDMGRPW.

The Edit String window appears.

Step 8 In the Value Data field, enter the Encrypted Password value that you obtained in 
Step 3.

Step 9 Click OK.

Step 10 From the Registry Editor window, double-click MGRPW.

The Edit String window appears.

Step 11 In the Value Data field, enter the Encrypted Password value that you obtained in
Step 3.

Step 12 Click OK.

You have successfully changed the password in the registry.

Note After changing the registry entries, you must restart the WWW and IIS services 
on the Cisco CallManager node to pick up the latest settings from the registry.

Step 13 Choose Control Panel > Administrative Tools.

Step 14 Double-click Services.

The Services window displays.

Step 15 Choose Worldwide Web Publishing Service.

Step 16 Click Stop.

Step 17 Click Start.

Step 18 Choose DC Directory Server.
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Step 19 Click Stop.

Step 20 Click Start.

If you use CRA 2.x that connects to the DC Directory, you must update the 
password in the Application Administration pages. Continue with Reconfiguring 
the Directory Manager Password for CRA and E-services.

Reconfiguring the Directory Manager Password for CRA and E-services

If you use CRA 2.x that connects to the DC Directory, use the following procedure 
to update the password in the Application Administration pages.

Procedure

Step 1 Enter http://servername/AppAdmin where servername is the DNS name or IP 
address of your application server.

Step 2 When prompted, enter the network user name and password.

Step 3 Choose Directory Configuration.

The Directory Configuration window appears.

Step 4 In the Directory Password field, enter your new password.

Step 5 Click OK.

Verification

To verify that you successfully changed the Cisco CallManager DC Directory 
Manager password, use the following procedure.

Procedure

Step 1 From Cisco CallManager Administration, choose User > Global Directory.

The User Information window appears.
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Step 2 Click Search.

Step 3 If you can view the users that are configured in the system, the configuration was 
successful.

If you cannot view the users that are configured in the system, verify the following 
information:

• The new password is effective: Log in to the DC Directory with the new 
password.

• The encrypted password was entered correctly into the registry.

• The directory is pointing to the correct directory and not another directory 
(such as AD or an old directory which could be empty).

• The Worldwide Web Publishing and DC Directory services are restarted and 
running after the restart.

Related Information
For directory installation and configuration information, go to the following URL:

http://www.cisco.com/univercd/cc/td/doc/product/voice/c_callmg/4_0/install
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Device Issues

This chapter addresses the following common problems that you may experience 
with Cisco IP Phones, gateways, and related devices.

• Voice Quality

• Codec and Region Mismatches

• Location and Bandwidth

• Phone Issues

• Gateway Issues

• Gatekeeper Issues

• B-Channel Remains Locked When Restart_Ack Does Not Contain 
Channel IE

Voice Quality
You may experience voice quality issues including lost or distorted audio signal 
during phone calls. 

Common problems include audio breaks (like broken words) or the presence of 
odd noises and audio distortion, such as echo, and watery or robotic voice quality. 
One-way audio, that is, a conversation between two people where only one person 
can hear anything, does not actually represent a voice quality issue, but this 
section covers this issue.
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You may experience audio problems with one or more of the following items:

• Gateways

• Phones

• Networks

This section covers the following common voice quality problems:

• Lost or Distorted Audio

• Correcting Audio Problems from the Cisco IP Phone

• Echo

• One-Way Audio or No Audio

Lost or Distorted Audio

Symptom

One of the most common problems that you may encounter involves broken audio 
signal (often described as garbled speech or lost syllables within a word or 
sentence). Two common causes for this exist: packet loss and/or jitter. Packet loss 
means that audio packets do not arrive at their destination because they were 
dropped or arrived too late to be useful. Jitter describes the variation in the arrival 
times of packets. In the ideal situation, all Voice over IP (VoIP) packets would 
arrive exactly at a rate of 1 every 20 microseconds (ms). Notice that this is not the 
it takes for a packet to get from point A to point B but is simply the variation in 
packet arrival times. 

Probable Cause

Many sources of variable delay exist in a network. You can control some of these 
but not others. You cannot entirely eliminate variable delay in a packetized voice 
network. Digital Signal Processors (DSP) on phones and other voice-capable 
devices by design buffer some of the audio in anticipation of variable delay. This 
dejittering occurs only when the audio packet has reached its destination and 
ready to be put into a conventional audio stream. 
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The Cisco IP Phone 7960 can buffer as much as 1 second of voice samples. The 
jitter buffer is adaptive, meaning if a burst of packets is received, the 
Cisco IP Phone 7960 can play them out in an attempt to control the jitter. The 
network administrator needs to minimize the variation between packet arrival 
times by applying quality-of-service (QoS) and other measures in advance 
(especially if calls cross a WAN).

Some video endpoints may not support G.728 and using G.728 may result in 
noise. Use another codec, such as G.729.

Corrective Action

Procedure

Step 1 When you are faced with a lost or distorted audio problem, first try to isolate the 
path of the audio. Try to identify each network device (switches and routers) in 
the path of the call audio stream. Keep in mind that the audio may be between two 
phones, or between a phone and a gateway, or it could have multiple legs (from a 
phone to a transcoding device and from there to another phone). Try to identify 
whether the problem occurs only between two sites, only through a certain 
gateway, on a certain subnet, and so on. This will help narrow the number of 
devices that you need to look at more carefully. 

Step 2 Next, disable silence suppression (also known as Voice Activation Detection or 
VAD). This mechanism does save bandwidth by not transmitting any audio when 
there is silence but may cause noticeable or unacceptable clipping at the 
beginning of words.

Disable the service in Cisco CallManager Administration, choose Service > 
Service Parameters. From there, choose the server and the Cisco CallManager 
service as shown in Figure 6-1.
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Figure 6-1 Cisco CallManager Administration Service Menu

Step 3 Set SilenceSuppression to False to disable for all devices in a Cisco CallManager 
cluster; alternatively, you can set SilenceSuppressionForGateways to False. 
When in doubt, turn both off by choosing the value False for each. 

Step 4 Using a network analyzer, if a network analyzer is available, check whether a 
monitored call between two phones has 50 packets per second (or 1 packet every 
20 ms) when silence suppression is disabled. With proper filtering, you can 
identify whether an excessive number of packets are lost or delayed.

Remember that delay by itself will not cause clipping, only variable delay. Notice 
in the table below, which represents a perfect trace, the arrival times between the 
audio packets (which will have an RTP header) that will be 20 ms. In a poor 
quality call (such as a call with a lot of jitter), the arrival times would vary greatly.

The following table illustrates a perfect trace.

Packet Number Time - absolute (sec) Time - delta (ms)

1 0

2 0.02 20

3 0.04 20

4 0.06 20

5 0.08 20
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Placing the packet analyzer into various points in the network will help narrow the 
number of places from which the delay is coming from. If no analyzer is available, 
you will need to use other methods. Examine interface statistics of each device in 
the path of the audio. 

Diagnostic Call Detail Records (CDR) specifies another tool for tracking calls 
with poor voice quality. Refer to the Cisco CallManager Serviceability 
Administration Guide for more information about CDRs.

Correcting Audio Problems from the Cisco IP Phone

Symptom

Audio problems occurs while a call is in progress.

Probable Cause

Devices, where a higher speed interface feeds into a lower speed interface, 
provide the most common sources for delay and packet loss. For example, a router 
may have a 100 Megabyte (MB) fast Ethernet interface connected to the LAN and 
a slow frame-relay interface, connected to the WAN. If the poor audio quality 
occurs only when communicating to the remote site, the most likely causes of the 
problem include

• The router has not been properly configured to give voice traffic priority over 
data traffic.

• Too many active calls exist for the WAN to support (that is, no call admission 
control restricts the number of calls that can be placed).

• Physical port errors occur.

• Congestion in the WAN itself occurs.

On the LAN, the most common problems represent physical-level errors (such as 
CRC errors) that are caused by faulty cables, interfaces, or by incorrectly 
configured devices (such as a port speed or duplex mismatch). Make sure that the 
traffic is not crossing any shared-media device, such as a hub. 
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Corrective Action

The Cisco IP Phone 7960 provides another tool for diagnosing possible audio 
problems. 

Procedure

Step 1 On an active call, you can press the i button twice rapidly and the phone will 
display an information screen that contains packet receive and transmit statistics, 
as well as average and maximum jitter counters. 

Note On this screen, jitter represents the average of the last five packets that 
arrived; the maximum jitter designates the maximum for the average 
jitter.

Step 2 Situations could also occur where the traffic is taking a slower path through the 
network than expected. If QoS has been configured correctly, the possibility exists 
that there is no call admission control. Depending on your topology, you can 
accomplish this through the use of Locations in Cisco CallManager 
Administration configuration, or by using a Cisco IOS router as a gatekeeper. In 
any case, you should always know the maximum calls supported across your 
WAN.

Diagnosing Crackling Sounds

Step 3 Crackling is another poor quality symptom, which is sometimes caused by a 
defective power supply or some kind of strong electrical interference close to the 
phone. Try swapping the power supply and moving the phone.

Checking Your Loads

Step 4 Verify gateway and phone loads. Check Cisco Connection Online (CCO) at 
www.cisco.com for the latest software loads, new patches, or release notes 
relating to the problem.
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Verification

Procedure

Step 1 Test by disabling silence suppression as described in Lost or Distorted Audio; 
then, place calls between the two sites. Do not place the calls on hold or on mute 
because this will stop packets from being transmitted. 

Step 2 With the maximum number of calls across the WAN, the calls should all have 
acceptable quality. 

Step 3 Test to make sure that a fast busy is returned when you try to make one more call.

Echo

Symptom

Echo occurs when the speech energy being generated and transmitted down the 
primary signal path is coupled into the receive path from the far end. The speaker 
then hears his or her own voice, delayed by the total echo path delay time.

Voice can reflect back. This can happen but goes unnoticed in a traditional voice 
network because the delay is so low. To the user, it sounds more like a side-tone 
than an echo. In a VoIP network, it will always be noticeable because 
packetization and compression contribute to the delay.

Probable Cause

Remember that the cause of the echo is always with analog components and 
wiring. For instance, IP packets cannot simply turn around and go back to the 
source at a lower audio level or on digital T1/E1 circuits. The only exception may 
occur if one party is using a speakerphone that has the volume set too high or other 
situations where an audio loop is created.
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Corrective Action

Procedure

Step 1 Make sure that the problem phones are not using the speakerphone and that they 
have the headset volume set to reasonable levels (start with 50 percent of the 
maximum audio level). Most of the time, the problems occur when you attach to 
the PSTN by way of a digital or analog gateway.

Testing the Gateway

Step 2 Determine which gateway is being used. If a digital gateway is in use, you may be 
able to add additional padding in the transmit direction (towards the PSTN). 
Because lower signal strength will yield less reflected energy, this should clear the 
problem. 

Additionally, you can adjust the receive level, so any reflected audio is reduced 
even further. Remember to make small adjustments at a time. Too much 
attenuation of the signal will make the audio impossible to hear on both sides. 

Step 3 Alternatively, you can contact the carrier and request to have the lines checked. 
On a typical T1/PRI circuit in North America, the input signal should be -15 dB. 
If the signal level is much higher (-5 dB, for example), echo likely will result.

Keeping an Echo Log

Step 4 You should keep a log of all calls that experience echo. 

Record the time of the problem, the source phone number, and the number called. 
Gateways have a fixed time of 16 ms of echo cancellation. 

If the delay in the reflected audio is longer than this, the echo cancellor cannot 
work properly. This should not be an issue for local calls, and long distance calls 
should have external echo cancellers built into the network at the Central Office. 
This fact provides one of the reasons why it is important to note the external phone 
number of a call that experiences echo.

Checking Your Loads

Step 5 Verify your gateway and phone loads. Check Cisco Connection Online at 
www.cisco.com for the latest software loads, new patches, or release notes that 
may relate to the problem.
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One-Way Audio or No Audio

Symptom

When establishing a phone call from an IP station through a Cisco IOS voice 
gateway/router, only one of the parties receives audio (one-way communication).

When establishing a toll-bypass call between two Cisco gateways, only one of the 
parties receives audio (one-way communication).

Probable Cause

An improperly configured Cisco IOS Gateway, a firewall, or a routing or default 
gateway problem, among other things can cause this problem.

Corrective Action

Make Sure IP Routing is Enabled on Cisco IOS Gateway/Routers 

Some Cisco IOS gateways, such as the VG200, have IP routing disabled by 
default. This will lead to one-way voice problems.

Note Before going any further, make sure your router has IP routing enabled, in other 
words, does not have the global configuration command no ip routing.

To enable IP routing, simply type the following global configuration command in 
your Cisco IOS gateway:

voice-ios-gwy(config)#ip routing

Check Basic IP Routing 

Basic IP reachability should always be checked first. As RTP streams are 
connectionless (transported over UDP), traffic may travel successfully in one 
direction, but get lost in the opposite direction.
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Check the following:

• Default gateways configured at the end stations

• IP routes on the default gateways, mentioned above, leading to the destination 
networks

Note The following list explains how to verify the default router/gateway 
configuration on various Cisco IP phones:

• Cisco IP Phone 7910—Press Settings, select option 6, push volume down 
until the Default Router field shows up.

• Cisco IP Phone 7960/40—Press Settings, select option 3, scroll down until 
the Default Router field shows up.

• Cisco IP Phone 2sp+/30vip—Press **#, then press # until gtwy= shows up.

Note When using the Cisco IP SoftPhone application and more than one NIC 
(network interface card) is installed in the box, make sure the box sources 
the correct NIC. This issue is commonly present in Cisco IP SoftPhone 
software version 1.1.x (version 1.2 should resolve this issues).

Note For Cisco DT24+ Gateways, check the DHCP Scope and make sure there 
is a Default Gateway (003 router) option in the scope. The 003 router 
parameter is what populates the Default Gateway field in the devices and 
PCs. Scope option 3 should have the IP address of the router interface that 
will be doing routing for the gateway.

Bind the H.323 Signaling to a Specific IP Address on Cisco IOS Gateway/Routers 

When the Cisco IOS gateway has multiple active IP interfaces, some of the H.323 
signaling may be sourced from one IP address and other parts of it may reference 
a different source addresses. This can generate various kinds of problems, one of 
them being one-way audio.
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To avoid the problem, the H.323 signaling can be bound to a specific source 
address, which can belong to a physical or virtual interface (loopback). The 
command syntax to use under the interface configuration mode is 
h323-gateway voip bind srcaddr<ip address> . Configure this command under 
the interface with the IP address to which the Cisco CallManager points.

This command was introduced in Cisco IOS Release 12.1.2T and is documented 
in Configuring H.323 Support for Virtual Interfaces.

Caution A bug exists in version 12.2(6) where this solution can actually cause a one-way 
audio problem. For more information, refer to bug ID CSCdw69681 ( registered 
customers only) in Cisco Software Bug Toolkit ( registered customers only) .

Check that Answer Supervision is being Sent and Received Correctly from the Telco or 
Switch 

In an implementation that has a Cisco IOS gateway connected to a Telco or 
switch, verify that answer supervision is being sent correctly when the called 
device behind the Telco or switch answers the call. Failure to receive the answer 
supervision will cause the Cisco IOS gateway not to cut-through (open) the audio 
path in a forward direction causing one-way voice. A workaround is to configure 
voice rtp send-recv on.

Cut-through Two Way Audio Early Using voice rtp send-recv on Cisco IOS 
Gateway/Routers 

The voice path is established in the backward direction as soon as the RTP stream 
is started. The forward audio path will not be cut-through until the Cisco IOS 
gateway receives a Connect message from the remote end.

In some cases it is necessary to establish a two-way audio path as soon as the RTP 
channel is opened. In other words, before the connect message is received. To 
achieve this, use the voice rtp send-recv global configuration command.

Check cRTP Settings on a Link-by-Link Basis on Cisco IOS Gateway/Routers 

This issue applies to scenarios, such as toll-bypass, where more than one 
Cisco IOS router/gateway is involved in the voice path and Compressed RTP 
(cRTP) is used. cRTP, or RTP Header Compression, is a method for making the 
VoIP packet headers smaller to regain bandwidth. cRTP takes the 40-byte 
IP/UDP/RTP header on a VoIP packet and compresses it to 2-4 bytes per packet, 
yielding approximately 12Kb of bandwidth for a G.729 encoded call with cRTP.
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cRTP is done on a hop-by-hop basis with decompression and recompression on 
every hop. Each packet header needs to be examined for routing, therefore cRTP 
needs to be enabled on both sides of an IP link.

It is also important to verify that cRTP is working as expected on both ends of the 
link. Cisco IOS levels vary in terms of switching paths and concurrent cRTP 
support.

In summary, the history is:

• Until Cisco IOS Software Release 12.0.5T, cRTP is process-switched.

• In Cisco IOS Software Release 12.0.7T, and continuing in 12.1.1T, fast- and 
Cisco express forwarding (CEF)-switching support for cRTP is introduced.

• In Cisco IOS Software Release 12.1.2T, algorithmic performance 
improvements are introduced.

If you are running cRTP on Cisco IOS platforms (IOS Release 12.1), verify that 
bug CSCds08210 ( registered customers only) (VoIP and FAX not working with 
RTP header compression ON) does not affect your IOS version.

Verify Minimum Software Level for NAT on Cisco IOS Gateway/Routers 

If using Network Address Translation (NAT), the minimum software level 
requirements must be met. Earlier versions of NAT do not support skinny protocol 
translation and will lead to one-way voice issues.

The minimum software levels required for using NAT and skinny simultaneously 
are Cisco IOS® Software 12.1(5)T for IOS gateways to support skinny and 
H.323v2 with NAT. 

Note If your Cisco CallManager is using a TCP port for skinny signaling 
different from the default 2000, you need to adjust the NAT router with 
the ip nat service skinny tcp port<number> global configuration 
command.

The minimum software level required for using NAT and skinny simultaneously 
on a PIX firewall is 6.0. 

Note These levels of software will not necessarily support all of the RAS 
messages necessary for full gatekeeper support. Gatekeeper support is 
outside the scope of this document.
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Disable voice-fastpath on AS5350 and AS5400 

The Cisco IOS command voice-fastpath enable gets a hidden global 
configuration command for the AS5350 and AS5400, which is enabled by default. 
To disable it, use the no voice-fastpath enable global configuration command.

When enabled, this command caches the IP address and UDP port number 
information for the logical channel opened for a specific call and prevents the RTP 
stream from getting to the application layer, but rather forwards the packets at a 
lower layer. This helps reduce CPU utilization marginally in high call volume 
scenarios.

When supplementary services, such as hold or transfer are used, the 
voice-fastpath command causes the router to stream the audio to the cached IP 
address and UDP port, disregarding the new logical channel information 
generated after resuming a call on hold or completing a transfer. To get around 
this problem, traffic should go to the application layer constantly so that 
redefinition of the logical channel is taken into account and audio is streamed to 
the new IP address/UDP port pair. That is why we should disable voice-fastpath 
to support supplementary services.

Configure the VPN IP Address with SoftPhone 

Cisco IP SoftPhone offers the ability to make a PC work like a 
Cisco IP Phone 7900 Series phone. Remote users who connect back to their 
company network through VPN need to configure some additional settings in 
order to avoid a one-way voice problem. This is a result of the media stream 
having to know what the endpoint of the connection is.

The solution is to configure the VPN IP address, instead of the IP address of the 
network adapter under the Network Audio Settings.

Verification

A useful command to verify packet flow is debug cch323 rtp. This command 
displays packets transmitted (X) and received (R) by the router. An uppercase 
character indicates successful transmission/reception whereas a lowercase 
character indicates a dropped packet.

voice-ios-gwy#debug cch323 rtp
RTP packet tracing is enabled
voice-ios-gwy#
voice-ios-gwy#
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voice-ios-gwy#
voice-ios-gwy#
voice-ios-gwy#

!--- This is an unanswered outgoing call. 
!--- Notice that voice path only cuts through in forward
!--- direction and that packets are dropped. Indeed,
!--- received packets are traffic from the IP phone to the PSTN
!--- phone. These will be dropped until the call is answered. 

Mar 3 23:46:23.690: ****** cut through in FORWARD direction *****
XXXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXr
XrXrXrXrXrXr
XrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXr
XrXrXrXrXrXr
XrXrXXrrrrrrrrrrrrrrrr
voice-ios-gwy#
voice-ios-gwy#

!--- This is an example of an answered call:

voice-ios-gwy#
voice-ios-gwy#
*Mar 3 23:53:26.570: ****** cut through in FORWARD direction *****
XXXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXr
XrXrXrXrXrXr
XrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXrXr
XrXrXrXrXrXr
XXrrrrrXrXrXrXrXrXrXrXrXrXrXrXrrXXrrXrXrXrXrXrXXXXXXXXXXXXXXXXrXXXXXXX
XrXrXrXXrrXr
XrXrXrXrXrXrXrXrXXrrrrrrrrrrrrrrrrrrrrrrrrrrrrrr

!-- At this point the remote end picks up the phone.
 
*Mar 3 23:53:30.378: ****** cut through in BOTH direction *****
XRXRXRXRXRXRXRXRXXRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRXR
XRXRXRXRXRXR
XRXRXRXRXRXRXRXRXRXRXRXRXRXRXXRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRR
RRXRXRXRXRXR
XXRRXRXRXXRRXRXRXRXRXXRXRXRXRXRXRRXRXXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRX
RXRXRXRXRXR
XRXRXRXRXRXRXRXRXRXRXRXRXRXRXRRRRRRRRRRRRRRRRRRRRXRXRXRXRXRXRXRXRXRXRX
RXRXRXRXRXR
XRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXXRRRRRRRRRRRRRRRRRRRRRRRRRRRRXRXRXRXRXR
XRXRXRXRXR
XRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRR
RRRRRRRRRRRRRR
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RRRRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRRXXRXRXRXRXRXRRXRX
RXRXRXRXRXRXR
XRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXXRRRRXRXRXRXRXRXRXRXRXRXRXRXRXRXR
XRXRXRXR
XXRRRRRRRRRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRX
RXRXRXRXRXRXR
XRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXRXR
XRXRXRXRXRXR
XRXRXRXRXRXRXRXRXRXRXRXRXXRRRXR

!-- End of conversation.

Codec and Region Mismatches
If a user gets a reorder tone (busy signal) when going off hook, it could be the 
result of codec disagreement between regions. Verify that both call ends support 
at least one common codec (for example, G.711). If they do not, you will need to 
use transcoders.

A region specifies the range of supported codecs that can be used with each of the 
other regions. Every device belongs to a region.

Note Codec negotiation with a Cisco IOS router is not supported.

For example, Region1<->Region2 = G.711, means that a call between a device in 
Region1 and a device in Region2 can use G.711 or any other supported codec that 
requires the same or less bandwidth as G.711 (any supported codecs within G.711, 
G.729, G.723, and so on).

Note The following list gives codecs that are supported for each device:
Cisco IP Phone 7960—G.711A-law/µ-law, G.729, G729A, G.729Annex-B
Cisco IP Phone SP12 series and VIP 30—G.711a-law/mu-law, G.723.1
Cisco Access Gateway DE30 and DT-24+—G.711a-law/mu-law, G.723.1
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Location and Bandwidth
If a user gets a reorder tone after dialing a number, this could happen because the 
Cisco CallManager bandwidth allocation for the location of one of the call end 
devices has been exceeded. Cisco CallManager checks for the available 
bandwidth for each device before making a call. If no bandwidth is available, 
Cisco CallManager will not set up the call, and the user receives a reorder tone.

12:42:09.017 Cisco CallManager|Locations:Orig=1 BW=12Dest=0 BW=-1(-1 
implies infinite bw available)
12:42:09.017 Cisco CallManager|StationD - stationOutputCallState 
tcpHandle=0x4f1ad98
12:42:09.017 Cisco CallManager|StationD - stationOutputCallInfo 
CallingPartyName=,  CallingParty=5003, CalledPartyName=, 
CalledParty=5005, tcpHandle=0x4f1ad98
12:42:09.017 Cisco CallManager|StationD - stationOutputStartTone: 
37=ReorderTone tcpHandle=0x4f1ad98

Once the call is established, the Cisco CallManager will subtract bandwidth from 
the locations, depending on the codec used in that call. 

• If the call is using G.711, Cisco CallManager subtracts 80k.

• If the call is using G.723, Cisco CallManager subtracts 24k.

• If the call is using G.729, Cisco CallManager subtracts 24k.

Phone Issues
This section addresses the following phone issues:

• Phone Resets

• Dropped Calls
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Phone Resets

Symptom

Phone resets.

Probable Cause

Phones will power cycle or reset for two reasons: 

• TCP failure connecting to Cisco CallManager

• Failure to receive an acknowledgement to the phone KeepAlive messages.

Corrective Action

Procedure

Step 1 Check the phones and gateways to ensure that you are using the latest software 
loads.

Step 2 Check Cisco Connection Online at www.cisco.com for the latest software loads, 
new patches, or release notes that may relate to the problem.

Step 3 Check the Event Viewer for instances of phone(s) resetting. Phone resets 
represent considered Information events. 

Step 4 Look for any errors that may have occurred around the time that the phone(s) 
reset.
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Step 5 Start an SDI trace and try to isolate the problem by identifying any common 
characteristics in the phones that are resetting. For example, check whether they 
are all located on the same subnet, same VLAN, and so on. Look at the trace and 
determine:

• If the resets occur during a call or happen intermittently

• If there any similarities of phone model (such as Cisco IP Phone 7960 or 
Cisco IP Phone 30VIP)

Step 6 Start a Sniffer trace on a phone that frequently resets. After it has reset, look at 
the trace to determine if there are any TCP retries occurring. If so, this indicates 
a network problem. The trace may show some consistencies in the resets, such as 
the phone resetting every seven days. This might indicate DHCP lease expiration 
every seven days (this value is user-configurable; for example, it could be every 
two minutes).

Dropped Calls

Symptom

Premature termination of dropped calls.

Probable Cause

Premature termination of dropped calls can be the result of a phone or gateway 
resetting (see Phone Resets) or a circuit problem, such as incorrect PRI 
configuration. 

Corrective Action

Procedure

Step 1 Determine whether this problem is isolated to one phone or to a group of phones. 
Perhaps you will find that the affected phones are all on a particular subnet or 
location. 
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Step 2 Check the Event Viewer for phone or gateway resets. 

You will see one Warning and one Error message for each phone that resets. This 
indicates that the phone cannot keep its TCP connection to the Cisco CallManager 
alive, so the Cisco CallManager resets the connection. This may occur because a 
phone was turned off or a problem may exist in the network. If this is an 
intermittent problem, you may find it useful to use Microsoft Performance to 
record phone registrations.

Step 3 If the problem seems to be occurring only through a certain gateway, such as a 
Cisco Access DT-24+, the best course of action is to enable tracing and/or view 
the Call Detail Records (CDR). The CDR files will give a cause of termination 
(CoT) that may help determine the cause of the problem. Refer to the 
Cisco CallManager Serviceability Administration Guide for detailed information 
on CDRs.

Step 4 Find the disconnect cause values (origCause_value and destCause_value— 
depending on which side hung up the call), that map to Q.931 disconnect cause 
codes (in decimal) at the following location:

http://www.cisco.com/univercd/cc/td/doc/product/software/ios113ed/dbook/disdn.htm.

Step 5 If the call is going out of a gateway to the PSTN, you can use the CDR to 
determine which side is hanging up the call. Obtain much of the same information 
by enabling tracing on the Cisco CallManager. Because the trace tool can affect 
Cisco CallManager performance, you will want to use this option only as a last 
resort or if your network is not yet in production.

Gateway Issues
This section addresses the following gateway issues:

• Gateway Reorder Tone

• Gateway Registration Failure
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Gateway Reorder Tone

Symptom

Reorder tone occurs.

Probable Cause

Users placing a call through the gateway might get a reorder tone if they are 
attempting to make a restricted call or to call a number that has been blocked. A 
reorder tone may occur if the dialed number is out of service or if the PSTN has 
an equipment or service problem. 

Check to be sure that the device giving the reorder tone has registered. Also, check 
your dial plan configuration to ensure that the call can be successfully routed.

Corrective Action

The following procedure shows the steps for troubleshooting reorder tones 
through gateways.

Procedure

Step 1 Check the gateways to ensure that you are using the latest software loads.

Step 2 Check Cisco Connection Online at www.cisco.com for the latest software loads, 
new patches, or release notes relating to the problem.

Step 3 Start an SDI trace and re-create the problem. Reorder tones could be the result of 
a configuration issue with location-based admission control or gatekeeper-based 
admission control where the Cisco CallManager might limit the number of 
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allowable calls. In the SDI trace, locate the call to determine if it was blocked 
intentionally by a route pattern or the calling search space or by any other 
configuration setting.

Step 4 Reorder tones can also occur when calling occurs through the PSTN. Check the 
SDI trace for Q.931 messages, in particular for disconnect messages. If a Q.931 
disconnect message is present, it means that the other party caused the disconnect, 
and you cannot correct for that.

Gateway Registration Failure
This section describes two similar but different categories of gateways. The 
Cisco Access AS-X, AT-X and Cisco Access DT-24+ and DE-30+ belong to one 
category. These gateways identify stand-alone units that are not directly 
connected to a Network Management Processor (NMP). The second category 
includes the Analog Access WS-X6624 and Digital Access WS-X6608. These 
gateways, as blades installed in a Catalyst 6000 chassis, provide direct 
connectivity to the NMP for control and statusing.

Symptom

A registration problem represents one of the most common issues that are 
encountered with gateways on a Cisco CallManager.

Probable Cause

Registration can fail for a variety of reasons.

Corrective Action

Procedure

Step 1 First, check that the gateway is up and running. All gateways have a heartbeat 
LED that blinks 1-second-on, 1-second-off when the gateway software is running 
normally. 
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If this LED is not blinking at all, or blinking very rapidly, the gateway software is 
not running. Normally, this results in an automatic reset of the gateway. Also, it 
is normal for the gateway to reset itself if it cannot complete the registration 
process after about 2 to 3 minutes. So, you may happen to look at the heartbeat 
LED while the device is resetting, but if the normal blinking pattern does not 
appear in 10 to 15 seconds, the gateway has suffered a serious failure. 

On the Cisco Access Analog gateways, find the green heartbeat LED on the far 
right of the front panel. On the Cisco Access Digital gateways, find the red LED 
on the far left on the top edge of the card. On the Cisco Analog Access 
WS-X6624, a green LED appears inside the blade (not visible from the front 
panel) on the far right card edge near the front. Finally, on the Digital Access 
WS-X6608, a separate heartbeat LED exists for each of the 8 spans on the blade. 
Eight red LEDs appear across the card (not visible from the front panel) about two 
thirds of the way towards the back.

Step 2 Check that the gateway received its IP address. A standalone gateway must 
receive its IP address via DHCP or BOOTP. A Catalyst gateway may receive its 
IP address by DHCP, BOOTP or by manual configuration through the NMP. 

Step 3 If you have access to the DHCP server, the best way to check a standalone gateway 
is to verify that the device has an outstanding lease on an IP address. If the 
gateway shows up on your server, this provides a good indication but is not 
definitive. Delete the lease at the DHCP server.

Step 4 Reset the gateway. 

Step 5 If the gateway reappears on the server with a lease within a couple of minutes, 
everything works fine in this area. If not, either the gateway cannot contact the 
DHCP server (Is a router improperly configured and not forwarding DHCP 
broadcasts? Is the server running?) or cannot get a positive response (Is the IP 
address pool depleted?). 

Step 6 If performing these checks does not yield the answer, use a sniffer trace to 
determine the specific problem.

Step 7 For a Catalyst 6000 gateway, you should check to make sure that the NMP can 
communicate with the gateway. You can check this by trying to ping its internal 
IP address from the NMP. 

The IP address uses this format:

127.1.module.port

For example, for port 1 on module 7, you would enter

Console (enable) ping 127.1.7.1
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127.1.7.1 is alive

Step 8 If pinging works, the show port command shows the IP address information. 
Make sure that the IP address information and the TFTP IP address is correct as 
well. 

Step 9 If the gateway is failing to obtain valid DHCP information, use the tracy utility 
(supplied by Cisco TAC) to determine the problem. 

Step 10 After obtaining this utility from TAC, issue the following command from the 
Cat6000 Command Line Interface (CLI):

tracy_start mod port

In this example, the WS-X6624 represents module 7, and it has only a single 860 
processor, so it is port 1. The command to issue is tracy_start 7 1.

The following output actually comes from the 860-console port on the gateway 
board itself; however, the output of the tracy command represents nothing more 
than a remote copy of the 860-console port.

      |             |      
      |             |      
    | | |         | | |     
   | | | | |     | | | | |    
| | | | | | |:.:| | | | | | |:..
C i s c o   S  y s t e m s
CAT6K Analog Gateway (ELVIS)
APP Version : A0020300, DSP Version : A0030300, Built Jun  1 2000 
16:33:01

ELVIS>> 00:00:00.020 (XA) MAC Addr : 00-10-7B-00-13-DE
00:00:00.050 NMPTask:got message from XA Task
00:00:00.050 (NMP) Open TCP Connection ip:7f010101
00:00:00.050 NMPTask:Send Module Slot Info
00:00:00.060 NMPTask:get DIAGCMD
00:00:00.160 (DSP) Test Begin -> Mask<0x00FFFFFF>
00:00:01.260 (DSP) Test Complete -> Results<0x00FFFFFF/0x00FFFFFF>
00:00:01.260 NMPTask:get VLANCONFIG
00:00:02.870 (CFG) Starting DHCP
00:00:02.870 (CFG) Booting DHCP for dynamic configuration.
00:00:06.570 (CFG) DHCP Request or Discovery Sent, DHCPState = 
INIT_REBOOT
00:00:06.570 (CFG) DHCP Server Response Processed, DHCPState = 
INIT_REBOOT
00:00:06.780 (CFG) IP Configuration Change!  Restarting now...
00:00:10.480 (CFG) DHCP Request or Discovery Sent, DHCPState = INIT
00:00:14:480 (CFG) DHCP Timeout Waiting on Server, DHCPState = INIT
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00:00:22:480 (CFG) DHCP Timeout Waiting on Server, DHCPState = INIT
00:00:38:480 (CFG) DHCP Timeout Waiting on Server, DHCPState = INIT

If this timeout message continues to scroll by, a problem exists with contacting 
the DHCP server. 

Step 11 First, check that the Catalyst 6000 gateway port is in the correct VLAN. 

You will find this information in the information that you retrieved by using the 
show port command. 

Step 12 If the DHCP server is not on the same VLAN as the Catalyst 6000 gateway, then 
make sure that the appropriate IP helper addresses have been configured to 
forward the DHCP requests to the DHCP server. The gateway can get stuck in the 
INIT state after a VLAN number change until the gateway resets. 

Step 13 When in the INIT state, try resetting the gateway. Every time that the 860 gets 
reset, your tracy session will be lost, so you must close your existing session and 
reestablish a new one by issuing the following commands:

tracy_close mod port

tracy_start mod port

Step 14 If you are still seeing the DHCPState = INIT messages, check whether the DHCP 
server is functioning correctly.

Step 15 If so, start a sniffer trace to see whether the requests are being sent and the server 
is responding.

Once DHCP is working correctly, the gateway will have an IP address that allows 
the use of the tracy debugging utility. This utility includes a built in feature of the 
NMP command set for the Catalyst gateways and is available as a helper 
application that runs on Windows 98/NT/2000 for the standalone gateways. 

Step 16 To use the helper application tracy utility, connect to the gateway by using the IP 
address to which it is assigned. This tracy application works on all the gateways, 
provides a separate trace window for each gateway (up to eight may be traced at 
once), and allows traces to be logged directly to a file that you specify.

Step 17 Verify that the TFTP server IP address was correctly provided to the gateway. 
DHCP normally provides DHCP in Option 66 (by name or IP address), Option 
150 (IP address only), or si_addr (IP address only). If your server has multiple 
Options configured, si_addr will take precedence over Option 150, which will 
take precedence over Option 66. 
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If Option 66 provides the DNS_NAME of the TFTP server, then the DNS 
server(s) IP address(es) must have been specified by DHCP, and the name entered 
in Option 66 must resolve to the correct TFTP server IP address. The NMP could 
configure a Catalyst gateway could be configured by the NMP to disable DHCP, 
and the NMP operator must then manually enter all configuration parameters at 
the console, including the TFTP server address.

Additionally, the gateways will always attempt to resolve the name CiscoCM1 via 
DNS. If successful, the CiscoCM1 IP address will take precedence over anything 
that the DHCP server or NMP tells it for the TFTP server address, even if the NMP 
has DHCP disabled.

Step 18 You can check the current TFTP server IP address in a gateway by using the tracy 
utility. Enter the following command to get the configuration task number:

TaskID: 0
Cmd:    show tl

Look for a line with config or CFG and use the corresponding number as the 
taskID for the next line, such as, for the Cisco Access Digital gateway. In the 
examples that follow, bolded lines of text make it easier for you to see the 
messages being explained. In the actual display output, text does not appear 
bolded. The examples come from an WS-X6624 model; the command to dump the 
DHCP information is

TaskID: 6
Cmd:     show dhcp

Step 19 The TFTP server IP address then appears. If it is not correct, verify that your 
DHCP options and other information that it provides are correct.

Step 20 Once the TFTP address is correct, ensure that the gateway is getting its 
configuration file from the TFTP server. If you see the following information in 
the tracy output, your TFTP service may not be working correctly, or the gateway 
might not be configured on the Cisco CallManager:

00:09:05.620 (CFG) Requesting SAA00107B0013DE.cnf File From TFTP 
Server
00:09:18.620 (CFG) TFTP Error: Timeout Awaiting Server Response for 
.cnf File!

The gateway attempts to connect to the same IP address as the TFTP server if it 
does not get a configuration file. This works fine unless you are in a clustered 
environment in which the gateway needs to receive its list of redundant 
Cisco CallManagers.
6-25
Troubleshooting Guide for Cisco CallManager Release 4.0(1)

OL-4617-01



 

Chapter 6      Device Issues
Gateway Issues
Step 21 If the card is not getting its TFTP information correctly, check the TFTP service 
on the Cisco CallManager and make sure it is running. 

Step 22 Check the TFTP trace on the Cisco CallManager. 

Another common problem occurs if the gateway is not configured correctly on the 
Cisco CallManager. A typical error involves entering an incorrect MAC address 
for the gateway. If this is the case, for a Catalyst 6000 gateway, you will probably 
get the following messages on the NMP console every 2 minutes:

2000 Apr 14 19:24:08 %SYS-4-MODHPRESET:Host process (860) 7/1 got 
reset asynchronously
2000 Apr 14 19:26:05 %SYS-4-MODHPRESET:Host process (860) 7/1 got 
reset asynchronously
2000 Apr 14 19:28:02 %SYS-4-MODHPRESET:Host process (860) 7/1 got 
reset asynchronously

The following example shows what the tracy output would look like if the gateway 
is not in the Cisco CallManager database:

00:00:01.670 (CFG) Booting DHCP for dynamic configuration.
00:00:05.370 (CFG) DHCP Request or Discovery Sent, DHCPState = 
INIT_REBOOT
00:00:05.370 (CFG) DHCP Server Response Processed, DHCPState = BOUND
00:00:05.370 (CFG) Requesting DNS Resolution of CiscoCM1
00:00:05.370 (CFG) DNS Error on Resolving TFTP Server Name.
00:00:05.370 (CFG) TFTP Server IP Set by DHCP Option 150 = 10.123.9.2
00:00:05.370 (CFG) Requesting SAA00107B0013DE.cnf File From TFTP 
Server
00:00:05.370 (CFG) TFTP Error: .cnf File Not Found!
00:00:05.370 (CFG) Requesting SAADefault.cnf File From TFTP Server
00:00:05.380 (CFG) .cnf File Received and Parsed Successfully.
00:00:05.380 (CFG) Updating Configuration ROM...
00:00:05.610 GMSG: GWEvent = CFG_DONE --> GWState = SrchActive
00:00:05.610 GMSG: CCM#0 CPEvent = CONNECT_REQ --> CPState = 
AttemptingSocket
00:00:05.610 GMSG: Attempting TCP socket with CCM 10.123.9.2
00:00:05.610 GMSG: CCM#0 CPEvent = SOCKET_ACK --> CPState = BackupCCM
00:00:05.610 GMSG: GWEvent = SOCKET_ACK --> GWState = RegActive
00:00:05.610 GMSG: CCM#0 CPEvent = REGISTER_REQ --> CPState = 
SentRegister
00:00:05.680 GMSG: CCM#0 CPEvent = CLOSED --> CPState = NoTCPSocket
00:00:05.680 GMSG: GWEvent = DISCONNECT --> GWState = Rollover
00:00:20.600 GMSG: GWEvent = TIMEOUT --> GWState = SrchActive
00:00:20.600 GMSG: CCM#0 CPEvent = CONNECT_REQ --> CPState = 
AttemptingSocket
00:00:20.600 GMSG: Attempting TCP socket with CCM 10.123.9.2
00:00:20.600 GMSG: CCM#0 CPEvent = SOCKET_ACK --> CPState = BackupCCM
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Another possible registration problem could be that the load information is 
incorrect or the load file is corrupt. The problem could also occur if the TFTP 
server is not working. In this case, tracy shows that the TFTP server reported that 
the file is not found:

00:00:07.390 GMSG: CCM#0 CPEvent = REGISTER_REQ --> CPState = 
SentRegister
00:00:08.010 GMSG: TFTP Request for application load A0021300
00:00:08.010 GMSG: CCM#0 CPEvent = LOADID --> CPState = AppLoadRequest
00:00:08.010 GMSG: ***TFTP Error: File Not Found***
00:00:08.010 GMSG: CCM#0 CPEvent = LOAD_UPDATE --> CPState = 
LoadResponse

In this case, the gateway requests application load A0021300, although the correct 
load name would be A0020300. For a Catalyst 6000 gateway, the same problem 
can occur when a new application load needs to get its corresponding DSP load 
as well. If the new DSP load is not found, a similar message will appear. 

ELVIS>> 00:00:00.020 (XA) MAC Addr : 00-10-7B-00-13-DE
00:00:00.050 NMPTask:got message from XA Task
00:00:00.050 (NMP) Open TCP Connection ip:7f010101
00:00:00.050 NMPTask:Send Module Slot Info
00:00:00.060 NMPTask:get DIAGCMD
00:00:00.160 (DSP) Test Begin -> Mask<0x00FFFFFF>
00:00:01.260 (DSP) Test Complete -> Results<0x00FFFFFF/0x00FFFFFF>
00:00:01.260 NMPTask:get VLANCONFIG
00:00:02.030 (CFG) Starting DHCP
00:00:02.030 (CFG) Booting DHCP for dynamic configuration.
00:00:05.730 (CFG) DHCP Request or Discovery Sent, DHCPState = 
INIT_REBOOT
00:00:05.730 (CFG) DHCP Server Response Processed, DHCPState = BOUND
00:00:05.730 (CFG) Requesting DNS Resolution of CiscoCM1
00:00:05.730 (CFG) DNS Error on Resolving TFTP Server Name.
00:00:05.730 (CFG) TFTP Server IP Set by DHCP Option 150 = 10.123.9.2
00:00:05.730 (CFG) Requesting SAA00107B0013DE.cnf File From TFTP 
Server
00:00:05.730 (CFG) .cnf File Received and Parsed Successfully.
00:00:05.730 GMSG: GWEvent = CFG_DONE --> GWState = SrchActive
00:00:05.730 GMSG: CCM#0 CPEvent = CONNECT_REQ --> CPState = 
AttemptingSocket
00:00:05.730 GMSG: Attempting TCP socket with CCM 10.123.9.2
00:00:05.730 GMSG: CCM#0 CPEvent = SOCKET_ACK --> CPState = BackupCCM
00:00:05.730 GMSG: GWEvent = SOCKET_ACK --> GWState = RegActive
00:00:05.730 GMSG: CCM#0 CPEvent = REGISTER_REQ --> CPState = 
SentRegister
00:00:06.320 GMSG: CCM#0 CPEvent = LOADID --> CPState = LoadResponse
00:01:36.300 GMSG: CCM#0 CPEvent = TIMEOUT --> CPState = BadCCM
00:01:36.300 GMSG: GWEvent = DISCONNECT --> GWState = Rollover
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00:01:46.870 GMSG: CCM#0 CPEvent = CLOSED --> CPState = NoTCPSocket
00:01:51.300 GMSG: GWEvent = TIMEOUT --> GWState = SrchActive
00:01:51.300 GMSG: CCM#0 CPEvent = CONNECT_REQ --> CPState = 
AttemptingSocket
00:01:51.300 GMSG: Attempting TCP socket with CCM 10.123.9.2
00:01:51.300 GMSG: CCM#0 CPEvent = SOCKET_ACK --> CPState = BackupCCM
00:01:51.300 GMSG: GWEvent = SOCKET_ACK --> GWState = RegActive
00:01:51.300 GMSG: CCM#0 CPEvent = REGISTER_REQ --> CPState = 
SentRegister
00:01:51.890 GMSG: CCM#0 CPEvent = LOADID --> CPState = LoadResponse

The difference here is that the gateway gets stuck in the LoadResponse stage and 
eventually times out. You can resolve this problem by correcting the load file 
name in the Device Defaults area of Cisco CallManager Administration.

Gatekeeper Issues
Before starting any gatekeeper troubleshooting, verify that IP connectivity exists 
within the network. Assuming that there is IP connectivity, use the following 
information in this section to troubleshoot your gatekeeper calls:

• Intercluster Trunks or H.225 Trunks

• Admission Rejects

• Registration Rejects

Intercluster Trunks or H.225 Trunks
Refer to the Cisco CallManager Administration Guide and Cisco CallManager 
System Guide at the following location:

http://www.cisco.com/univercd/cc/td/doc/product/voice/c_callmg/4_0/index.htm
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Admission Rejects

Symptom

The system issues Admission Rejects (ARJ) when Cisco CallManager has 
registered with the Gatekeeper but cannot send a phone call.

Probable Cause

Configuration issues on the gatekeeper should be the primary focus when the 
gatekeeper issues an ARJ.

Corrective Action

Procedure

Step 1 Verify IP connectivity from the Cisco CallManager to the gatekeeper.

Step 2 Show gatekeeper status and verify that the gatekeeper state is up.

Step 3 Is there a zone subnet defined on the gatekeeper? If so, verify that the subnet of 
the Cisco CallManager is in the allowed subnets.

Step 4 Verify that the technology prefix matches between the Cisco CallManager and the 
gatekeeper configuration.

Step 5 Verify the bandwidth configuration.

Registration Rejects

Symptom

The system issues Registration Rejects (RRJ) when Cisco CallManager cannot 
register with the gatekeeper. 
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Probable Cause

Configuration issues on the gatekeeper should be the primary focus when the 
gatekeeper is issuing a RRJ.

Corrective Action

Procedure

Step 1 Verify IP connectivity from the Cisco CallManager to the gatekeeper.

Step 2 Show gatekeeper status and verify that the gatekeeper state is up.

Step 3 Is there a zone subnet defined on the gatekeeper? If so, verify that the subnet of 
the gateway is in the allowed subnets.

Cisco CallManager Locks the B-Channel and Sends 
Restart

This section covers the following:

• Channel Restarts

• B-Channel Remains Locked When Restart_Ack Does Not Contain 
Channel IE

Channel Restarts

Symptom

Cisco CallManager locks the B-channel and sends a restart on that channel for no 
apparent reason. For related information, see B-Channel Remains Locked When 
Restart_Ack Does Not Contain Channel IE.
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Outbound calls cause DSPs to lockup. 

Note Release 3.1(2c) Engineer Special 21 resolves this problem.

Probable Cause

Your ISDN channel selection order causes a glare condition. This may occur when 
a high volume of calls occurs.

Also, B-channel selection for outgoing calls is exclusive (the Cisco CallManager 
does not accept other B-channels). If a channel is not available, the PABX or CO 
sends Release Complete.

Corrective Action

Procedure

Step 1 From Cisco CallManager Administration, choose Device > Gateway as shown in 
Figure 6-2.

Figure 6-2 Cisco CallManager Administration Device Menu

The Find and List Gateways window displays.
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Step 2 Enter search criteria to locate a specific gateway as shown in Figure 6-3.

Figure 6-3 Find and List Gateways Window

Step 3 Click Find.

A list of discovered devices displays.

Step 4 Click the device name of the gateway that you want to update.

The Gateway Configuration window appears.

Step 5 To access gateway ports, click the icon of the gateway port or the MGCP endpoint 
link on the left side of the configuration window for the chosen gateway.

Step 6 Check the Inhibit Restarts at PRI initialization check box as shown in 
Figure 6-4.
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Figure 6-4 Interface Information Window

Step 7 Click Update.

Step 8 Reset the gateway to apply the changes.

Step 9 Restart the Cisco CallManager server.

Note You must restart the Cisco CallManager server to clear the restart 
problem after checking the Inhibit Restarts at PRI Initialization check 
box.

For detailed information on E1/T1 PRI configuration settings, refer to the 
Cisco CallManager Administration Guide.
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B-Channel Remains Locked When Restart_Ack Does Not Contain 
Channel IE

Symptom

This issue relates to the previous issue: Cisco CallManager Locks the B-Channel 
and Sends Restart.

When the Cisco CallManager system receives a Release Complete with cause 
ie=channel not available, the system sends out a Restart to bring this channel back 
to the idle state.

Probable Cause

In the Restart, you specify with the Channel IE which channel(s) must be 
restarted. If the network responds with Restart_Ack without the Channel IE, the 
system keeps this channel in a locked state. While on network side, this same 
channel goes back to idle state.

Now you end up with the network requesting this channel for inbound calls.

Because the channel is locked on the Cisco CallManager server, the 
Cisco CallManager releases any call requests for this channel.

This behavior occurs on numerous sites in the UK and when the gateway is an E1 
blade (most likely the same happens when using MGCP backhaul on the 
2600/3600).

A glare condition provides the likely reason for the Release Complete.

You see this frequent happening on sites where a high call volume occurs.

If the B-channel selection on the network is top-down or bottom up, all inbound 
calls will fail until a B-channel in the higher/lower range is freed (if an active call 
gets cleared).

When B-channel selection is round-robin over a certain time, you will end up with 
an E1 blade with all locked B-channels.

Corrective Action

Reset the E1 port.
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Verification

The B-channel(s) return to the idle state.
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C H A P T E R 7

Dial Plans and Routing Issues

This chapter addresses the following common problems that you may experience 
with dial plans, route partitions, and calling search spaces.

• Route Partitions and Calling Search Spaces

• Dial Plan Issues

Route Partitions and Calling Search Spaces
Route partitions inherit the error-handling capabilities for the Cisco CallManager 
software. That is, a console and SDI file trace are provided for logging 
information and error messages. These messages will be part of the digit analysis 
component of the traces. You must be sure that you know how the Partitions and 
Calling Search Spaces are configured and what devices are in each partition and 
its associated calling search space to determine the source of the problem. The 
Calling Search Space determines what numbers are available for making a call. 
The Partition determines allowable calls to a device or route list.

Refer to the route plan chapters in the Cisco CallManager Administration Guide 
and the Cisco CallManager System Guide for more information.

The following trace shows an example of a dialed number that is in the device 
Calling Search Space. For more detailed explanations about SDI traces, review 
the case studies in this document.

08:38:54.968 Cisco CallManager|StationInit - InboundStim - 
OffHookMessageID tcpHandle=0x6b88028
08:38:54.968 Cisco CallManager|StationD - stationOutputDisplayText 
tcpHandle=0x6b88028, Display= 5000 
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08:38:54.968 Cisco CallManager|StationD - stationOutputSetLamp stim: 
9=Line instance=1 lampMode=LampOn tcpHandle=0x6b88028
08:38:54.968 Cisco CallManager|StationD - stationOutputCallState 
tcpHandle=0x6b88028
08:38:54.968 Cisco CallManager|StationD - 
stationOutputDisplayPromptStatus tcpHandle=0x6b88028
08:38:54.968 Cisco CallManager|StationD - stationOutputSelectSoftKeys 
tcpHandle=0x6b88028
08:38:54.968 Cisco CallManager|StationD - 
stationOutputActivateCallPlane tcpHandle=0x6b88028
08:38:54.968 Cisco CallManager|Digit analysis: match(fqcn="5000", 
cn="5000", pss="RTP_NC_Hardwood:RTP_NC_Woodland:Local RTP", dd="")

In the Digit Analysis component of the previous trace, the pss (Partition Search 
Space, also known as Calling Search Space) gets listed for the device placing the 
call. 

In the following trace, RTP_NC_Hardwood;RTP_NC_Woodland;Local_RTP 
represent the partitions that this device is allowed to call.

08:38:54.968 Cisco CallManager|Digit analysis: 
potentialMatches=PotentialMatchesExist
08:38:54.968 Cisco CallManager|StationD - stationOutputStartTone: 
33=InsideDialTone tcpHandle=0x6b88028
08:38:55.671 Cisco CallManager|StationInit - InboundStim - 
KeypadButtonMessageID kpButton: 5 tcpHandle=0x6b88028
08:38:55.671 Cisco CallManager|StationD - stationOutputStopTone 
tcpHandle=0x6b88028
08:38:55.671 Cisco CallManager|StationD - stationOutputSelectSoftKeys 
tcpHandle=0x6b88028
08:38:55.671 Cisco CallManager|Digit analysis: match(fqcn="5000", 
cn="5000", pss="RTP_NC_Hardwood:RTP_NC_Woodland:Local RTP", dd="5")
08:38:55.671 Cisco CallManager|Digit analysis: 
potentialMatches=PotentialMatchesExist
08:38:56.015 Cisco CallManager|StationInit - InboundStim - 
KeypadButtonMessageID kpButton: 0 tcpHandle=0x6b88028
08:38:56.015 Cisco CallManager|Digit analysis: match(fqcn="5000", 
cn="5000", pss="RTP_NC_Hardwood:RTP_NC_Woodland:Local RTP", dd="50")
08:38:56.015 Cisco CallManager|Digit analysis: 
potentialMatches=PotentialMatchesExist
08:38:56.187 Cisco CallManager|StationInit - InboundStim - 
KeypadButtonMessageID kpButton: 0 tcpHandle=0x6b88028
08:38:56.187 Cisco CallManager|Digit analysis: match(fqcn="5000", 
cn="5000", pss="RTP_NC_Hardwood:RTP_NC_Woodland:Local RTP", dd="500")
08:38:56.187 Cisco CallManager|Digit analysis: 
potentialMatches=PotentialMatchesExist
08:38:56.515 Cisco CallManager|StationInit - InboundStim - 
KeypadButtonMessageID kpButton: 3 tcpHandle=0x6b88028
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08:38:56.515 Cisco CallManager|Digit analysis: match(fqcn="5000", 
cn="5000", pss="RTP_NC_Hardwood:RTP_NC_Woodland:Local RTP", dd="5003")
08:38:56.515 Cisco CallManager|Digit analysis: analysis results
08:38:56.515 Cisco CallManager||PretransformCallingPartyNumber=5000

The key thing to note is that PotentialMatchesExist is the result of Digit Analysis 
of the numbers that were dialed until the exact match is found and the call is 
routed accordingly.

The following trace describes what happens when the Cisco CallManager is 
attempting to dial the directory number 1001 and it is not in the Calling Search 
Space for that device. Again, the key thing to note is that the digit analysis routine 
had potential matches until only the first digit was dialed. The route pattern 
associated with the digit 1 is in a partition that is not in the device calling search 
space, RTP_NC_Hardwood;RTP_NC_Woodland;Local_RTP. Therefore, the 
phone received a reorder tone (busy signal).

08:38:58.734 Cisco CallManager|StationInit - InboundStim - 
OffHookMessageID tcpHandle=0x6b88028
08:38:58.734 Cisco CallManager|StationD - stationOutputDisplayText 
tcpHandle=0x6b88028, Display= 5000 
08:38:58.734 Cisco CallManager|StationD - stationOutputSetLamp stim: 
9=Line instance=1 lampMode=LampOn tcpHandle=0x6b88028
08:38:58.734 Cisco CallManager|StationD - stationOutputCallState 
tcpHandle=0x6b88028
08:38:58.734 Cisco CallManager|StationD - 
stationOutputDisplayPromptStatus tcpHandle=0x6b88028
08:38:58.734 Cisco CallManager|StationD - stationOutputSelectSoftKeys 
tcpHandle=0x6b88028
08:38:58.734 Cisco CallManager|StationD - 
stationOutputActivateCallPlane tcpHandle=0x6b88028
08:38:58.734 Cisco CallManager|Digit analysis: match(fqcn="5000", 
cn="5000", pss="RTP_NC_Hardwood:RTP_NC_Woodland:Local RTP", dd="")
08:38:58.734 Cisco CallManager|Digit analysis: 
potentialMatches=PotentialMatchesExist
08:38:58.734 Cisco CallManager|StationD - stationOutputStartTone: 
33=InsideDialTone tcpHandle=0x6b88028
08:38:59.703 Cisco CallManager|StationInit - InboundStim - 
KeypadButtonMessageID kpButton: 1 tcpHandle=0x6b88028
08:38:59.703 Cisco CallManager|StationD - stationOutputStopTone 
tcpHandle=0x6b88028
08:38:59.703 Cisco CallManager|StationD - stationOutputSelectSoftKeys 
tcpHandle=0x6b88028
08:38:59.703 Cisco CallManager|Digit analysis: match(fqcn="5000", 
cn="5000", pss="RTP_NC_Hardwood:RTP_NC_Woodland:Local RTP", dd="1")
08:38:59.703 Cisco CallManager|Digit analysis: 
potentialMatches=NoPotentialMatchesExist
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08:38:59.703 Cisco CallManager|StationD - stationOutputStartTone: 
37=ReorderTone tcpHandle=0x6b88028

Route partitions work by associating a partition name with every directory 
number in the system. The directory number can be called only if the calling 
device contains the partition within a list of partitions to which it is permitted to 
place calls—its partition search space. This provides for extremely powerful 
control over routing.

When a call is being placed, Digit Analysis attempts to resolve the dialed address 
only in those partitions that the partition search space specifies. Each partition 
name comprises a discrete subset of the global dialable address space. From each 
listed partition, Digit Analysis retrieves the pattern that best matches the sequence 
of dialed digits. Then, from among the matching patterns, Digit Analysis chooses 
the best match. If two patterns equally match the sequence of dialed digits, Digit 
Analysis breaks the tie by choosing the pattern associated with the partition listed 
first in the partition search space.

Dial Plan Issues
This section addresses the following dial plan issues:

• Problem When Dialing a Number

• Secure Dial Plan

Problem When Dialing a Number

Symptom

Problems occur when a number is dialed.

Probable Cause

A Dial Plan is a list of numbers and groups of numbers that tells the 
Cisco CallManager what devices (such as phones and gateways) to send calls to 
when a certain string of digits is collected. It is analogous to a static routing table 
in a router. 
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Please be certain your dial plan concepts, basic call routing, and planning have 
been carefully considered and properly configured before trying to troubleshoot a 
potential dial plan issue. Very often, the problem lies with planning and 
configuration. Refer to the route plan configuration chapters in the 
Cisco CallManager Administration Guide for more information.

Corrective Action

Procedure

Step 1 Identify the Directory Number (DN) that is originating the call.

Step 2 Identify the Calling Search Space for this DN.

Tip The Calling Search Space determines what numbers are available for making a 
call.

Step 3 If applicable, identify which device the Calling Search Space is associated with 
this DN. Make sure that you identify the correct device; because multiple line 
appearances are supported, it is possible to have the same DN on multiple devices. 
Note the device’s Calling Search Space. 

If this is a Cisco IP Phone originating the call, remember that a particular line 
(DN) and the device that line is associated with have Calling Search Spaces. They 
will be combined when making a call. For example, if line instance 1000 has a 
Calling Search Space of AccessLevelX and the Cisco IP Phone that has extension 
1000 configured on it has AccessLevelY as its Calling Search Space, then when 
making a call from that line appearance, Cisco CallManager will search through 
partitions contained in Calling Search Space AccessLevelX and AccessLevelY.

Step 4 Identify which Partitions are associated with the Calling Search Space(s).

Tip The Partition determines allowable calls to a device or route list.

Step 5 Identify to which Partition of the device the call should (or should not) go.
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Step 6 Identify which number is being dialed. Note if and when the user is getting a 
secondary dial tone. Also note what they hear after all the digits have been entered 
(reorder, fast-busy). Does the user get the progress tones before expecting to hear 
anything? Make sure that callers wait at least 10 seconds after entering the last 
digit because they may have to wait for the interdigit timer to expire.

Step 7 Generate a Route Plan Report in Cisco CallManager Administration, and use it to 
examine all the route patterns for the partitions that are in the Calling Search 
Space for the problem call.

Step 8 If necessary, add or modify the Route Patterns or Route Filters.

Step 9 If you can find the Route Pattern to which the call is being sent, note the Route 
List or Gateway to which the pattern points.

Step 10 If it is a Route List, check which Route Groups are part of the list and which 
Gateway(s) is part of the Route Groups.

Step 11 Verify that the applicable devices are registered with Cisco CallManager.

Step 12 If a gateway has no access to Cisco CallManager exists, use the show tech 
command to capture and verify this information.

Step 13 Pay attention to the @ sign. This macro can expand to include many different 
things. It is often used in combination with filtering options.

Step 14 If a device is not part of a partition, it is said to be part of the Null or default 
partition. Every user should be able to call that device. The system always 
searches the Null partition last.

Step 15 If you dial an outside number that is matching a 9.@ pattern and it takes 
10 seconds before the call goes through, check the filtering options. By default, 
with a 9.@ pattern, when a 7-digit number is dialed, the Cisco IP Phone will wait 
10 seconds before placing the call. You need to apply a Route Filter to the pattern 
that displays LOCAL-AREA-CODE DOES-NOT- EXIST and 
END-OF-DIALING DOES-NOT-EXIST.
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Secure Dial Plan
Use partitions and calling search spaces, in addition to more common filtering 
based on sections of the @ macro (which stands for the North American 
Numbering Plan) in a route pattern, to configure Cisco CallManager to create a 
secure dialing plan for users. Partitions and Calling Search Spaces provide an 
integral part of security and are especially useful for multitenant environments 
and for creating an individual user level. Filtering, a subset of the Calling Search 
Space/Partition concept, can add additional granularity to the security plan.

Be advised that usually the last thing you want to do when trying to fix a filtering 
problem is to run an SDI trace. There is simply not enough information, and the 
potential for causing more harm is too great.
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Cisco CallManager Services Issues

This chapter covers the solutions for the following most common issues related to 
Cisco CallManager services:

• Conference Bridge Issues

• Transcoding Issues

• MTP Resource Issues

Conference Bridge Issues
This section addresses the following conference bridge issue: No Available 
Conference Bridge.

No Available Conference Bridge

Symptom

Error Message No Conference Bridge Available

Probable Cause

This could indicate either a software or a hardware problem.
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Corrective Action

Procedure

Step 1 Check to see whether you have any available software or hardware Conference 
Bridge resources registered with Cisco CallManager. 

Step 2 Use either Microsoft Performance or the Admin Serviceability Tool to check the 
number of Unicast AvailableConferences.

Note Cisco CallManager Release 3.1 uses different names for counters and 
objects. Refer to the Cisco CallManager Serviceability Administration 
Guide for more information.

The Cisco IP Voice Media Streaming application performs the conference bridge 
function. One software installation of Cisco IP Voice Media Streaming will 
support 16 Unicast Available Conferences (3 people/conference), as shown in the 
following trace.

Note The number of supported devices may vary with different 
Cisco CallManager releases. Refer to the Release 3.1 documentation at 
the following location: 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_callmg/3_1/in
dex.htm

10:59:29.951 Cisco CallManager|UnicastBridgeControl - 
wait_capabilities_StationCapRes - Device= CFB_kirribilli - Registered 
- ConfBridges= 16, Streams= 48, tcpHandle=4f12738 
10:59:29.951 Cisco CallManager|UnicastBridgeManager - 
UnicastBridgeRegistrationReq - Device Registration Complete for Name= 
Xoð ô%ð  - DeviceType= 50, ResourcesAvailable= 16, deviceTblIndex= 0

One E1 port (WS-X6608-E1 card contains 8x E1 ports) provides five Unicast 
Available Conferences (max conference size = 6), as shown in the following trace.

11:14:05.390 Cisco CallManager|UnicastBridgeControl - 
wait_capabilities_StationCapRes - Device= CFB00107B000FB0 - Registered 
- ConfBridges= 5, Streams= 16, tcpHandle=4f19d64 
11:14:05.480 Cisco CallManager|UnicastBridgeManager - 
UnicastBridgeRegistrationReq - Device Registration Complete for Name= 
Xoð ô%ð  - DeviceType= 51, ResourcesAvailable= 5, deviceTblIndex= 0
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The following hardware trace on the Cisco Catalyst 6000 8 Port Voice T1/E1 and 
Services Module indicates that the E1 port 4/1 in the card has registered as a 
Conference Bridge with Cisco CallManager.

greece-sup (enable) sh port 4/1
Port  Name               Status     Vlan       Duplex Speed Type
----- ------------------ ---------- ---------- ------ ----- ----------
 4/1                     enabled    1            full     -Conf Bridge
 
Port     DHCP    MAC-Address       IP-Address      Subnet-Mask
-------- ------- ----------------- --------------- ---------------
 4/1     disable 00-10-7b-00-0f-b0 10.200.72.31    255.255.255.0   
 
Port     Call-Manager(s)   DHCP-Server     TFTP-Server     Gateway
-------- ----------------- --------------- --------------- -----------
 4/1     10.200.72.25      -               10.200.72.25    -               
 
Port     DNS-Server(s)     Domain
-------- ----------------- -------------------------------------------
 4/1     -                 0.0.0.0
 
Port     CallManagerState DSP-Type
-------- ---------------- --------
4/1     registered       C549
 
Port  NoiseRegen NonLinearProcessing
----- ---------- -------------------
 4/1  disabled   disabled

Step 3 Check the maximum number of users that are configured in your ad hoc or 
meet-me conference to determine whether the problem occurred because this 
number was exceeded.
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Transcoding Issues
This section addresses the following transcoding issue: Hardware Transcoder Not 
Working As Expected.

Hardware Transcoder Not Working As Expected

Symptom

You have installed a hardware transcoder in the Cisco Catalyst 6000 8 Port Voice 
T1/E1 and Services Module, and it does not work as expected (you cannot make 
calls between two users with no common codec).

Probable Cause

You may not have any available transcoder resources registered with 
Cisco CallManager (must be hardware). 

Corrective Action

Use Microsoft Performance or the Admin Serviceability Tool to check the number 
of MediaTermPointsAvailable that are available. 

Note Cisco CallManager Release 3.1 uses different names for counters and objects. 
Refer to the Cisco CallManager Serviceability Administration Guide for more 
information.

One E1 port (WS-X6608-E1 card contains 8x E1 ports) provides transcoder/MTP 
resources for 16 calls, as shown in the following trace.

Note The number of supported devices may vary with different Cisco CallManager 
releases. Refer to the Release 3.1 documentation at the following location: 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_callmg/3_1/index.htm
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11:51:09.939 Cisco CallManager|MediaTerminationPointControl - 
Capabilities Received - Device= MTP00107B000FB1 - Registered - 
Supports 16 calls

The following hardware trace on the Cisco Catalyst 6000 8 Port Voice T1/E1 and 
Services Module indicates that the E1 port 4/2 in the card has registered as an 
MTP/transcoder with Cisco CallManager.

greece-sup (enable) sh port 4/2
Port  Name               Status     Vlan       Duplex Speed Type
----- ------------------ ---------- ---------- ------ ----- ----------
 4/2                     enabled    1            full     - MTP
 
Port     DHCP    MAC-Address       IP-Address      Subnet-Mask
-------- ------- ----------------- --------------- ---------------
 4/2     disable 00-10-7b-00-0f-b1 10.200.72.32    255.255.255.0   
 
Port     Call-Manager(s)   DHCP-Server     TFTP-Server     Gateway
-------- ----------------- --------------- --------------- -----------
 4/2     10.200.72.25      -               10.200.72.25    -               
 
Port     DNS-Server(s)     Domain
-------- ----------------- -------------------------------------------
 4/2     -                 0.0.0.0
 
Port     CallManagerState DSP-Type
-------- ---------------- --------
 4/2     registered       C549
 
Port  NoiseRegen NonLinearProcessing
----- ---------- -------------------
 4/2  disabled   disabled

Note You cannot configure the same E1 port for both Conference Bridge and 
Transcoder/MTP

To make a call between two devices that are using a low bit rate code (such as 
G.729 and G.723) that do not support the same codec, you need a transcoder 
resource.

Assume Cisco CallManager has been configured such that the codec between 
Region1 and Region2 is G.729. The following scenarios apply:
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• If caller on Phone A initiates a call, Cisco CallManager realizes it is a 
Cisco IP Phone 7960, which supports G.729. After the digits have been 
collected, the Cisco CallManager determines that the call is destined for User 
D who is in Region2. Because the destination device also supports G.729, the 
call gets set up, and the audio flows directly between Phone A and Phone D.

• If a caller on Phone B, who has a Cisco IP Phone 12SP+, initiates a call to 
Phone D, this time the Cisco CallManager would realize that the originating 
phone only supports G.723 or G.711. Cisco CallManager would need to 
allocate a transcoding resource so audio would flow as G.711 between Phone 
B and the transcoder but as G.729 between the transcoder and Phone D. If no 
transcoder were available, Phone D would ring, but as soon as the call was 
answered, the call would disconnect.

• If a user on Phone B calls Phone F, which is a Cisco IP Phone 12SP+, the two 
phones would actually use G.723, even though G.729 is configured as the 
codec to use between the regions. G.723 gets used because both endpoints 
support it, and it uses less bandwidth than G.729.

MTP Resource Issues
This section addresses the following MTP resource issue: No Supplementary 
Services Available On An Established Call.

No Supplementary Services Available On An Established Call

Symptom

A call gets established, but supplementary services are not available.

Probable Cause

An MTP resource problem could provide the source of the transcoding problem if 
a call is established, but supplementary services are not available on an H.323 
device that does not support H323v2.
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Corrective Action

Procedure

Step 1 Determine whether you have any available software or hardware MTP resources 
registered with Cisco CallManager. 

Step 2 Use Microsoft Performance or the Admin Serviceability Tool to check the number 
of MediaTermPointsAvailable.

Note Cisco CallManager Release 3.1 uses different names for counters and 
objects. Refer to the Cisco CallManager Serviceability Administration 
Guide for more information.

Using MTP to support supplementary services with H.323 devices that do not 
support H.323v2 allows one MTP software application to support 24 calls as 
shown in the following trace.

Note The number of supported devices may vary with different 
Cisco CallManager releases. Refer to the Release 3.1 documentation at 
the following location: 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_callmg/3_1/in
dex.htm

10:12:19.161 Cisco CallManager|MediaTerminationPointControl - 
Capabilities Received - Device= MTP_kirribilli. - Registered - 
Supports 24 calls

One E1 port (WS-X6608-E1 card contains 8x E1 ports) provides MTP resources 
for 16 calls, as shown in the following trace.

11:51:09.939 Cisco CallManager|MediaTerminationPointControl - 
Capabilities Received - Device= MTP00107B000FB1 - Registered - 
Supports 16 calls

The following hardware trace from the Cisco Catalyst 6000 8 Port Voice T1/E1 
and Services Module indicates that the E1 port 4/2 in the card has registered as an 
MTP/transcoder with Cisco CallManager.

greece-sup (enable) sh port 4/2
Port  Name               Status     Vlan       Duplex Speed Type
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----- ------------------ ---------- ---------- ------ ----- ----------
 4/2                     enabled    1            full     - MTP
 
Port     DHCP    MAC-Address       IP-Address      Subnet-Mask
-------- ------- ----------------- --------------- ---------------
 4/2     disable 00-10-7b-00-0f-b1 10.200.72.32    255.255.255.0   
 
Port     Call-Manager(s)   DHCP-Server     TFTP-Server     Gateway
-------- ----------------- --------------- --------------- -----------
 4/2     10.200.72.25      -               10.200.72.25    -               
 
Port     DNS-Server(s)     Domain
-------- ----------------- -------------------------------------------
 4/2     -                 0.0.0.0
 
Port     CallManagerState DSP-Type
-------- ---------------- --------
 4/2     registered       C549
 
Port  NoiseRegen NonLinearProcessing
----- ---------- -------------------
 4/2  disabled   disabled

Step 3 In the Gateway Configuration screen of Cisco CallManager Administration, 
check to see whether the Media Termination Point Required check box is 
checked.

Step 4 Verify that Cisco CallManager has allocated the required number of MTP devices.
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Voice Messaging Issues

This chapter covers the solutions for the following most common voice messaging 
issues:

• Voice Messaging

• Unity Issues

Voice Messaging
For extensive troubleshooting information for Cisco Unity voice messaging, refer 
to the Cisco Unity Troubleshooting Guide at the following URL:

http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity31/tsg/index.htm

For all documentation related to Cisco Unity, refer to the following URL:

http://www.cisco.com/univercd/cc/td/doc/product/voice/index.htm

Voice Messaging Stops After 30 Seconds

Symptom

When running Cisco Unity 3.x with Cisco CallManager, a caller only has 30 
seconds in which to leave a voice-mail message.
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Probable Cause

This problem occurs when a caller is leaving a voice message and the call is 
terminated 30 seconds into the message. Reproduce this easily by dialing a valid 
extension/number and attempting to leave a voice message that is longer than 30 
seconds.

Corrective Action

Procedure

Step 1 To resolve this problem, verify that the Media Gateway Control Protocol (MGCP) 
is being used on the voice gateway.

Step 2 If the MGCP is being used, add the no mgcp timer receive-rtcp command.

Step 3 If MGCP is not on the voice gateway, enable Skinny traces for the Cisco Unity 
server and Cisco CallManager traces.

Refer to Configuring Unity Traces with MaestroTools.exe at the following URL:
http://www.cisco.com/warp/public/788/AVVID/unity_trace_maestrotools.html 
for further information on configuring Skinny traces in Cisco Unity 3.x and later. 

Beginning with Cisco Unity 3.1, the Cisco Unity Diagnostic Tool replaces 
MaestroTools. For further information on utilizing this tool, refer to Cisco Unity 
Diagnostic Tool at the following URL:
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity31/tsg/tsg3
1/tsg_0900.htm#xtocid13

Unity Issues
This section covers the following topics:

• Unity Does Not Roll Over: Receive Busy Tone

• Calls Forwarded to Voice Messaging Are Treated as a Direct Call to Unity

• Administrator Account Not Associated with Cisco Unity Subscriber

• Noise in Recorded Message on Cisco Unity 3.1.2 or 3.1.3
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Unity Does Not Roll Over: Receive Busy Tone

Symptom

Unity does not get past the first line and will not roll over to the second port.

Example
Call 5000 from 1001
Get Unity
Place the call on Hold
Press New Call
Dial 5000
Get Busy tone
Press End Call
Press Resume Call
Press End Call

Probable Cause

Messaging Interface is configured with the same number as Unity (5000), and it 
is registering the intercept, so the call is hitting CMI.

Corrective Action

Check the CMI service parameters to ensure that the voicemaildn is not 
configured.

Calls Forwarded to Voice Messaging Are Treated as a Direct Call 
to Unity

Symptom

Unity version is 2.4.5.135, TSP is 6.0(1), and Cisco CallManager is 3.1(31)spD.
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Calls from one IP phone to another that are forwarded to voice messaging get 
treated as a direct call to Unity from the phone that is making the call. However, 
this only occurs if the digits are dialed but works properly (receiving the called 
phone’s greeting) if the Redial softkey is pressed.

Probable Cause

The logic in the TSP states that if the call is a forwarded call and the 
originalCalledPartyName is “Voicemail,” then mark the call as a direct call. This 
was done for failover Unity systems using Cisco CallManager.

Corrective Action

Procedure

Step 1 On the Cisco CallManager server, change the name of the Display field on the 
Cisco Voice Mail ports to anything other than “VoiceMail.”

Step 2 On the Unity server, add a new Registry string value of 
HKLM\Software\ActiveVoice\AvSkinny\voiceMail display Name= anything 
other than VoiceMail.

Administrator Account Not Associated with Cisco Unity 
Subscriber

Symptom

While attempting to access the System Administrator (SA) page, you receive an 
error stating that the administrator account is not associated with the Unity 
subscriber.

Probable Cause

Access was not configured for the user.
9-4
Troubleshooting Guide for Cisco CallManager Release 4.0(1)

OL-4617-01



 

Chapter 9      Voice Messaging Issues
Unity Issues
Corrective Action

Procedure

Step 1 To gain appropriate rights to access the SA page, you must run the 
GrantUnityAccess utility. Locate this tool at 
C:\commserver\grantunityaccess.exe

Note For more information about the GrantUnityAccess utility, refer to 
Granting Administrative Rights to Other Cisco Unity Servers at the 
following URL:
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity31/
sag/sag312/sag_0255.htm#xtocid8

Step 2 If you run this utility with no options, the instructions should display. The normal 
use of this tool provides the domain/alias of the account that is to have access to 
the SA, and then provides information about from which account to copy those 
rights.

For example, if the alias of the user to whom you want to give administration 
rights is TempAdministrator and your domain name is MyDOMAIN, you would 
use the following command at the DOS prompt:
GrantUnityAccess -u MyDOMAIN\TempAdministrator -s Installer -f.

The installer account designates a special account that always has administration 
rights but is not created in the directory itself; it is local to the SQL database only.
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Noise in Recorded Message on Cisco Unity 3.1.2 or 3.1.3

Symptom

This problem occurs only if the registry setting values for Automatic Gain Control 
(AGC) are set incorrectly. The bad values are usually

• AGCsamplesize is 4e20 hex (20000 decimal) and should be 1f40 hex (8000 
decimal).

• AGCgainthreshold is 28 hex (40 decimal) and should be 5 hex (5 decimal).

Probable Cause

In some cases on Cisco Unity 3.1.2 servers, and possibly 3.1.3 upgraded servers, 
the AGC registry settings are set to the incorrect values. These incorrect settings 
can cause loud white noise in the following situations: 

• At the beginning of a message. 

• Within the message when the user stops talking while recording the message. 

• At the end of the message. 

Corrective Action

Changing the registry settings to the correct values eliminates the problem. For 
detailed information, refer to the Cisco Unity product documentation at the 
following URL:

http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/index.htm
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Cisco CallManager Attendant Console 
Issues

This chapter covers solutions for the following most common issues related to the 
Cisco CallManager Attendant Console.

• Initialization of Telephony Error Message Displays

• Problems Making and Receiving Calls

– Unable to Place Calls to Pilot Point

– Line Not Available

– Lines Disabled on Phone

• Directory Issues

• Voice Mail Issues

• Problems Using Cisco CallManager Attendant Console Interface

– Speed Dial and Directory Windows Display Incorrect Line State

– Directory Numbers Appear in an Unknown Line State

• Cisco CallManager Serviceability Does Not Generate JTAPI Logs

• Collecting Server Logs
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Initialization of Telephony Error Message Displays
This section addresses the following Cisco CallManager Attendant Console 
telephone initialization error message displays:

• Initialization of Telephony Fails

• Attendant Cannot Access Server Error Message Displays

Initialization of Telephony Fails

Symptom

The attendant received an error message that the initialization of telephony failed.

Probable Cause

You must check the Call Park Retrieval Allowed check box in the ac user profile 
in Cisco CallManager Administration.

Additional causes may include the following:

• The pilot point and/or the controlled phones are not in the controlled device 
list of the 'ac' user. 

• No ‘ac’ user exists.

• There is an ‘ac’ user password mismatch.

• Enable CTI Application is not checked in the Cisco CallManager 
Administration

Corrective Action

Procedure

Step 1 From Cisco CallManager Administration, choose User > Global Directory.

The User Information window displays.

Step 2 In the User Search field, enter ac and click Search.
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Step 3 From the resulting list of matching names, click the ac user name.

Step 4 Check the Call Park Retrieval Allowed check box. 

Step 5 Click Update.

Attendant Cannot Access Server Error Message Displays

Symptom

When the attendant attempted to log in to the server, a dialog box stated that the 
attendant cannot access the server. 

Probable Cause

The version of the attendant console that is on the attendant PC and the version of 
the attendant console that is available through Cisco CallManager Administration 
do not match. 

Corrective Action

Upgrade the version of the attendant console that is running on the attendant PC.

Procedure

Step 1 From each Cisco CallManager Attendant Console PC, browse into a server that is 
running Cisco CallManager Administration and log in with administrative 
privileges. 

Tip To browse into the server, enter 
http://<CM-server-name>/CCMAdmin/main.asp, where 
<CM-server-name> equals the name of the server, in the Address bar in 
the web browser. 

Step 2 From Cisco CallManager Administration, choose Application > Install Plugins.
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Step 3 Click the icon for the Cisco CallManager Attendant Console. 

The Cisco CallManager Attendant Console installation wizard runs.

Step 4 To acknowledge the installation, click Yes.

Step 5 In the initial installation wizard window, click Next.

Step 6 You can install the attendant console to the default location or use the Browse 
button to specify a new location; after specifying a location, click Next.

Step 7 In the Ready to Install window, click Next.

Step 8 After the installation program finishes installing files, choose whether you want 
to restart the computer now or later; then, click Finish.

Step 9 If prompted, restart the computer.

After you install the application, you can configure or update any attendant 
console settings that you did not configure during the installation process.

Problems Making and Receiving Calls
This section addresses the following Cisco CallManager Attendant Console 
issues related to problems when making or receiving calls:

• Unable to Place Calls to Pilot Point

• Line Not Available

• Lines Disabled on Phone

Unable to Place Calls to Pilot Point

Symptom

When a user calls the pilot point the user gets a reorder tone. 
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Probable Cause

The pilot point and/or the controlled phones are not in the controlled device list 
of the 'ac' user. 

Corrective Action

You must configure one user named “ac” in Cisco CallManager Administration 
and associate the attendant phones and the pilot points with the user. If you do not 
configure this user, the attendant console cannot interact with CTIManager, and 
the attendant cannot receive calls. 

Procedure

Step 1 From Cisco CallManager Administration, choose User > Add a New User.

The User Information window displays.

Step 2 In the First Name and Last Name fields, enter ac or another name that you can 
remember.

Step 3 In the User ID field, enter ac.

Step 4 In the User Password field, enter 12345.

Step 5 In the Confirm Password field, enter 12345.

Step 6 Enter a PIN and telephone number.

Step 7 Check the Enable CTI Application Use check box. You must check this box for 
the attendant console to interact with CTIManager.

Step 8 Check the Call Park Retrieval Allowed check box. 

If you forget to check the check box, an error message displays when the attendant 
attempts to log in to the attendant PC.

Step 9 Click Insert.

Step 10 Make sure that you associate the devices with the ac user.
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Line Not Available

Symptom

The attendant received an error message that the selected line is not available.

Probable Cause

The line supports a configurable number of calls at the same time. If the attendant 
line supports two calls and you use Line 1 for transferring a call, and attendant 
placed another call on hold on the same line, the line that the attendant chose will 
be unavailable for use. The line remains unavailable until the attendant completes 
one of the tasks.

Corrective Action

To increase the number of calls supported by a line, peform the following 
procedure:

Procedure

Step 1 Choose Device > Phone.

The Find and List Phones window displays. 

Step 2 Enter search criteria to locate a specific phone.

A list of phones that match the search criteria displays. 

Step 3 Click the name of the phone to update.

The Phone Configuration window displays. 

Step 4 From the Directory Numbers list, click the line that you want to update.

The Directory Number Configuration window displays. 

Step 5 In the Maximum Number of Calls field, enter the number of calls you want the 
line to support.

Step 6 Click Update.

Step 7 For the changes to take effect, click Reset Devices. 
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A message indicates the number of devices that you want to restart. 

Step 8 Click OK to restart the devices.

Lines Disabled on Phone

Symptom

The lines on the attendant phone are disabled in Cisco CallManager Attendant 
Console.

Probable Cause

The pilot point and/or the controlled phones are not in the controlled device list 
of the ac user.

Corrective Action

Use the following procedure to create an ac user and associate the pilot points and 
attendant phones with this user.

Procedure

Step 1 From Cisco CallManager Administration, choose User > Add a New User.

The User Information window displays.

Step 2 In the First Name and Last Name fields, enter ac or another name that you can 
remember.

Step 3 In the User ID field, enter ac.

Step 4 In the User Password field, enter 12345.

Step 5 In the Confirm Password field, enter 12345.

Step 6 Enter a PIN and telephone number.

Step 7 Check the Enable CTI Application Use check box. You must check this box for 
the attendant console to interact with CTIManager.
10-7
Troubleshooting Guide for Cisco CallManager Release 4.0(1)

OL-4617-01



 

Chapter 10      Cisco CallManager Attendant Console Issues
Problems Making and Receiving Calls
Step 8 Check the Call Park Retrieval Allowed check box. 

If you forget to check the check box, an error message displays when the attendant 
attempts to log in to the attendant PC.

Step 9 Click Insert.

Step 10 Make sure that you associate the devices with the ac user.

Step 11 In the Application Profiles column of the User Information window, click Device 
Association.

Step 12 Perform one of the following tasks:

a. To view all devices, click Select Devices, and go to Step 13.

b. To limit the list of available devices to a specific selection, enter the criteria 
by which you want to search by using the following methods: 

• Choose device name, description, or directory number.

• Choose the comparison operator.

• Enter a text or number entry.

• Click Select Devices, and go to Step 13.

Step 13 Check the check box(es) of the attendant console phones/pilot points that you 
must associate with the user.

Step 14 Click Update to assign the phones/pilot points to the ac user.
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Directory Issues
This section addresses the following Cisco CallManager Attendant Console issue: 
Directory Window Does Not Display Users, and provides various probable causes 
and corrective actions.

Directory Window Does Not Display Users

Symptom

Users that were added in Cisco CallManager Administration do not appear in the 
Directory window of Cisco CallManager Attendant Console.

Probable Cause #1

The server only extracts the user list from the directory when one of the following 
conditions occurs: 

• The Cisco TCD service starts and the Directory Sync Period service 
parameter specifies a non-zero interval.

• The interval specified in the Directory Sync Period service parameter expires.

• You change the value of the Directory Synch Period service parameter in 
Cisco CallManager Administration.

The Cisco CallManager Attendant Console loads the user list only at login. 

Corrective Action #1

The attendant needs to login again after any one of the previous conditions occurs.

Probable Cause #2

Cisco CallManager Attendant Console does not display users without telephone 
numbers. 
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Corrective Action #2

Make sure that all relevant users have phone numbers listed for them in the 
directory. 

Procedure

Step 1 From Cisco CallManager Administration, choose User > Global Directory.

The User Information window displays.

Step 2 In the User Search field, enter the appropriate search criteria and click Search.

Step 3 From the resulting list of matching names, click the name of the user to which you 
want to add a phone number.

Step 4 In the Telephone Number field, enter the user telephone number.

Step 5 Click Update.

Voice Mail Issues
This section addresses the following Cisco CallManager Attendant Console voice 
mail issue: Incorrect Voice Mail Greeting Played.

Incorrect Voice Mail Greeting Played

Symptom

When a call is not answered at the attendant and forwarded to voice mail, the 
voice mail system plays the attendant greeting instead of the pilot point greeting.

Probable Cause

The Reset Original Called service parameter specifies True. 
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Corrective Action

Procedure

Step 1 Choose Service > Service Parameters.

Step 2 From the Server drop-down list box, choose the Attendant Console server.

Step 3 From the Service drop-down list box, choose the Cisco Telephony Call Dispatcher 
service.

Step 4 From the Reset Original Called drop-down list box, choose False.

Problems Using Cisco CallManager Attendant 
Console Interface

This section addresses the following Cisco CallManager Attendant Console 
interface issues:

• Text Displays Incorrect Language

• Speed Dial and Directory Windows Display Incorrect Line State

• Directory Numbers Appear in an Unknown Line State

Text Displays Incorrect Language

Symptom

Some text displays in English, while other text displays in the language that the 
attendant chose in the Cisco CallManager Attendant Console dialog box.

Probable Cause

The latest locale installer that is available for the chosen language is not installed. 
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Corrective Action

You must install the latest locale installer that is available for your chosen 
language. Refer the Cisco IP Telephony Locale Installer documentation that is 
available on the web at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/locinst/index.htm.

Speed Dial and Directory Windows Display Incorrect Line State

Symptom

The Speed Dial window and the Directory window do not display the correct line 
state.

Probable Cause

Line state updates from the server to the client are sent using UDP packets. If a 
NAT device or a firewall separates the client and server, then the client will most 
likely not receive line state updates from the server. 

Corrective Action

Ensure that both client and server are on the same side of the NAT device or the 
firewall. 

Directory Numbers Appear in an Unknown Line State

Symptom

Line states of some directory numbers appear in an unknown state.

Probable Cause

The Cisco TCD service is not started on all Cisco CallManager servers from 
which the phones receive call-processing services.
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Corrective Action

Start the Cisco TCD services on all CallManager servers from which the phones 
receive call-processing services.

Procedure 

Step 1 From the Cisco CallManager Administration window, choose Application > 
Cisco CallManager Serviceability.

The Cisco CallManager Serviceability window displays. 

Step 2 Choose Tools > Control Center.

The Control Center window displays the list of servers in the Cisco CallManager 
cluster. 

Step 3 From the Servers column, choose the server where you want to start the 
Cisco TCD service.

The window displays the services for the server that you chose, the status of the 
services, and a service control panel to stop or start a service. 

Step 4 Click the radio button next to the Cisco TCD service.

Step 5 Click the Start button.

The Service Status symbol changes from a square to an arrow. 

Cisco CallManager Serviceability Does Not 
Generate JTAPI Logs

This section addresses the following Cisco CallManager Attendant Console issue: 
JTAPI Logs Do Not Generate.
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JTAPI Logs Do Not Generate

Symptom

You changed the trace level from Error to Detailed, but the JTAPI logs are still not 
generated. 

Probable Cause

JTAPI trace levels are set at the initialization time of JTAPI and are not changed 
later. 

Corrective Action

Use the following procedure to restart the Cisco Telephony Call Dispatcher 
service:

Procedure

Step 1 From the Cisco CallManager Administration window, choose Application > 
Cisco CallManager Serviceability.

The Cisco CallManager Serviceability window displays. 

Step 2 Choose Tools > Control Center.

The Control Center window displays the list of servers in the Cisco CallManager 
cluster. 

Step 3 From the Servers column, choose the server where you want to restart the 
Cisco TCD service.

The window displays the services for the server that you chose, the status of the 
services, and a service control panel to stop or start a service. 

Step 4 Click the radio button next to the Cisco TCD service.

Step 5 Click the Restart button.
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Collecting Server Logs
This section addresses the following Cisco CallManager Attendant Console issue 
for collecting server logs: Solution To Collect All Server Logs.

Solution To Collect All Server Logs

Symptom

Need a solution to collect all server-side logs.

Probable Cause

To debug server issues, collect the following traces:

• CCM

• CTI

• SDL CCM

• SDL CTI

• TCD

• JTAPI

Corrective Action

Execute accollectlogs.bat from 
C:\Program Files\Cisco\CallManagerAttendant\bin directory

There are three optional parameters required:

• -directory <directory_name>—Directory where the Cisco CallManager 
traces exists

• -time <n_minutes>—Collect last <n_minutes> worth of logs

• -output <zip_file_name>—The name of the output zip file
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Opening a Case With TAC

When you open a case with the Cisco TAC, you must provide preliminary 
information to better identify and qualify the issue. You may need to provide 
additional information, depending on the nature of the issue. Waiting to collect the 
following information upon the engineer's request after opening a case inevitably 
results in resolution delay.

• Required Preliminary Information

– Network Layout

– Problem Description

– General Information

• TAC Web

• CCO Cases

• Attachments

• Cisco Live!

• Remote Access

Required Preliminary Information
For all issues, always provide the following information to TAC. Collect and save 
this information for use upon opening a TAC case and update it regularly with any 
changes.

• Network Layout
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• Problem Description

• General Information

Network Layout
A detailed description of the physical and logical setup, as well as all the 
following network elements involved in the voice network (if applicable):

• Cisco CallManager(s)

– Version (from Cisco CallManager Administration choose Details)

– Number of Cisco CallManagers

– Setup (stand-alone, cluster)

• Unity

– Version (from the Cisco CallManager Administration)

– Integration type

• Applications

– List of installed applications

– Version numbers of each application

• IP/voice gateways

– OS version

– Show tech (IOS gateway)

– Cisco CallManager load (Skinny gateway)

• Switch

– OS version

– VLAN configuration 

• Dial plan—Numbering scheme, call routing 

Ideally, submit a Visio or other detailed diagram, such as JPG. Using the 
whiteboard, you may also provide the diagram through a Cisco Live! session.
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Problem Description
Provide step-by-step detail of actions that the user performed when the issue 
occurs. Ensure the detailed information includes

• Expected behavior

• Detailed observed behavior

General Information
Make sure that the following information is readily available:

• Is this a new installation?

• If this is a previous version of a Cisco CallManager installation, has this issue 
occurred since the beginning? (If not, what changes were recently made to the 
system?)

• Is the issue reproducible?

– If reproducible, is it under normal or special circumstances?

– If not reproducible, is there anything special about when it does occur?

– What is the frequency of occurrence?

• What are the affected devices?

– If specific devices are affected (not random), what do they have in 
common?

– Include DNs or IP addresses (if gateways) for all devices that are 
involved in the problem.

• What devices are on the Call-Path (if applicable)?
A-3
Troubleshooting Guide for Cisco CallManager Release 4.0(1)

OL-4617-01



 

Appendix A      Opening a Case With TAC
TAC Web
TAC Web
Use TAC Web, a detailed collection of tools and technical documents written by 
TAC engineers, to analyze common issues and provide solutions. See the 
presentation covering TAC Web tools and content that is available to help you use 
this tool at the following URL:

http://www.cisco.com/public/support/tac/home.shtml

CCO Cases
Opening a case through CCO gives it priority over all other case-opening 
methods. High priority cases (P1 and P2) provide an exception to this rule.

Provide an accurate problem description when opening a CCO case. That 
description of the problem returns URL links that may provide you with an 
immediate solution.

If you do not find a solution to your problem, continue the process of sending your 
case to a TAC engineer.

Attachments
Attach reports to a case by sending an email to the engineer and attaching a zip 
file for documents larger than 100 Kb.

At the following URL, use the Manage a TAC Case section, please login link to 
log in as a registered user:

http://www.cisco.com/public/support/tac/contact.shtml
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Cisco Live!
Cisco Live!, a secure, encrypted Java applet, allows you and your Cisco TAC 
engineer to work together more effectively by using Collaborative Web Browsing 
/ URL sharing, whiteboard, Telnet, and clipboard tools.

Access Cisco Live! at the following URL:

http://c3.cisco.com/

Remote Access
Remote access provides you with the ability to establish Terminal Services 
(remote port 3389), HTTP (remote port 80), and Telnet (remote port 23) sessions 
to all the necessary equipment.

Caution When setting up dial-in, do not use login:cisco or password:cisco because they 
constitute a vulnerability to the system.

You may resolve many issues very quickly by allowing the TAC engineer remote 
access to the devices through one of the following methods:

• Equipment with public IP address.

• Dial-in access—In decreasing order of preference: analog modem, Integrated 
Services Digital Network (ISDN) modem, virtual private network (VPN).

• Network Address Translation (NAT)—IOS and private Internet exchange 
(PIX) to allow access to equipment with private IP addresses.

Ensure that firewalls do not obstruct IOS traffic and PIX traffic during engineer 
intervention and that all necessary services, such as Terminal Services, start on 
the servers.

Note TAC handles all access information with the utmost discretion, and no changes 
will be made to the system without customer consent.
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Cisco Secure Telnet
Cisco Secure Telnet offers Cisco Service Engineers (CSE) transparent firewall 
access to Cisco CallManager servers on your site.

Cisco Secure Telnet works by enabling a Telnet client inside the Cisco Systems 
firewall to connect to a Telnet daemon behind your firewall. This secure 
connection allows remote monitoring and maintenance of your 
Cisco CallManager servers without requiring firewall modifications.

Note Cisco accesses your network only with your permission. You must provide a 
network administrator at your site to help initiate the process.

Firewall Protection
Virtually all internal networks use firewall applications to restrict outside access 
to internal host systems. These applications protect your network by restricting IP 
connections between the network and the public internet. 

Firewalls work by automatically blocking TCP/IP connections that are initiated 
from the outside, unless the software is reconfigured to allow such access. 

Corporate networks normally permit communication with the public Internet but 
only if connections directed to outside hosts originate from inside the firewall.

Cisco Secure Telnet Design
Cisco Secure Telnet takes advantage of the fact that Telnet connections can easily 
be initiated from behind a firewall. Using an external proxy machine, the system 
relays TCP/IP communications from behind your firewall to a host behind another 
firewall at the Cisco Technical Assistance Center (TAC).

Using this relay server maintains the integrity of both firewalls while supporting 
secure communication between the shielded remote systems.
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Figure A-1 Cisco Secure Telnet System

Cisco Secure Telnet Structure
The external relay server establishes the connection between your network and 
Cisco Systems by building a Telnet tunnel. This enables you to transmit the IP 
address and password identifier of your Cisco CallManager server to your CSE. 

Note The password comprises a text string upon which your administrator and the CSE 
mutually agree.

Your administrator starts the process by initiating the Telnet tunnel, which 
establishes a TCP connection from inside your firewall out to the relay server on 
the public Internet. The Telnet tunnel then establishes another connection to your 
local Telnet server, creating a two-way link between the entities.

Note The Telnet client at the Cisco TAC runs in compliance with systems running on 
Windows NT and Windows 2000 or with UNIX operating systems.

After the Cisco CallManager at your site accepts the password, the Telnet client 
that is running at the Cisco TAC connects to the Telnet daemon that is running 
behind your firewall. The resulting transparent connection allows the same access 
as if the machine were being used locally.
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Where to Find More Information
Once the Telnet connection is stable, the CSE can implement all remote 
serviceability functionality to perform maintenance, diagnostic, and 
troubleshooting tasks on your Cisco CallManager server.

You can view the commands sent by the CSE and the responses issued by your 
Cisco CallManager server, but the commands and responses may not always be 
completely formatted. 

Where to Find More Information
For detailed information, refer to the Cisco CallManager Serviceability 
Administration Guide.
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Case Study: Troubleshooting 
Intracluster Phone Calls

The case study in this appendix discusses in detail the call flow between two 
Cisco IP Phones within a cluster, called an intracluster call. This case study also 
focuses on Cisco CallManager and Cisco IP Phone initialization, registration, and 
keepalive processes. A detailed explanation of an intracluster call flow follows the 
discussion. The explanation of the processes are explained using the trace utilities 
and tools discussed in Chapter 2, “Troubleshooting Tools”.

This appendix contains the following topics:

• Sample Topology

• Cisco IP Phone Initialization Process

• Cisco CallManager Initialization Process

• Cisco CallManager Initialization Process

• Self-Starting Processes

• Cisco CallManager Registration Process

• Cisco CallManager KeepAlive Process

• Cisco CallManager Intracluster Call Flow Traces
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Sample Topology
Sample Topology
Given that you have two clusters named Cluster 1 and Cluster 2, the two 
Cisco CallManagers in Cluster 1 are called CCM3 and CCM4, while the two 
Cisco CallManagers in Cluster 2 are called CCM1 and CCM2.

The traces collected for this case study come from CCM1, which is located in 
Cluster 2, as shown in Figure B-1. The basis for the call flow are the two 
Cisco IP Phones in Cluster 2. The IP addresses of these two Cisco IP Phones are 
172.16.70.230 (directory number 1000) and 172.16.70.231 (directory number 
1001), respectively.

Figure B-1 Sample Topology of Intra-Cluster Cisco IP Phone-to-Cisco IP Phone 
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Cisco IP Phone Initialization Process
The following procedure explains in detail the Cisco IP Phone initialization (or 
boot up) process.

Procedure

Step 1 If you have set the appropriate options in DHCP server (such as Option 066 or 
Option 150), the Cisco IP Phone sends a request, at initialization to the DHCP 
server to get an IP address, Domain Name System (DNS) server address, and 
TFTP server name or address. It also gets a default gateway address if you have 
set these options in the DHCP server (Option 003).

Step 2 If a DNS name of the TFTP sever is sent by DHCP, you need a DNS server IP 
address to map the name to an IP address. Bypass this step if the DHCP server 
sends the IP address of the TFTP server. In this case study, the DHCP server sent 
the IP address of TFTP because DNS was not configured.

Step 3 If a TFTP server name is not included in the DHCP reply, the Cisco IP Phone uses 
the default server name.

Step 4 The configuration file (.cnf) file gets retrieved from the TFTP server. All .cnf files 
have the name SEP<mac_address>.cnf. If this is the first time the phone is 
registering with the Cisco CallManager, a default file, SEPdefault.cnf, gets 
downloaded to the Cisco IP Phone. In this case study, the first Cisco IP Phone 
uses the IP address 172.16.70.230 (its MAC address is SEP0010EB001720), and 
the second Cisco IP Phone uses the IP address 172.16.70.231 (its MAC address is 
SEP003094C26105).

Step 5 All .cnf files include the IP address(es) for the primary and secondary 
Cisco CallManager(s). The Cisco IP Phone uses this IP address to contact the 
primary Cisco CallManager and to register. 

Step 6 Once the Cisco IP Phone connects and registers with Cisco CallManager, the 
Cisco CallManager tells the Cisco IP Phone which executable version (called a 
load ID) to run. If the specified version does not match the executing version on 
the Cisco IP Phone, the Cisco IP Phone will request the new executable from the 
TFTP server and reset automatically
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Cisco CallManager Initialization Process
This section explains the initialization process of Cisco CallManager with the 
help of traces that are captured from CCM1 (identified by the IP address 
172.16.70.228). As described previously, SDI traces provide a very effective 
troubleshooting tool because they detail every packet sent between endpoints.

This section describes the events that occur when Cisco CallManager is 
initialized. Understanding how to read traces will help you to properly 
troubleshoot the various Cisco CallManager processes and the effect of those 
processes on services such as conferencing and call forwarding. 

The following messages from the Cisco CallManager SDI trace utility show the 
initialization process on one of the Cisco CallManagers, in this case, CCM1.

• The first message indicates that Cisco CallManager started its initialization 
process. 

• The second message indicates that Cisco CallManager read the default 
database values (for this case, it is the primary or publisher database).

• The third message indicates Cisco CallManager received the various 
messages on TCP port 8002. 

• The fourth message shows that, after receiving to these messages, 
Cisco CallManager added a second Cisco CallManager to its list: CCM2 
(172.16.70.229). 

• The fifth message indicates that Cisco CallManager has started and is running 
Cisco CallManager version 3.1(1).

16:02:47.765 CCM|CMProcMon - CallManagerState Changed - Initialization 
Started.
16:02:47.796 CCM|NodeId:  0, EventId: 107 EventClass: 3 EventInfo: 
Cisco CM Database Defaults Read
16:02:49.937 CCM| SDL Info - NodeId: [1], Listen IP/Hostname: 
[172.16.70.228], Listen Port: [8002]
16:02:49.984 CCM|dBProcs - Adding SdlLink to NodeId: [2], IP/Hostname: 
[172.16.70.229]
16:02:51.031 CCM|NodeId:  1, EventId:  1 EventClass:  3 EventInfo: 
Cisco CallManager Version=<3.1(1)> started
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Self-Starting Processes
Once Cisco CallManager is up and running, it starts several other processes 
within itself. Some of these processes follow, including MulticastPoint Manager, 
UnicastBridge Manager, digit analysis, and route list. You will find the messages 
described during these processes very useful when you are troubleshooting a 
problem related to the features in Cisco CallManager.

For example, assume that the route lists are not functioning and are unusable. To 
troubleshoot this problem, you would monitor these traces to determine whether 
the Cisco CallManager has started RoutePlanManager and if it is trying to load 
the RouteLists. The sample configuration below shows that 
RouteListName=''ipwan'' and RouteGroupName=''ipwan'' are loading and 
starting.

16:02:51.031 CCM|MulicastPointManager - Started
16:02:51.031 CCM|UnicastBridgeManager - Started
16:02:51.031 CCM|MediaTerminationPointManager - Started
16:02:51.125 CCM|MediaCoordinator(1) - started
16:02:51.125 CCM|NodeId:    1, EventId: 1543 EventClass:  2 EventInfo: 
Database manager started
16:02:51.234 CCM|NodeId:    1, EventId: 1542 EventClass:  2 EventInfo: 
Link manager started
16:02:51.390 CCM|NodeId:    1, EventId: 1541 EventClass:  2 EventInfo: 
Digit analysis started
16:02:51.406 CCM|RoutePlanManager - Started, loading RouteLists
16:02:51.562 CCM|RoutePlanManager - finished loading RouteLists
16:02:51.671 CCM|RoutePlanManager - finished loading RouteGroups
16:02:51.671 CCM|RoutePlanManager - Displaying Resulting RoutePlan
16:02:51.671 CCM|RoutePlanServer - RouteList Info, by RouteList and 
RouteGroup Selection Order
16:02:51.671 CCM|RouteList - RouteListName=''ipwan''
16:02:51.671 CCM|RouteList - RouteGroupName=''ipwan''
16:02:51.671 CCM|RoutePlanServer - RouteGroup Info, by RouteGroup and 
Device Selection Order
16:02:51.671 CCM|RouteGroup - RouteGroupName=''ipwan''

The following trace shows the RouteGroup adding the device 172.16.70.245, 
which is CCM3 located in Cluster 1 and is considered an H.323 device. In this 
case, the RouteGroup is created to route calls to CCM3 in Cluster 1 with 
Cisco IOS Gatekeeper permission. If a problem occurs while routing the call to a 
Cisco IP Phone located in Cluster 1, the following messages would help you find 
the cause of the problem. 
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16:02:51.671 CCM|RouteGroup - DeviceName=''172.16.70.245''
16:02:51.671 CCM|RouteGroup -AllPorts

Part of the initialization process shows that Cisco CallManager is adding "Dns" 
(Directory Numbers). By reviewing these messages, you can determine whether 
the Cisco CallManager has read the directory number from the database.

16:02:51.671 CCM|NodeId:    1, EventId: 1540 EventClass:  2 EventInfo: 
Call control started
16:02:51.843 CCM|ProcessDb -        Dn = 2XXX,      Line = 0,    
Display = ,  RouteThisPattern, NetworkLocation = OffNet,  
DigitDiscardingInstruction = 1,   WhereClause = 
16:02:51.859 CCM|Digit analysis: Add local pattern 2XXX , PID: 1,80,1
16:02:51.859 CCM|ForwardManager - Started
16:02:51.984 CCM|CallParkManager - Started
16:02:52.046 CCM|ConferenceManager - Started

In the following traces, the Device Manager in Cisco CallManager statically 
initializes two devices. The device with IP address 172.17.70.226 represents a 
gatekeeper, and the device with IP address 172.17.70.245 gets another 
Cisco CallManager in a different cluster. That Cisco CallManager gets registered 
as an H.323 Gateway with this Cisco CallManager.

16:02:52.250 CCM|DeviceManager: Statically Initializing Device;  
DeviceName=172.16.70.226
16:02:52.250 CCM|DeviceManager: Statically Initializing Device;  
DeviceName=172.16.70.245

Cisco CallManager Registration Process
Another important part of the SDI trace involves the registration process. When a 
device is powered up, it gets information via DHCP, connects to the TFTP server 
for its .cnf file, and then connects to the Cisco CallManager that is specified in the 
.cnf file. The device could be an MGCP gateway, a Skinny gateway, or a 
Cisco IP Phone. Therefore, you need to be able to discover whether devices have 
successfully registered on the Cisco AVVID network.

In the following trace, Cisco CallManager has received new connections for 
registration. The registering devices are MTP_nsa-cm1 (MTP services on CCM1), 
and CFB_nsa-cm1 (Conference Bridge service on CCM1). Although these are 
software services that are running on Cisco CallManager, they get treated 
internally as different external services and therefore get assigned a TCPHandle, 
socket number, and port number as well as a device name.
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16:02:52.750 CCM|StationInit - New connection accepted. DeviceName=, 
TCPHandle=0x4fbaa00, Socket=0x594, IPAddr=172.16.70.228, Port=3279, 
StationD=[0,0,0]
16:02:52.750 CCM|StationInit - New connection accepted. DeviceName=, 
TCPHandle=0x4fe05e8, Socket=0x59c, IPAddr=172.16.70.228, Port=3280, 
StationD=[0,0,0]
16:02:52.781 CCM|StationInit - Processing StationReg. regCount: 1 
DeviceName=MTP_nsa-cm1, TCPHandle=0x4fbaa00, Socket=0x594, 
IPAddr=172.16.70.228, Port=3279, StationD=[1,45,2]
16:02:52.781 CCM|StationInit - Processing StationReg. regCount: 1 
DeviceName=CFB_nsa-cm1, TCPHandle=0x4fe05e8, Socket=0x59c, 
IPAddr=172.16.70.228, Port=3280, StationD=[1,96,2]

Cisco CallManager KeepAlive Process
The station, device, or service and the Cisco CallManager use the following 
messages to maintain a knowledge of the communications channel between them. 
The messages begin the KeepAlive sequence that ensures that the 
communications link between the Cisco CallManager and the station remains 
active. The following messages can originate from either the Cisco CallManager 
or the station.

16:03:02.328 CCM|StationInit - InboundStim - KeepAliveMessage - 
Forward KeepAlive to StationD. DeviceName=MTP_nsa-cm2, 
TCPHandle=0x4fa7dc0, Socket=0x568, IPAddr=172.16.70.229, Port=1556, 
StationD=[1,45,1]
16:03:02.328 CCM|StationInit - InboundStim - KeepAliveMessage - 
Forward KeepAlive to StationD. DeviceName=CFB_nsa-cm2, 
TCPHandle=0x4bf8a70, Socket=0x57c, IPAddr=172.16.70.229, Port=1557, 
StationD=[1,96,1]
16:03:06.640 CCM|StationInit - InboundStim - KeepAliveMessage - 
Forward KeepAlive to StationD. DeviceName=SEP0010EB001720, 
TCPHandle=0x4fbb150, Socket=0x600, IPAddr=172.16.70.230, Port=49211, 
StationD=[1,85,2]
16:03:06.703 CCM|StationInit - InboundStim - KeepAliveMessage - 
Forward KeepAlive to StationD. DeviceName=SEP003094C26105, 
TCPHandle=0x4fbbc30, Socket=0x5a4, IPAddr=172.16.70.231, Port=52095, 
StationD=[1,85,1]

The messages in the following trace depict the KeepAlive sequence that indicates 
that the communications link between the Cisco CallManager and the station is 
active. Again, these messages can originate from either the Cisco CallManager or 
the station.
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16:03:02.328 CCM|MediaTerminationPointControl - 
stationOutputKeepAliveAck tcpHandle=4fa7dc0
16:03:02.328 CCM|UnicastBridgeControl - stationOutputKeepAliveAck 
tcpHandle=4bf8a70
16:03:06.703 CCM|StationInit - InboundStim - IpPortMessageID: 
32715(0x7fcb) tcpHandle=0x4fbbc30
16:03:06.703 CCM|StationD - stationOutputKeepAliveAck 
tcpHandle=0x4fbbc30

Cisco CallManager Intracluster Call Flow Traces
The following SDI traces explore the intracluster call flow in detail. You can 
identify the Cisco IP Phones in the call flow by the directory number (dn), 
tcpHandle, and IP address. A Cisco IP Phone (dn: 1001, tcpHandle: 0x4fbbc30, 
IP address: 172.16.70.231) located in Cluster 2 is calling another Cisco IP Phone 
in the same Cluster (dn=1000, tcpHandle= 0x4fbb150, IP address= 
172.16.70.230). Remember that you can follow a device through the trace by 
looking at the TCP handle value, time stamp, or name of the device. The TCP 
handle value for the device remains the same until the device is rebooted or goes 
offline.

The following traces show that the Cisco IP Phone (1001) has gone off hook. The 
trace below shows the unique messages, TCP handle, and the called number, 
which display on the Cisco IP Phone. No calling number appears at this point 
because the user has not tried to dial any digits. The information below appears in 
the form of Skinny Station messages between the Cisco IP Phones and the 
Cisco CallManager. 

16:05:41.625 CCM|StationInit - InboundStim - OffHookMessageID 
tcpHandle=0x4fbbc30
16:05:41.625 CCM|StationD - stationOutputDisplayText 
tcpHandle=0x4fbbc30, Display= 1001

The next trace shows Skinny Station messages going from Cisco CallManager to 
a Cisco IP Phone. The first message is to turn on the lamp on the calling party 
Cisco IP Phone.

16:05:41.625 CCM|StationD - stationOutputSetLamp stim: 9=Line 
instance=1 lampMode=LampOn tcpHandle=0x4fbbc30

Cisco CallManager uses the stationOutputCallState message to notify the station 
of certain call-related information.
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16:05:41.625 CCM|StationD - stationOutputCallState tcpHandle=0x4fbbc30

Cisco CallManager uses the stationOutputDisplayPromptStatus message to cause 
a call-related prompt message to display on the Cisco IP Phone.

16:05:41.625 CCM|StationD - stationOutputDisplayPromptStatus 
tcpHandle=0x4fbbc30

Cisco CallManager uses the stationOutputSelectSoftKey message to cause the 
Skinny Station to choose a specific set of soft keys.

16:05:41.625 CCM|StationD - stationOutputSelectSoftKeys 
tcpHandle=0x4fbbc30

Cisco CallManager uses the next message to instruct the Skinny Station as to the 
correct line context for the display.

16:05:41.625 CCM|StationD - stationOutputActivateCallPlane 
tcpHandle=0x4fbbc30

In the following message, the digit analysis process is ready to identify incoming 
digits and check them for potential routing matches in the database. The entry, 
cn=1001, represents the calling party number where dd="" represents the dialed 
digit, which would show the called part number. The phone sends StationInit 
messages, Cisco CallManager sends StationD messages, and Cisco CallManager 
performs digit analysis.

16:05:41.625 CCM|Digit analysis: match(fqcn="", cn="1001", pss="", 
dd="")
16:05:41.625 CCM|Digit analysis: 
potentialMatches=PotentialMatchesExist

The following debug message shows that the Cisco CallManager is providing 
inside dial tone to the calling party Cisco IP Phone.

16:05:41.625 CCM|StationD - stationOutputStartTone: 33=InsideDialTone 
tcpHandle=0x4fbbc30

After Cisco CallManager detects an incoming message and recognizes that the 
keypad button 1 has been pressed on the Cisco IP Phone, it immediately stops the 
output tone.

16:05:42.890 CCM|StationInit - InboundStim - KeypadButtonMessageID 
kpButton: 1 tcpHandle=0x4fbbc30
16:05:42.890 CCM|StationD - stationOutputStopTone tcpHandle=0x4fbbc30
16:05:42.890 CCM|StationD - stationOutputSelectSoftKeys 
tcpHandle=0x4fbbc30
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16:05:42.890 CCM|Digit analysis: match(fqcn="", cn="1001", pss="", 
dd="1")
16:05:42.890 CCM|Digit analysis: 
potentialMatches=PotentialMatchesExist
16:05:43.203 CCM|StationInit - InboundStim - KeypadButtonMessageID 
kpButton: 0 tcpHandle=0x4fbbc30
16:05:43.203 CCM|Digit analysis: match(fqcn="", cn="1001", pss="", 
dd="10")
16:05:43.203 CCM|Digit analysis: 
potentialMatches=PotentialMatchesExist
16:05:43.406 CCM|StationInit - InboundStim - KeypadButtonMessageID 
kpButton: 0 tcpHandle=0x4fbbc30
16:05:43.406 CCM|Digit analysis: match(fqcn="", cn="1001", pss="", 
dd="100")
16:05:43.406 CCM|Digit analysis: 
potentialMatches=PotentialMatchesExist
16:05:43.562 CCM|StationInit - InboundStim - KeypadButtonMessageID 
kpButton: 0 tcpHandle=0x4fbbc30
16:05:43.562 CCM|Digit analysis: match(fqcn="", cn="1001", pss="", 
dd="1000")

After the Cisco CallManager has received enough digits to match, it provides the 
digit analysis results in a table format. Cisco CallManager ignores any extra digits 
that are pressed on the phone after this point because a match has already been 
found.

16:05:43.562 CCM|Digit analysis: analysis results
16:05:43.562 CCM||PretransformCallingPartyNumber=1001
|CallingPartyNumber=1001
|DialingPattern=1000
|DialingRoutePatternRegularExpression=(1000)
|PotentialMatches=PotentialMatchesExist
|DialingSdlProcessId=(1,38,2)
|PretransformDigitString=1000
|PretransformPositionalMatchList=1000
|CollectedDigits=1000
|PositionalMatchList=1000
|RouteBlockFlag=RouteThisPattern

The next trace shows that Cisco CallManager is sending out this information to a 
called party phone (the tcpHandle number identifies the phone).

16:05:43.578 CCM|StationD - stationOutputCallInfo 
CallingPartyName=1001,  CallingParty=1001, CalledPartyName=1000, 
CalledParty=1000, tcpHandle=0x4fbb150

The next trace indicates that Cisco CallManager is ordering the lamp to blink for 
incoming call indication on the called party Cisco IP Phone.
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16:05:43.578 CCM|StationD - stationOutputSetLamp stim: 9=Line 
instance=1 lampMode=LampBlink tcpHandle=0x4fbb150

In the following traces, Cisco CallManager provides ringer, display notification, 
and other call-related information to the called party Cisco IP Phone. Again, you 
can see that all messages get directed to the same Cisco IP Phone because the 
same tcpHandle gets used throughout the traces.

16:05:43.578 CCM|StationD - stationOutputSetRinger: 2=InsideRing 
tcpHandle=0x4fbb150
16:05:43.578 CCM|StationD - stationOutputDisplayNotify 
tcpHandle=0x4fbb150
16:05:43.578 CCM|StationD - stationOutputDisplayPromptStatus 
tcpHandle=0x4fbb150
16:05:43.578 CCM|StationD - stationOutputSelectSoftKeys 
tcpHandle=0x4fbb150

Notice that Cisco CallManager also provides similar information to the calling 
party Cisco IP Phone. Again, the tcpHandle differentiates between 
Cisco IP Phones.

16:05:43.578 CCM|StationD - stationOutputCallInfo 
CallingPartyName=1001,  CallingParty=1001, CalledPartyName=, 
CalledParty=1000, tcpHandle=0x4fbbc30
16:05:43.578 CCM|StationD - stationOutputCallInfo 
CallingPartyName=1001,  CallingParty=1001, CalledPartyName=1000, 
CalledParty=1000, tcpHandle=0x4fbbc30

In the next trace, Cisco CallManager provides an alerting or ringing tone to the 
calling party Cisco IP Phone, notifying that the connection has been established.

16:05:43.578 CCM|StationD - stationOutputStartTone: 36=AlertingTone 
tcpHandle=0x4fbbc30
16:05:43.578 CCM|StationD - stationOutputCallState tcpHandle=0x4fbbc30
16:05:43.578 CCM|StationD - stationOutputSelectSoftKeys 
tcpHandle=0x4fbbc30
16:05:43.578 CCM|StationD - stationOutputDisplayPromptStatus 
tcpHandle=0x4fbbc30

At this point, the called party’s Cisco IP Phone goes off hook; therefore, 
Cisco CallManager stops generating the ringer tone to calling party.

16:05:45.140 CCM|StationD - stationOutputStopTone tcpHandle=0x4fbbc30
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In the following messages, Cisco CallManager causes the Skinny Station to begin 
receiving a Unicast RTP stream. To do so, Cisco CallManager provides the IP 
address of the called party as well as codec information and packet size in msec 
(milliseconds). PacketSize designates an integer that contains the sampling time, 
in milliseconds, that is used to create the RTP packets. 

Note Normally this value gets set to 30 msec. In this case, it is set to 20 msec.

16:05:45.140 CCM|StationD - stationOutputOpenReceiveChannel 
tcpHandle=0x4fbbc30 myIP: e74610ac (172.16.70.231)
16:05:45.140 CCM|StationD - ConferenceID: 0 msecPacketSize: 20 
compressionType:(4)Media_Payload_G711Ulaw64k

Similarly, Cisco CallManager provides information to the called party (1000).

16:05:45.140 CCM|StationD - stationOutputOpenReceiveChannel 
tcpHandle=0x4fbb150 myIP: e64610ac (172.16.70.230)
16:05:45.140 CCM|StationD - ConferenceID: 0 msecPacketSize: 20 
compressionType:(4)Media_Payload_G711Ulaw64k

Cisco CallManager has received the acknowledgment message from called party 
for establishing the open channel for RTP stream, as well as the IP address of the 
called party. This message informs the Cisco CallManager of two pieces of 
information about the Skinny Station. First, it contains the status of the open 
action. Second, it contains the receive port address and number for transmission 
to the remote end. The IP address of the transmitter (calling part) of the RTP 
stream is ipAddr, and PortNumber is the IP port number of the RTP stream 
transmitter (calling party).

16:05:45.265 CCM|StationInit - InboundStim - 
StationOpenReceiveChannelAckID tcpHandle=0x4fbb150, Status=0, 
IpAddr=0xe64610ac, Port=17054, PartyID=2

Cisco CallManager uses the following messages to order the station to begin 
transmitting the audio and video streams to the indicated remote Cisco IP Phone 
IP address and port number. 

16:05:45.265 CCM|StationD - stationOutputStartMediaTransmission 
tcpHandle=0x4fbbc30 myIP: e74610ac (172.16.70.231)
16:05:45.265 CCM|StationD - RemoteIpAddr: e64610ac (172.16.70.230) 
RemoteRtpPortNumber: 17054 msecPacketSize: 20 
compressionType:(4)Media_Payload_G711Ulaw64k
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16:03:25.328 CCM|StationD(1):   TCPPid=[1.100.117.1] 
OpenMultiReceiveChannel conferenceID=16777217 passThruPartyID=1000011 
compressionType=101(Media_Payload_H263) qualifierIn=?.   myIP: 
e98e6b80 (128.107.142.233)|<CT::1,100,11,1.1><IP::><DEV::>

16:03:25.375 CCM|StationInit: TCPPid=[1.100.117.1] 
StationOpenMultiMediaReceiveChannelAck Status=0, IpAddr=0xe98e6b80, 
Port=65346, 
PartyID=16777233|<CT::1,100,105,1.215><IP::128.107.142.233>

16:03:25.375 CCM|StationD(2):   TCPPid = [1.100.117.2] 
star_StationOutputStartMultiMediaTransmission conferenceID=16777218 
passThruPartyID=16777250 remoteIpAddress=e98e6b80(66.255.0.0)    
remotePortNumber=65346 compressType=101(Media_Payload_H263) 
qualifierOut=?. myIP: e98e6b80 
(128.107.142.233)|<CT::1,100,105,1.215><IP::128.107.142.233>

In the following traces, the previously explained messages are sent to the called 
party. The messages that indicate that the RTP media stream has been started 
between the called and calling party, follow these messages.

16:05:45.312 CCM|StationD - stationOutputStartMediaTransmission 
tcpHandle=0x4fbb150 myIP: e64610ac (172.16.70.230)
16:05:45.328 CCM|StationD - RemoteIpAddr: e74610ac (172.16.70.231) 
RemoteRtpPortNumber: 18448 msecPacketSize: 20 
compressionType:(4)Media_Payload_G711Ulaw64k
16:05:46.203 CCM|StationInit - InboundStim - OnHookMessageID 
tcpHandle=0x4fbbc30

The calling party Cisco IP Phone finally goes on hook, which terminates all the 
control messages between the Skinny Station and Cisco CallManager as well as 
the RTP stream between Skinny Stations.

16:05:46.203 CCM|StationInit - InboundStim - OnHookMessageID 
tcpHandle=0x4fbbc30
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Case Study: Troubleshooting 
Cisco IP Phone-to-Cisco IOS Gateway 
Calls

The case study described in Appendix A, “Opening a Case With TAC,” described 
the call flow for an intracluster call. The case study in this appendix examines a 
Cisco IP Phone that is calling through a Cisco IOS Gateway to a phone that is 
connected through a local PBX or on the Public Switched Telephone Network 
(PSTN). Conceptually, when the call reaches the Cisco IOS Gateway, the gateway 
will forward the call to either a phone connected to an FXS port or to the PBX. If 
the call is forwarded to the PBX, it could terminate to a phone that is connected 
to a local PBX, or the PBX forwards it over the PSTN, and the call will terminate 
somewhere on the PSTN.

This appendix contains the following topics:

• Call Flow Traces

• Debug Messages and Show Commands on the Cisco IOS Gatekeeper

• Debug Messages and Show Commands on the Cisco IOS Gateway

• Cisco IOS Gateway with T1/PRI Interface

• Cisco IOS Gateway with T1/CAS Interface
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Call Flow Traces
This section discusses call flow through examples from the Cisco CallManager 
trace file CCM000000000. The traces in this case study focus only on the call flow 
itself because Appendix A, “Opening a Case With TAC” (for example, 
initialization, registration, and KeepAlive mechanism) already explained the 
more detailed trace information.

In this call flow, a Cisco IP Phone (directory number 1001) that is located in 
cluster 2 is calling a phone (directory number 3333) that is located somewhere on 
the PSTN. Remember that you can follow a device through the trace by looking 
at the TCP handle value, time stamp, or name of the device. The TCP handle value 
for the device remains the same until the device is rebooted or goes off line.

In the following traces, the Cisco IP Phone (1001) has gone off hook. The trace 
shows the unique messages, TCP handle, and the calling number, which displays 
on the Cisco IP Phone. No called number appears at this point, because the user 
has not tried to dial any digits.

16:05:46.37515:20:18.390 CCM|StationInit - InboundStim - 
OffHookMessageID tcpHandle=0x5138d98

15:20:18.390 CCM|StationD - stationOutputDisplayText 
tcpHandle=0x5138d98, Display=1001        

In the following traces, the user is dialing the DN 3333, one digit at a time. The 
number 3333 specifies the destination number of the phone, which is located 
somewhere on the PSTN network. The digit analysis process of the 
Cisco CallManager is currently active and is analyzing the digits to discover 
where the call needs to get routed. Appendix A, “Opening a Case With TAC” 
provides a more detailed explanation of the digit analysis

15:20:18.390 CCM|Digit analysis: match(fqcn="", cn="1001", pss="", 
dd="")
15:20:19.703 CCM|Digit analysis: match(fqcn="", cn="1001", pss="", 
dd="3")
15:20:20.078 CCM|Digit analysis: match(fqcn="", cn="1001", pss="", 
dd="33")
15:20:20.718 CCM|Digit analysis: match(fqcn="", cn="1001", pss="", 
dd="333")
15:20:21.421 CCM|Digit analysis: match(fqcn="", cn="1001", pss="", 
dd="3333")
15:20:21.421 CCM|Digit analysis: analysis results
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In the following traces, the digit analysis has completed, calling and called party 
are matched, and the information has been parsed.

|CallingPartyNumber=1001
|DialingPattern=3333
|DialingRoutePatternRegularExpression=(3333)
|PretransformDigitString=3333
|PretransformPositionalMatchList=3333
|CollectedDigits=3333
|PositionalMatchList=3333

In the following traces, the number 0 indicates the originating location, and the 
number 1 indicates the destination location. BW = -1 determines the bandwidth 
of the originating location. The value -1 implies that the bandwidth is infinite. The 
bandwidth is infinite because the call originated from a Cisco IP Phone located in 
a LAN environment. BW = 64 determines the bandwidth of the destination 
location. The call destination specifies a phone located in a PSTN, and the codec 
type that is used is G.711 (64 Kbps).

15:20:21.421 CCM|Locations:Orig=0 BW=-1 Dest=1 BW=64 (-1 implies 
infinite bw available)

The following traces show the calling and called party information. In this 
example, the calling party name and number are the same because the 
administrator has not configured a display name, such as John Smith.

15:20:21.421 CCM|StationD - stationOutputCallInfo 
CallingPartyName=1001,  CallingParty=1001, CalledPartyName=, 
CalledParty=3333, tcpHandle=0x5138d98

The following trace shows that the H.323 code has been initialized and is sending 
an H.225 setup message. You can also see the traditional HDLC SAPI messages, 
the IP address of the called side in hexidecimal, and the port numbers.

15:20:21.421 CCM|Out Message -- H225SetupMsg -- Protocol= H225Protocol
15:20:21.421 CCM|MMan_Id= 1. (iep=  0 dsl=  0 sapi=  0 ces=  0 
IpAddr=e24610ac IpPort=47110)

The following trace shows the calling and called party information as well as the 
H.225 alerting message. Also shown is the mapping of a Cisco IP Phone 
hexidecimal value to the IP address. The IP address of the Cisco IP Phone (1001) 
is 172.16.70.231.

15:20:21.437 CCM|StationD - stationOutputCallInfo 
CallingPartyName=1001,  CallingParty=1001, CalledPartyName=, 
CalledParty=3333, tcpHandle=0x5138d98
15:20:21.453 CCM|In  Message -- H225AlertMsg -- Protocol= H225Protocol
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15:20:21.953 CCM|StationD - stationOutputOpenReceiveChannel 
tcpHandle=0x5138d98 myIP: e74610ac (172.16.70.231)

The following trace shows the compression type that is used for this call (G.711 
mu-law).

15:20:21.953 CCM|StationD - ConferenceID: 0 msecPacketSize: 20 
compressionType:(4)Media_Payload_G711Ulaw64k

After the H.225 alert message has been sent, H.323 initializes H.245. The 
following trace shows the calling and called party information, and the H.245 
messages. Notice that the TCP handle value remains the same as before, 
indicating that this is the continuation of the same call.

ONE FOR EACH Channel- 16:53:36.855 CCM|H245Interface(3) paths 
established ip = e98e6b80, port = 
1304|<CT::1,100,105,1.1682><IP::128.107.142.233>
ONE FOR EACH Channel- 16:53:37.199 CCM|H245Interface(3) OLC outgoing 
confirm ip = b870701, port = 49252|<CT::1,100,128,3.9><IP::1.7.135.11>
 
H323 EP has answered the call and H245 channel setup in progress:
16:53:13.479 CCM|In  Message -- H225ConnectMsg -- Protocol= 
H225Protocol|
 
16:03:25.359 CCM|StationD(1):  TCPPid = [1.100.117.1] CallInfo 
callingPartyName='' callingParty=13001 cgpnVoiceMailbox=    
calledPartyName='' calledParty=11002 cdpnVoiceMailbox=    
originalCalledPartyName='' originalCalledParty=11002 
originalCdpnVoiceMailbox= originalCdpnRedirectReason=0    
lastRedirectingPartyName='' lastRedirectingParty=11002 
lastRedirectingVoiceMailbox= lastRedirectingReason=0    
callType=2(OutBound) lineInstance=1 callReference=16777217. version: 
0|<CT::1,100,11,2.1><IP::><DEV::>
 
16:03:25.328 CCM|StationD(1):   TCPPid = [1.100.117.1] 
OpenReceiveChannel conferenceID=16777217 passThruPartyID=16777233 
millisecondPacketSize=20    
compressionType=4(Media_Payload_G711Ulaw64k) qualifierIn=?. myIP: 
e98e6b80 (128.107.142.233)|<CT::1,100,11,1.1><IP::><DEV::>
16:03:25.359 CCM|StationD(2):   TCPPid = [1.100.117.2] 
StartMediaTransmission conferenceID=16777218 passThruPartyID=16777249 
remoteIpAddress=e98e6b80(64.255.0.0)    remotePortNumber=65344 
milliSecondPacketSize=20 compressType=4(Media_Payload_G711Ulaw64k) 
qualifierOut=?. myIP: e98e6b80 
(128.107.142.233)|<CT::1,100,105,1.213><IP::128.107.142.233>
16:03:25.375 CCM|StationD(2):   TCPPid = [1.100.117.2] 
star_StationOutputStartMultiMediaTransmission conferenceID=16777218 
passThruPartyID=16777250 remoteIpAddress=e98e6b80(66.255.0.0)    
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remotePortNumber=65346 compressType=101(Media_Payload_H263) 
qualifierOut=?. myIP: e98e6b80 
(128.107.142.233)|<CT::1,100,105,1.215><IP::128.107.142.233>
16:03:25.328 CCM|StationD(1):   TCPPid=[1.100.117.1] 
OpenMultiReceiveChannel conferenceID=16777217 passThruPartyID=1000011 
compressionType=101(Media_Payload_H263) qualifierIn=?.   myIP: 
e98e6b80 (128.107.142.233)|<CT::1,100,11,1.1><IP::><DEV::>

The following trace shows the H.225 connection message, as well as other 
information. When the H.225 connection message is received, the call connected.

15:20:22.968 CCM|In  Message -- H225ConnectMsg -- Protocol= 
H225Protocol
15:20:22.968 CCM|StationD - stationOutputCallInfo 
CallingPartyName=1001,  CallingParty=1001, CalledPartyName=, 
CalledParty=3333, tcpHandle=0x5138d98
15:20:22.062 CCM|MediaCoordinator - wait_AuConnectInfoInd
15:20:22.062 CCM|StationD - stationOutputStartMediaTransmission 
tcpHandle=0x5138d98 myIP: e74610ac (172.16.70.231)
15:20:22.062 CCM|StationD - RemoteIpAddr: e24610ac (172.16.70.226) 
RemoteRtpPortNumber: 16758 msecPacketSize: 20 
compressionType:(4)Media_Payload_G711Ulaw64k
15:20:22.062 CCM|Locations:Orig=0 BW=-1Dest=1 BW=6(-1 implies infinite 
bw available)
16:03:25.359 CCM|MediaManager(1) - wait_AuConnectInfo - recieved 
response, fowarding, 
CI(16777217,16777218)|<CT::1,100,105,1.213><IP::128.107.142.233>
16:03:25.359 CCM|MediaCoordinator - 
wait_AuConnectInfoInd|<CT::1,100,105,1.213><IP::128.107.142.233>
16:03:25.359 CCM|ConnectionManager - wait_AuConnectInfoInd, 
CI(16777217,16777218)|<CT::1,100,105,1.213><IP::128.107.142.233>

The following message shows that an on-hook message from the Cisco IP Phone 
(1001) is being received. As soon as an on-hook message is received, the H.225 
and Skinny Station device disconnection messages are sent, and the entire H.225 
message is seen. This final message indicates that the call terminated.

15:20:27.296 CCM|StationInit - InboundStim - OnHookMessageID 
tcpHandle=0x5138d98
15:20:27.296 CCM|ConnectionManager -wait_AuDisconnectRequest 
(16777247,16777248): STOP SESSION
15:20:27.296 CCM|MediaManager - wait_AuDisconnectRequest - StopSession 
sending disconnect to (64,5) and remove connection from list
15:20:27.296 CCM| Device SEP003094C26105 , UnRegisters with SDL Link 
to monitor NodeID= 1
15:20:27.296 CCM|StationD - stationOutputCloseReceiveChannel 
tcpHandle=0x5138d98 myIP: e74610ac (172.16.70.231)
C-5
Troubleshooting Guide for Cisco CallManager Release 4.0(1)

OL-4617-01



 

Appendix C      Case Study: Troubleshooting Cisco IP Phone-to-Cisco IOS Gateway Calls
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15:20:27.296 CCM|StationD - stationOutputStopMediaTransmission 
tcpHandle=0x5138d98 myIP: e74610ac (172.16.70.231)
15:20:28.328 CCM|In  Message -- H225ReleaseCompleteMsg -- Protocol= 
H225Protocol
16:03:33.344 CCM|StationInit - InboundStim - StationOnHookMessageID: 
Msg Size(received, defined) = 4, 
12|<CT::1,100,105,1.219><IP::128.107.142.233>
16:03:33.359 CCM|ConnectionManager - 
wait_AuDisconnectRequest(16777217,16777218): STOP 
SESSION|<CT::1,100,105,1.219><IP::128.107.142.233>
16:03:33.359 CCM|StationD(2):   TCPPid = [1.100.117.2] 
CloseReceiveChannel conferenceID=16777218 passThruPartyID=16777249.  
myIP: e98e6b80 
(128.107.142.233)|<CT::1,100,105,1.219><IP::128.107.142.233>
16:03:33.359 CCM|StationD(2):   TCPPid = [1.100.117.2] 
StopMediaTransmission conferenceID=16777218 passThruPartyID=16777249.  
myIP: e98e6b80 
(128.107.142.233)|<CT::1,100,105,1.219><IP::128.107.142.233>
16:03:33.359 CCM|StationD(2):   TCPPid = [1.100.117.2] 
star_StationOutputCloseMultiMediaReceiveChannel conferenceID=16777218 
passThruPartyID=16777249.  myIP: e98e6b80 
(128.107.142.233)|<CT::1,100,105,1.219><IP::128.107.142.233>
16:03:33.359 CCM|StationD(2):   TCPPid = [1.100.117.2] 
star_StationOutputStopMultiMediaTransmission conferenceID=16777218 
passThruPartyID=16777250.  myIP: e98e6b80 
(128.107.142.233)|<CT::1,100,105,1.219><IP::128.107.142.233>

Debug Messages and Show Commands on the 
Cisco IOS Gatekeeper

In the Call Flow Traces discussion covers the Cisco CallManager SDI trace in 
detail. In the topology for this case study, the debug ras command has been turned 
on in the Cisco IOS Gatekeeper. 

The following debug messages show that the Cisco IOS Gatekeeper is receiving 
the admission request (ARQ) for the Cisco CallManager (172.16.70.228), 
followed by other successful Remote Access Server (RAS) messages. Finally, the 
Cisco IOS Gatekeeper sends an admission confirmed (ACF) message to the 
Cisco CallManager.

*Mar 12 04:03:57.181: RASLibRASRecvData ARQ (seq# 3365) rcvd from 
[172.16.70.228883] on sock [0x60AF038C]
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*Mar 12 04:03:57.181: RASLibRAS_WK_TInit ipsock [0x60A7A68C] setup 
successful
*Mar 12 04:03:57.181: RASlibras_sendto msg length 16 from 
172.16.70.2251719 to 172.16.70.228883
*Mar 12 04:03:57.181: RASLibRASSendACF ACF (seq# 3365) sent to 
172.16.70.228

The following debug messages show that the call is in progress.

*Mar 12 04:03:57.181: RASLibRASRecvData successfully rcvd message of 
length 55 from 172.16.70.228883

The following debug messages show that the Cisco IOS Gatekeeper has received 
a disengaged request (DRQ) from the Cisco CallManager (172.16.70.228), and 
the Cisco IOS Gatekeeper has sent a disengage confirmed (DCF) to the 
Cisco CallManager.

*Mar 12 04:03:57.181: RASLibRASRecvData DRQ (seq# 3366) rcvd from 
[172.16.70.228883] on sock [0x60AF038C]
*Mar 12 04:03:57.181: RASlibras_sendto msg length 3 from 
172.16.70.2251719 to 172.16.70.228883
*Mar 12 04:03:57.181: RASLibRASSendDCF DCF (seq# 3366) sent to 
172.16.70.228
*Mar 12 04:03:57.181: RASLibRASRecvData successfully rcvd message of 
length 124 from 172.16.70.228883

The command show gatekeeper endpoints on the Cisco IOS Gatekeeper shows 
that all four Cisco CallManagers are registered with the Cisco IOS Gatekeeper. 
Remember that in the topology for this case study, four Cisco CallManagers exist, 
two in each cluster. This Cisco IOS Gatekeeper includes two zones and each zone 
includes two Cisco CallManagers. 

R2514-1#show gatekeeper endpoints

                    GATEKEEPER ENDPOINT REGISTRATION
                    ===================================
CallSignalAddr  Port  RASSignalAddr   Port  Zone Name         Type   
--------------- ----- --------------- ----- ---------         ---- 
172.16.70.228       2     172.16.70.228       1493  gka.cisco.com     
VOIP-GW
    H323-ID: ac1046e4->ac1046f5
172.16.70.229       2     172.16.70.229        3923  gka.cisco.com     
VOIP-GW
    H323-ID: ac1046e5->ac1046f5
172.16.70.245       1     172.16.70.245        1041  gkb.cisco.com     
VOIP-GW
    H323-ID: ac1046f5->ac1046e4
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172.16.70.243        1     172.16.70.243       2043  gkb.cisco.com     
VOIP-GW
    H323-ID: ac1046f5->ac1046e4
Total number of active registrations = 4

Debug Messages and Show Commands on the 
Cisco IOS Gateway

Debug Messages and Show Commands on the Cisco IOS Gatekeeper, the 
Cisco IOS Gatekeeper show commands and debug outputs discusses in detail. 
This section focuses on the debug output and show commands on the 
Cisco IOS Gateway. In the topology for this case study, calls go through the 
Cisco IOS Gateways. The Cisco IOS Gateway interfaces to the PSTN or PBX 
with either T1/CAS or T1/PRI interfaces. The following example shows debug 
output of commands such as debug voip ccapi inout, debug H225 events, and 
debug H225 asn1. 

In the following debug output, the Cisco IOS Gateway accepts the TCP 
connection request from Cisco CallManager (172.16.70.228) on port 2328 for 
H.225. 

*Mar 12 04:03:57.169: H225Lib::h225TAccept: TCP connection accepted 
from 172.16.70.228:2328 on socket [1]
*Mar 12 04:03:57.169: H225Lib::h225TAccept: Q.931 Call State is 
initialized to be [Null].
*Mar 12 04:03:57.177: Hex representation of the received 
TPKT03000065080000100

The following debug output shows that the H.225 data is coming from the 
Cisco CallManager on this TCP session. Notice the protocolIdentifier, which 
indicates the H.323 version being used, in this debug output. The following debug 
shows that H.323 version 2 is being used. The example also shows the called and 
calling party numbers.

- Source Address H323-ID
- Destination Address e164
*Mar 12 04:03:57.177:       H225Lib::h225RecvData: Q.931 SETUP 
received from socket [1]value H323-UserInformation ::= 
*Mar 12 04:03:57.181: {
*Mar 12 04:03:57.181:   h323-uu-pdu 
*Mar 12 04:03:57.181:   {
*Mar 12 04:03:57.181:     h323-message-body setup : 
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*Mar 12 04:03:57.181:       {
*Mar 12 04:03:57.181:         protocolIdentifier { 0 0 8 2250 0 2 },
*Mar 12 04:03:57.181:         sourceAddress 
*Mar 12 04:03:57.181:         {
*Mar 12 04:03:57.181:           h323-ID : "1001"
*Mar 12 04:03:57.181:         },
*Mar 12 04:03:57.185:         destinationAddress 
*Mar 12 04:03:57.185:         {
*Mar 12 04:03:57.185:           e164 : "3333"
*Mar 12 04:03:57.185:         },
*Mar 12 04:03:57.189:       H225Lib::h225RecvData: State changed to 
[Call Present].

The following debug output shows Call Control Application Programming 
Interface (CCAPi). Call Control APi indicates an incoming call. You can also see 
called and calling party information in the following output. CCAPi matches the 
dial peer 0, which is the default dial peer. It matches dial peer 0 because the 
CCAPi could not find any other dial peer for the calling number, so it is using the 
default dial peer. 

*Mar 12 04:03:57.189: cc_api_call_setup_ind (vdbPtr=0x616C9F54, 
callInfo={called=3333, calling=1001, fdest=1 peer_tag=0}, 
callID=0x616C4838)
*Mar 12 04:03:57.193: cc_process_call_setup_ind (event=0x617A2B18) 
handed call to app "SESSION"
*Mar 12 04:03:57.193: sess_appl: ev(19=CC_EV_CALL_SETUP_IND), cid(17), 
disp(0)
*Mar 12 04:03:57.193: ccCallSetContext (callID=0x11, 
context=0x61782BBC)
Mar 12 04:03:57.193: ssaCallSetupInd finalDest cllng(1001), 
clled(3333)
*Mar 12 04:03:57.193: ssaSetupPeer cid(17) peer list:  tag(1)
*Mar 12 04:03:57.193: ssaSetupPeer cid(17), destPat(3333), matched(4), 
prefix(), peer(6179E63C)
*Mar 12 04:03:57.193: ccCallSetupRequest (peer=0x6179E63C, dest=, 
params=0x61782BD0 mode=0, *callID=0x617A87C0)
*Mar 12 04:03:57.193: callingNumber=1001, calledNumber=3333, 
redirectNumber=
*Mar 12 04:03:57.193: accountNumber=,finalDestFlag=1, 
guid=0098.89c8.9233.511d.0300.cddd.ac10.46e6

The CCAPi matches the dial-peer 1 with the destination pattern, which is the 
called number 3333. Keep in mind that peer_tag means dial peer. Notice the 
calling and called party number in the request packet.

*Mar 12 04:03:57.193: peer_tag=1
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*Mar 12 04:03:57.197: ccIFCallSetupRequest: (vdbPtr=0x617BE064, dest=, 
callParams={called=3333, calling=1001, fdest=1, voice_peer_tag=1}, 
mode=0x0)

The following debug output shows that the H.225 alerting messages are returning 
to the Cisco CallManager. 

*Mar 12 04:03:57.197: ccCallSetContext (callID=0x12, 
context=0x61466B30)
*Mar 12 04:03:57.197: ccCallProceeding (callID=0x11, prog_ind=0x0)
*Mar 12 04:03:57.197: cc_api_call_proceeding(vdbPtr=0x617BE064, 
callID=0x12, prog_ind=0x0)
*Mar 12 04:03:57.197: cc_api_call_alert(vdbPtr=0x617BE064, 
callID=0x12, prog_ind=0x8, sig_ind=0x1)
*Mar 12 04:03:57.201: sess_appl: ev(17=CC_EV_CALL_PROCEEDING), 
cid(18), disp(0)
*Mar 12 04:03:57.201: ssa: 
cid(18)st(1)oldst(0)cfid(-1)csize(0)in(0)fDest(0)-cid2(17)st2(1)oldst2
(0)
*Mar 12 04:03:57.201: ssaIgnore cid(18), st(1),oldst(1), ev(17)
*Mar 12 04:03:57.201: sess_appl: ev(7=CC_EV_CALL_ALERT), cid(18), 
disp(0)
*Mar 12 04:03:57.201: ssa: 
cid(18)st(1)oldst(1)cfid(-1)csize(0)in(0)fDest(0)-cid2(17)st2(1)oldst2
(0)
*Mar 12 04:03:57.201: ssaFlushPeerTagQueue cid(17) peer list: (empty)
*Mar 12 04:03:57.201: ccCallAlert (callID=0x11, prog_ind=0x8, 
sig_ind=0x1)
*Mar 12 04:03:57.201: ccConferenceCreate (confID=0x617A8808, 
callID1=0x11, callID2=0x12, tag=0x0)
*Mar 12 04:03:57.201: cc_api_bridge_done (confID=0x7, 
srcIF=0x616C9F54, srcCallID=0x11, dstCallID=0x12, disposition=0, 
tag=0x0)value H323-UserInformation
*Mar 12 04:03:57.201: {
*Mar 12 04:03:57.201:   h323-uu-pdu 
*Mar 12 04:03:57.201:   {
*Mar 12 04:03:57.201:     h323-message-body alerting : 
*Mar 12 04:03:57.201:       {
*Mar 12 04:03:57.201:         protocolIdentifier { 0 0 8 2250 0 2 },
*Mar 12 04:03:57.205:         destinationInfo 
*Mar 12 04:03:57.205:         {
*Mar 12 04:03:57.205:           mc FALSE,
*Mar 12 04:03:57.205:           undefinedNode FALSE
*Mar 12 04:03:57.205:         },

Notice in this packet that Cisco IOS is also sending the H.245 address and port 
number to Cisco CallManager. Sometimes the Cisco IOS Gateway will send the 
unreachable address, which could cause either no audio or one-way audio.
C-10
Troubleshooting Guide for Cisco CallManager Release 4.0(1)

OL-4617-01



 

Appendix C      Case Study: Troubleshooting Cisco IP Phone-to-Cisco IOS Gateway Calls
Debug Messages and Show Commands on the Cisco IOS Gateway
*Mar 12 04:03:57.205:         h245Address ipAddress : 
*Mar 12 04:03:57.205:           {
*Mar 12 04:03:57.205:             ip 'AC1046E2'H,
*Mar 12 04:03:57.205:             port 011008
*Mar 12 04:03:57.205:           },
*Mar 12 04:03:57.213: Hex representation of the ALERTING TPKT to 
send.0300003D0100
*Mar 12 04:03:57.213: 
*Mar 12 04:03:57.213:       H225Lib::h225AlertRequest: Q.931 ALERTING 
sent from socket [1]. Call state changed to [Call Received].
*Mar 12 04:03:57.213: cc_api_bridge_done (confID=0x7, 
srcIF=0x617BE064, srcCallID=0x12, dstCallID=0x11, disposition=0, 
tag=0x0)

The following debug output shows that the H.245 session is coming up. You can 
see the capability indication for codec negotiation, as well as how many bytes will 
be present in each voice packet.

*Mar 12 04:03:57.217: cc_api_caps_ind (dstVdbPtr=0x616C9F54, 
dstCallId=0x11, srcCallId=0x12, caps={codec=0xEBFB, fax_rate=0x7F, 
vad=0x3, modem=0x617C5720 codec_bytes=0, signal_type=3})
*Mar 12 04:03:57.217: sess_appl: ev(23=CC_EV_CONF_CREATE_DONE), 
cid(17), disp(0)
*Mar 12 04:03:57.217: ssa: 
cid(17)st(3)oldst(0)cfid(7)csize(0)in(1)fDest(1)-cid2(18)st2(3)oldst2(
1)
*Mar 12 04:03:57.653: cc_api_caps_ind (dstVdbPtr=0x617BE064, 
dstCallId=0x12, srcCallId=0x11, caps={codec=0x1, fax_rate=0x2, 
vad=0x2, modem=0x1, codec_bytes=160, signal_type=0})

The following debug output shows that both parties negotiated 
correctly and agreed on G.711 codec with 160 bytes of data.

*Mar 12 04:03:57.653: cc_api_caps_ack (dstVdbPtr=0x617BE064, 
dstCallId=0x12, srcCallId=0x11, caps={codec=0x1, fax_rate=0x2, 
vad=0x2, modem=0x1, codec_bytes=160, signal_type=0})
*Mar 12 04:03:57.653: cc_api_caps_ind (dstVdbPtr=0x617BE064, 
dstCallId=0x12, srcCallId=0x11, caps={codec=0x1, fax_rate=0x2, 
vad=0x2, modem=0x, codec_bytes=160, signal_type=0})
*Mar 12 04:03:57.653: cc_api_caps_ack (dstVdbPtr=0x617BE064, 
dstCallId=0x12, srcCallId=0x11, caps={codec=0x1, fax_rate=0x2, 
vad=0x2, modem=0x1, codec_bytes=160, signal_type=0})
*Mar 12 04:03:57.657: cc_api_caps_ack (dstVdbPtr=0x616C9F54, 
dstCallId=0x11, srcCallId=0x12, caps={codec=0x1, fax_rate=0x2, 
vad=0x2, modem=0x1, codec_bytes=160, signal_type=0})
*Mar 12 04:03:57.657: cc_api_caps_ack (dstVdbPtr=0x616C9F54, 
dstCallId=0x11, srcCallId=0x12, caps={codec=0x1, fax_rate=0x2, 
vad=0x2, modem=0x1, codec_bytes=160, signal_type=0})
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The H.323 connect and disconnect messages follow.

*Mar 12 04:03:59.373: cc_api_call_connected(vdbPtr=0x617BE064, 
callID=0x12)
*Mar 12 04:03:59.373: sess_appl: ev(8=CC_EV_CALL_CONNECTED), cid(18), 
disp(0)
*Mar 12 04:03:59.373: ssa: 
cid(18)st(4)oldst(1)cfid(7)csize(0)in(0)fDest(0)-cid2(17)st2(4)oldst2(
3)
*Mar 12 04:03:59.373: ccCallConnect (callID=0x11)
*Mar 12 04:03:59.373: {
*Mar 12 04:03:59.373:   h323-uu-pdu 
*Mar 12 04:03:59.373:   {
*Mar 12 04:03:59.373:     h323-message-body connect : 
*Mar 12 04:03:59.373:       {
*Mar 12 04:03:59.373:         protocolIdentifier { 0 0 8 2250 0 2 },
*Mar 12 04:03:59.373:         h245Address ipAddress : 
*Mar 12 04:03:59.373:           {
*Mar 12 04:03:59.377:             ip 'AC1046E2'H,
*Mar 12 04:03:59.377:             port 011008
*Mar 12 04:03:59.377:           },
*Mar 12 04:03:59.389: Hex representation of the CONNECT TPKT to 
send.03000052080
*Mar 12 04:03:59.393: H225Lib::h225SetupResponse: Q.931 CONNECT sent 
from socket [1]
*Mar 12 04:03:59.393: H225Lib::h225SetupResponse: Q.931 Call State 
changed to [Active].
*Mar 12 04:04:08.769: cc_api_call_disconnected(vdbPtr=0x617BE064, 
callID=0x12, cause=0x10)
*Mar 12 04:04:08.769: sess_appl: ev(12=CC_EV_CALL_DISCONNECTED), 
cid(18), disp(0)

Cisco IOS Gateway with T1/PRI Interface
As explained earlier, two types of calls go through the Cisco IOS Gateways: the 
Cisco IOS Gateway interfaces to the PSTN or PBX with either T1/CAS or T1/PRI 
interfaces. The following example shows the debug outputs when the 
Cisco IOS Gateways use T1/PRI interface.

The debug isdn q931 command on the Cisco IOS Gateway has been turned on, 
enabling Q.931, a Layer Three signaling protocol for D-channel in the ISDN 
environment. Each time a call is placed out of the T1/PRI interface, a setup packet 
must be sent. The setup packet always has (protocol descriptor) pd = 8, and it 
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generates a random hexidecimal value for the callref. The callref tracks the call. 
For example, if two calls are placed, the callref value can determine the call for 
which the RX (received) message is intended. Bearer capability 0x8890 means a 
64 Kbps data call. If it were a 0x8890218F, it would be a 56 Kbps data call and 
0x8090A3 if it is a voice call. In the debug output below, the bearer capability is 
0x8090A3, which is for voice. The example shows called and calling party 
numbers.

The callref uses a different value for the first digit (to differentiate between TX 
and RX) and the second value is the same (SETUP had a 0 for the last digit and 
CONNECT_ACK also has a 0). The router completely depends upon the PSTN or 
PBX to assign a Bearer channel (B-channel). If the PSTN or PBX does not assign 
a channel to the router, the call will not be routed. In this case, a CONNECT 
message is received from the switch with the same reference number as was 
received for ALERTING (0x800B). Finally, you can see the exchange of the 
DISCONNECT message followed by RELEASE and RELEASE _COMP 
messages as the call is being disconnected. A cause ID for the call rejection 
follows RELEASE_COMP messages. The cause ID is a hexidecimal value. The 
meaning of the cause can be found by decoding the hexidecimal value and 
following up with your provider.

 *Mar  1 225209.694 ISDN Se115 TX ->  SETUP pd = 8  callref = 0x000B
 *Mar  1 225209.694         Bearer Capability i = 0x8090A3
 *Mar  1 225209.694         Channel ID i = 0xA98381
 *Mar  1 225209.694         Calling Party Number i = 0x2183, '1001'
 *Mar  1 225209.694         Called Party Number i = 0x80, '3333'
 *Mar  1 225209.982 ISDN Se115 RX <-  ALERTING pd = 8  callref = 
0x800B
 *Mar  1 225209.982         Channel ID i = 0xA98381
 *Mar  1 225210.674 ISDN Se115 RX <-  CONNECT pd = 8  callref = 0x800B
 *Mar  1 225210.678 ISDN Se115 TX ->  CONNECT_ACK pd = 8  callref = 
0x000B
 *Mar  1 225215.058 ISDN Se115 RX <-  DISCONNECT pd = 8  callref = 
0x800B
 *Mar  1 225215.058         Cause i = 0x8090 - Normal call clearing  
225217 %ISDN-6
DISCONNECT Int S10  disconnected from unknown , call lasted 4 sec
 *Mar  1 225215.058 ISDN Se115 TX ->  RELEASE pd = 8  callref = 0x000B
 *Mar  1 225215.082 ISDN Se115 RX <-  RELEASE_COMP pd = 8  callref = 
0x800B
*Mar  1 225215.082  Cause i = 0x829F - Normal, unspecified or Special  
intercept, call blocked group restriction 
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Cisco IOS Gateway with T1/CAS Interface
Two types of calls go through the Cisco IOS Gateways: the Cisco IOS Gateway 
interface to the PSTN or PBX with either T1/CAS or T1/PRI interfaces. The 
following debug outputs occur when the Cisco IOS Gateways has T1/CAS 
interface. The debug cas on the Cisco IOS Gateway has been turned on.

The following debug message shows that the Cisco IOS Gateway is sending an 
off-hook signal to the switch. 

Apr  5 17:58:21.727: from NEAT(0): (0/15): Tx LOOP_CLOSURE (ABCD=1111) 

The following debug message indicates that the switch is sending wink after 
receiving the loop closure signal from the Cisco IOS Gateway.

Apr  5 17:58:21.859: from NEAT(0): (0/15): Rx LOOP_CLOSURE (ABCD=1111)
Apr  5 17:58:22.083: from NEAT(0): (0/15): Rx LOOP_OPEN (ABCD=0000)

The following debug message indicates that the Cisco IOS Gateway is going 
off-hook.

Apr  5 17:58:23.499: from NEAT(0): (0/15): Rx LOOP_CLOSURE (ABCD=1111) 

The following output shows the show call active voice brief on the 
Cisco IOS Gateway when the call is in progress. The output also shows the called 
and calling party number and other useful information.

R5300-5#show call active voice brief
<ID>: <start>hs.<index> +<connect> pid:<peer_id> <dir> <addr> <state> 
tx:<packets>/<bytes> rx:<packets>/<bytes> <state>
 IP <ip>:<udp> rtt:<time>ms pl:<play>/<gap>ms 
lost:<lost>/<early>/<late>  delay:<last>/<min>/<max>ms <codec>
 FR <protocol> [int dlci cid] vad:<y/n> dtmf:<y/n> seq:<y/n> 
sig:<on/off> <codec> (payload size)
 Tele <int>: tx:<tot>/<v>/<fax>ms <codec> noise:<l> acom:<l> 
i/o:<l>/<l> dBm
511D : 156043737hs.1 +645 pid:0 Answer 1001 active
 tx:1752/280320 rx:988/158080
 IP172.16.70.228:18888 rtt:0ms pl:15750/80ms lost:0/0/0 
delay:25/25/65ms g711ulaw
511D : 156043738hs.1 +644 pid:1 Originate 3333 active
 tx:988/136972 rx:1759/302548
 Tele 1/0/0 (30): tx:39090/35195/0ms g711ulaw noise:-43 acom:0  
i/0:-36/-42 dBm
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 P P E N D I X D

Case Study: Troubleshooting 
Intercluster Phone Calls

The case study in this appendix examines a Cisco IP Phone that is calling another 
Cisco IP Phone that is located in a different cluster. This type of call is also known 
as an intercluster Cisco IP Phone call.

This appendix contains the following topics:

• Sample Topology

• Intercluster H.323 Communication

• Call Flow Traces

• Failed Call Flow

Sample Topology
The following sample topology gets used in this case study. Two clusters, each 
having two Cisco CallManagers, and also Cisco IOS Gateways and a 
Cisco IOS Gatekeeper are in place.

Intercluster H.323 Communication
The Cisco IP Phone in Cluster 1 makes a call to the Cisco IP Phone in Cluster 2. 
Intercluster Cisco CallManager communication takes place using the H.323 
Version 2 protocol. A Cisco IOS Gatekeeper also serves for admission control.
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Call Flow Traces
The Cisco IP Phone can connect to the Cisco CallManager via Skinny Station 
protocol, and the Cisco CallManager can connect with the Cisco IOS Gatekeeper 
by using the H.323 Registration, Admission, and Status (RAS) protocol. The 
admission request message (ARQ) gets sent to the Cisco IOS Gatekeeper, which 
sends the admission confirmed message (ACF) after making sure the intercluster 
call can be made using H.323 version 2 protocol. Once this happens, the audio 
path gets made by using the RTP protocol between Cisco IP Phones in different 
clusters.

Call Flow Traces
This section discusses the call flow by using SDI trace examples captured in the 
CCM000000000 file. The traces discussed in this case study focus only on the call 
flow itself.

In this call flow, a Cisco IP Phone (2002) located in Cluster 2 is calling a 
Cisco IP Phone (1001) located in Cluster 1. Remember that you can follow a 
device through the trace by looking at the TCP handle value, time stamp, or name 
of the device. The TCP handle value for the device remains the same until the 
device is rebooted or goes offline.

In the following traces, the Cisco IP Phone (2002) has gone off hook. The trace 
shows the unique messages, TCP handle, and the calling number, which displays 
on the Cisco IP Phone. The following debug output shows the called number 
(1001), H.225 connect, and H.245 confirm messages. The codec type is G.711 
mu-law. 

16:06:13.921 CCM|StationInit - InboundStim - OffHookMessageID 
tcpHandle=0x1c64310
16:06:13.953 CCM|Out Message -- H225ConnectMsg -- Protocol= 
H225Protocol
16:06:13.953 CCM|Ie - H225UserUserIe IEData= 7E 00 37 05 02 C0 06 
16:06:13.953 CCM|StationD - stationOutputCallInfo CallingPartyName=,  
CallingParty=2002, CalledPartyName=1001, CalledParty=1001, 
tcpHandle=0x1c64310
16:06:14.015 CCM|H245Interface(2) OLC indication chan number = 2
16:06:14.015 CCM|StationD - stationOutputOpenReceiveChannel 
tcpHandle=0x1c64310 myIP: e74610ac (172.16.70.231)
16:06:14.015 CCM|StationD - ConferenceID: 0 msecPacketSize: 20 
compressionType:(4)Media_Payload_G711Ulaw64k
16:06:14.062 CCM|StationInit - InboundStim - 
StationOpenReceiveChannelAckID tcpHandle=0x1c64310, Status=0, 
IpAddr=0xe74610ac, Port=20444, PartyID=2
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16:06:14.062 CCM|H245Interface(2) paths established ip = e74610ac, 
port = 20444
16:06:14.187 CCM|H245Interface(2) OLC outgoing confirm ip = fc4610ac, 
port = 29626

The following traces show the calling and called party number, which associates 
with an IP address and a hexidecimal value.

16:06:14.187 CCM|StationD - stationOutputStartMediaTransmission 
tcpHandle=0x1c64310 myIP: e74610ac (172.16.70.231)
16:06:14.187 CCM|StationD - RemoteIpAddr: fc4610ac (172.16.70.252) 

The following traces show the packet sizes and the MAC address of the 
Cisco IP Phone (2002). The disconnect, then on-hook messages, follow these 
traces. 

RemoteRtpPortNumber: 29626 msecPacketSize: 20 
compressionType:(4)Media_Payload_G711Ulaw64k
16:06:16.515 CCM| Device SEP003094C26105 , UnRegisters with SDL Link 
to monitor NodeID= 1
16:06:16.515 CCM|StationD - stationOutputCloseReceiveChannel 
tcpHandle=0x1c64310 myIP: e74610ac (172.16.70.231)
16:06:16.515 CCM|StationD - stationOutputStopMediaTransmission 
tcpHandle=0x1c64310 myIP: e74610ac (172.16.70.231)
16:06:16.531 CCM|In  Message -- H225ReleaseCompleteMsg -- Protocol= 
H225Protocol
16:06:16.531 CCM|Ie - Q931CauseIe -- IEData= 08 02 80 90 
16:06:16.531 CCM|Ie - H225UserUserIe -- IEData= 7E 00 1D 05 05 80 06 
16:06:16.531 CCM|Locations:Orig=1 BW=64Dest=0 BW=-1 (-1 implies 
infinite bw available)
16:06:16.531 CCM|MediaManager - wait_AuDisconnectRequest - StopSession 
sending disconnect to (64,2) and remove connection from list
16:06:16.531 CCM|MediaManager - wait_AuDisconnectReply - received all 
disconnect replies, forwarding a reply for party1(16777219) and 
party2(16777220)
16:06:16.531 CCM|MediaCoordinator - wait_AuDisconnectReply - removing 
MediaManager(2) from connection list
16:06:16.734 CCM|StationInit - InboundStim - OnHookMessageID 
tcpHandle=0x1c64310
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Failed Call Flow
The following section describes an unsuccessful intercluster call flow, as seen in 
the SDI trace. In the following traces, the Cisco IP Phone (1001) goes off hook. 
A TCP handle gets assigned to the Cisco IP Phone. 

16:05:33.468 CCM|StationInit - InboundStim - OffHookMessageID 
tcpHandle=0x4fbbc30
16:05:33.468 CCM|StationD - stationOutputDisplayText 
tcpHandle=0x4fbbc30, Display= 1001        
16:05:33.484 CCM|StationD - stationOutputSetLamp stim: 9=Line 
instance=1 lampMode=LampOn tcpHandle=0x4fbbc30

In the following traces, the user dials the called number (2000) of the 
Cisco IP Phone, and the process of digit analysis tries to match the number.

16:05:33.484 CCM|Digit analysis: match(fqcn="", cn="1001", pss="", 
dd="")
16:05:33.484 CCM|Digit analysis: 
potentialMatches=PotentialMatchesExist
16:05:35.921 CCM|Digit analysis: match(fqcn="", cn="1001", pss="", 
dd="2")
16:05:35.921 CCM|Digit 
analysis:potentialMatches=ExclusivelyOffnetPotentialMatchesExist
16:05:36.437 CCM|Digit analysis: match(fqcn="", cn="1001", pss="", 
dd="20")
16:05:36.437 CCM|Digit 
analysis:potentialMatches=ExclusivelyOffnetPotentialMatchesExist
16:05:36.656 CCM|Digit analysis: match(fqcn="", cn="1001", pss="", 
dd="200")
16:05:36.656 CCM|Digit 
analysis:potentialMatches=ExclusivelyOffnetPotentialMatchesExist
16:05:36.812 CCM|Digit analysis: match(fqcn="", cn="1001", pss="", 
dd="2000")

The digit analysis has now completed, and the results appear in the following 
traces. It is important to note that the following 
PotentialMatches=NoPotentialMatchesExist reference indicates that the 
Cisco CallManager cannot match this directory number. Finally, a reorder tone 
gets sent to the calling party (1001), which is followed by an on-hook message.

16:05:36.812 CCM|Digit analysis: analysis results
16:05:36.812 CCM||PretransformCallingPartyNumber=1001
|CallingPartyNumber=1001
|DialingPattern=2XXX
|DialingRoutePatternRegularExpression=(2XXX)
|PotentialMatches=NoPotentialMatchesExist
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|CollectedDigits=2000
16:05:36.828 CCM|StationD - stationOutputCallInfo 
CallingPartyName=1001,  CallingParty=1001, CalledPartyName=, 
CalledParty=2000, tcpHandle=0x4fbbc30
16:05:36.828 CCM|StationD - stationOutputStartTone: 37=ReorderTone 
tcpHandle=0x4fbbc30
16:05:37.953 CCM|StationInit - InboundStim - OnHookMessageID 
tcpHandle=0x4fbbc30
D-5
Troubleshooting Guide for Cisco CallManager Release 4.0(1)

OL-4617-01



 

Appendix D      Case Study: Troubleshooting Intercluster Phone Calls
Failed Call Flow
D-6
Troubleshooting Guide for Cisco CallManager Release 4.0(1)

OL-4617-01



 

Troubleshooting Guide fo
OL-4617-01
I N D E X
A

access denied

troubleshooting 4-30

add a new user does not work and you are 
unable to access the administration

DC directory 5-10

administration page not displaying

troubleshooting 4-9

allowing remote access

how to A-5

application profiles do not display

troubleshooting 5-8

attachments

reports A-4

B

backup folder

troubleshooting 3-12

backups

quick backup tips 3-2

troubleshooting 3-10

backup utility

unable to locate 3-12
B-channel remains locked when restart_ack 
does not contain channel IE

troubleshooting 6-34

blank enterprise parameters page after upgrade

troubleshooting 3-9

boot failure

recovery 3-4

browser

unable to access administration page 4-11

C

calls forwarded to voice mail treated as direct 
call

troubleshooting 9-3

CCO cases

opening a case A-4

changing IIS parameters

troubleshooting 4-48

changing server name

troubleshooting 3-4, 4-21

changing the IP address

troubleshooting 3-4, 4-21

Cisco CallManager Attendant Console Issues

collecting server logs 10-15

directory issues 10-9
IN-1
r Cisco CallManager Release 4.0(1)



 

Index
initialization of telephony error message 
displays 10-2

interface issues 10-11

problems making and receiving calls 10-4

serviceability does not generate JTAPI 
logs 10-13

voice mail issues 10-10

Cisco CallManager locks B-channel and sends 
restart

troubleshooting 6-30

Cisco CallManager service

overview 1-1

Cisco IP Phone

troubleshooting audio problems 6-5

Cisco Live!

reporting a case A-5

Cisco Secure Telnet

design A-6

overview 2-7

server access A-6

structure A-7

Cisco Syslog Analysis

Cisco Syslog Analyzer 2-11

Cisco Syslog Analyzer Collector 2-11

Cisco Unity does not rollover

troubleshooting 9-3

CiscoWorks2000 2-12

Campus Manager 2-10

Code Red II

recovery 4-50
IN-2
Troubleshooting Guide for Cisco CallManager Relea
collecting

debugs 2-2

sniffer traces 2-1

command line tools

overview 2-8

commands

show 2-8

show command

options 2-9

compatibility matrix

hardware and software 1-3

D

database corrupt after restore

troubleshooting 3-14

databases not in synch

troubleshooting 3-5

DC directory

add a new user does not work and you are 
unable to access the 
administration 5-10

troubleshooting 5-2

debugs

collecting 2-2

default web site under IIS has improper setting

troubleshooting 4-28

device issues

troubleshooting 6-1

diagnosing
se 4.0(1)
OL-4617-01



 

Index
slow server response 4-39

directory issues

troubleshooting 5-1

E

error code 1165

troubleshooting 3-11

F

features

troubleshooting 8-1, 9-1

G

guidelines

problem solving 1-3

H

hardware and software

compatibility matrix 1-3

I

installation

troubleshooting 3-3

IP Telephony networks
Troubleshooti
OL-4617-01
troubleshooting 1-5

L

logs

echo log 6-8

long term solutions

security 4-49

M

monitoring

performance

Cisco CallManager 2-10

N

name to address resolution failing

troubleshooting 4-20

near term solutions

security 4-49

network failure

preparation 1-4

no connectivity

remote server 4-31

O

open a TAC case
IN-3
ng Guide for Cisco CallManager Release 4.0(1)



 

Index
required information A-1

opening a CCO case

url location A-4

overview 2-12

Cisco Secure Telnet 2-7

CiscoWorks2000 2-12

command line tools 2-8

of Cisco CallManager 1-1

serviceability 1-2

show command 2-8

troubleshooting 1-1

P

path analysis

operation 2-10

trace 2-10

performance

monitoring

Cisco CallManager 2-10

tool

function 2-10

statistics monitor and display 2-10

port 80 blocked

troubleshooting 4-29

preparation

network failure 1-4

problem solving

guidelines 1-3
IN-4
Troubleshooting Guide for Cisco CallManager Relea
Q

quick backup tips

troubleshooting 3-2

R

recovery

boot failure 3-4

Code Red II 4-50

remote server

no connectivity 4-31

unable to access administration page 4-16

replication failure

troubleshooting 4-33

required information

open a TAC case A-1

S

security

long term solutions 4-49

near term solutions 4-49

troubleshooting 4-48

security, firewall integrity A-6

serviceability

overview 1-2

show

commands 2-8
se 4.0(1)
OL-4617-01



 

Index
show command

options 2-9

overview 2-8

sniffer traces

collecting 2-1

SNMP

defined 2-11

remote monitoring with 2-11

syslog

analysis

described 2-11

system

troubleshooting 3-1

system issues

troubleshooting 4-1

system logging

described 2-11

system not responding

troubleshooting 4-1, 4-2

T

TAC

allowing remote access A-5

Cisco Live! A-5

required information A-1

TAC case

attaching reports A-4

TAC web
Troubleshooti
OL-4617-01
url location A-4

Telnet

Cisco Secure Telnet 2-7

Telnet, Cisco Secure

design A-6

structure A-6, A-7

testing

gateways 6-8

tips

troubleshooting 2-14

tools

troubleshooting 2-1, 2-3

troubleshooting

access denied 4-30

administration page not displaying 4-9

administrator account not associated with 
Cisco Unity subscriber 9-4

admission rejects 6-29

after restore database corrupt 3-14

application profiles do not display 5-8

ARJs 6-29

audio problems from Cisco IP Phone 6-5

backup error code 1165 3-11

backups 3-10

B-channel remains locked when restart_ack 
does not contain channel IE 6-34

blank enterprise parameters page 3-9

boot failure 3-4

calling search spaces 7-1

changing IIS parameters 4-48
IN-5
ng Guide for Cisco CallManager Release 4.0(1)



 

Index
changing server name 3-4, 4-21

changing the IP address 3-4, 4-21

Cisco CallManager locks B-channel and 
sends restart 6-30

Cisco CallManager system not 
responding 4-1

codec and region mismatches 6-15

Code Red II 4-50

conference bridge problems 8-1

databases not in synch 3-5

DC directory 5-2

default web site under IIS has improper 
setting 4-28

device issues 6-1

dial plan problems 7-4

directory issues 5-1

dropped calls 6-18

echo 6-7

features 8-1, 9-1

gatekeeper issues 6-28

gateway registration failure 6-21

gateway reorder tone issues 6-19

H.225 gateway 6-28

installation 3-3

inter-cluster trunks 6-28

IP Telephony networks 1-5

location and bandwidth issues 6-16

lost or distorted audio problems 6-2

MTP resource problems 8-6

name to address resolution failing 4-20
IN-6
Troubleshooting Guide for Cisco CallManager Relea
no connectivity to other devices 4-31

noise in recorded message 9-6

not authorized to view page 4-14

one-way or no audio 6-9

opening a case A-4

opening a case with TAC A-1

overview 1-1

phone resets 6-16

port 80 blocked 4-29

quick backup tips 3-2

registration rejects 6-29

remote access for TAC A-5

replication failure 4-33

required preliminary information A-1

route partition problems 7-1

RRJs 6-29

secure dial plans 7-7

security 4-48

sending attachments to TAC A-4

system 3-1

system issues 4-1

system stops responding 4-2

TAC url location A-4

tips 2-14

tools 2-3

transcoding problems 8-4

unable to access administration page from 
remote server 4-16

unable to access administration page from the 
browser 4-11
se 4.0(1)
OL-4617-01



 

Index
unable to locate backup folder 3-12

unable to locate backup utility 3-12

unity does not rollover 9-3

upgrades 3-6

using Cisco Live! A-5

voice mail stops after 30 seconds 9-1

voice messaging 9-1

voice quality issues 6-1

U

upgrade

blank enterprise parameters page 3-9

upgrades

troubleshooting 3-6

URL location

opening a CCO case A-4

TAC web A-4

V

voice mail stops after 30 seconds

troubleshooting 9-1

voice messaging

troubleshooting 9-1
Troubleshooti
OL-4617-01
 IN-7

ng Guide for Cisco CallManager Release 4.0(1)



 

Index
IN-8
Troubleshooting Guide for Cisco CallManager Relea
se 4.0(1)

OL-4617-01


	Contents
	Preface
	Purpose
	Audience
	Organization
	Related Documentation
	Conventions
	Obtaining Documentation
	Cisco.com
	Documentation CD-ROM
	Ordering Documentation

	Documentation Feedback
	Obtaining Technical Assistance
	Cisco TAC Website
	Opening a TAC Case
	TAC Case Priority Definitions

	Obtaining Additional Publications and Information

	Troubleshooting Overview
	Cisco�CallManager
	Serviceability
	Hardware and Software Compatibility
	General Model of Problem Solving
	Network Failure Preparation
	IP Telephony Networks
	Where to Find More Information

	Troubleshooting Tools
	Sniffer Traces
	Debugs
	Cisco�CallManager Troubleshooting Tools
	Cisco�Secure Telnet
	Command Line Tools
	Show Command

	Cisco�CallManager System Performance Monitoring
	Path Analysis Operation
	System Log Management Process
	Simple Network Management Protocol Support
	CiscoWorks2000
	Cisco Discovery Protocol Support
	Other Tools
	SQL Query Analyzer


	Troubleshooting Tips
	Where to Find More Information

	Installation, Backup, and Restore Issues
	Quick Upgrade, Backup, and Restore Tips
	Restore Location When You Have Two Different Versions of Cisco�CallManager
	BAT for Faster Transfer of Data
	Upgrade, Backup, and Restore
	Back Up the Publisher
	Third-Party Backup Utilities

	Installation Issues
	Unable to Change the Server Name for Cisco�CallManager
	Symptom
	Probable Cause
	Corrective Action

	Boot Failure Recovery
	One Publisher, Two Subscribers: All Three Databases Have Different Information After an Install o...
	Symptom
	Probable Cause
	Corrective Action


	Upgrade Issues
	Subscriber Upgrade Fails: Unable to Find Updated Database
	Symptom
	Probable Cause
	Corrective Action
	Verification

	Blank Enterprise Parameters Page After Upgrade
	Symptom
	Probable Cause
	Corrective Action
	Verification

	Related Information

	Backup and Restore Issues
	Backup to Local Tape Drive Is Not Working and Terminates with Error Code 1165
	Symptom
	Probable Cause
	Corrective Action
	Verification

	When Installing Cisco�CallManager, No Prompt Displays for a Backup Destination
	Symptom
	Probable Cause
	Corrective Action

	Sti Backup Utility in Cisco�CallManager Stuck on “Cancelling Backup”
	Symptom
	Corrective Action

	After a Restore, Database Is Corrupt
	Symptom
	Probable Cause
	Corrective Action

	Related Information


	Cisco�CallManager System Issues
	Cisco�CallManager System Not Responding
	Cisco�CallManager System Stops Responding
	Symptom
	Probable Cause

	Cisco�CallManager Administration Page Does Not Display
	Symptom
	Probable Cause
	Corrective Action
	Verification

	Errors Occur When Attempting to Access the Cisco�CallManager Administration Page from the Browser
	Symptom
	Probable Cause
	Corrective Action
	Verification

	You Are Not Authorized to View This Page
	Symptom
	Probable Cause
	Corrective Action
	Verification

	Errors Occur When Attempting to Access the Cisco�CallManager Administration Page from a Browser o...
	Problems Displaying or Adding Users With Cisco�CallManager
	Symptom
	Probable Cause
	Corrective Action

	SQLSvc User Can Not Log In
	Symptom
	Probable Cause
	Corrective Action

	Name to Address Resolution Failing
	Symptom
	Probable Cause
	Corrective Action

	Unable to Change the Server Name for Cisco�CallManager
	Symptom
	Probable Cause
	Corrective Action

	Default Web Site Under IIS Has Improper Setting
	Symptom
	Probable Cause
	Corrective Action

	Port 80 Is Blocked in One or More Routers Between Your Local Browser and the Cisco�CallManager Se...
	Symptom
	Probable Cause
	Corrective Action

	You Attempt to Access a Machine Where Access Is Explicitly Denied
	Symptom
	Probable Cause
	Corrective Action

	Improper Network Setting Exists in the Remote Machine From Where You Are Browsing
	Symptom
	Probable Cause
	Corrective Action


	Replication Fails Between the Publisher and the Subscriber
	Cannot Update Data Because the Publisher Is Not Available
	Symptom
	Probable Cause
	Corrective Action

	Subscriber Stops Replicating Data From the Publisher
	Symptom
	Probable Cause
	Corrective Action
	Verification


	Slow Server Response
	Mismatched Duplex Port Settings
	Symptom
	Probable Cause
	Corrective Action


	JTAPI Subsystem Startup Problems
	JTAPI Subsystem is OUT_OF_SERVICE
	Symptom
	Probable Cause

	MIVR-SS_TEL-4-ModuleRunTimeFailure
	Probable Cause
	Corrective Action
	Probable Cause
	Corrective Action
	Probable Cause
	Corrective Action
	Probable Cause
	Corrective Action
	Probable Cause
	Corrective Action
	Probable Cause
	Corrective Action

	MIVR-SS_TEL-1-ModuleRunTimeFailure
	Symptom
	Probable Cause
	Corrective Action

	JTAPI Subsystem is in PARTIAL_SERVICE
	Symptom
	Probable Cause

	MIVR-SS_TEL-3-UNABLE_REGISTER_CTIPORT
	Probable Cause
	Corrective Action


	Security
	Changing IIS Parameters for Security
	Symptom
	Probable Cause
	Corrective Action

	Near-Term Security Solutions
	Long-Term Security Solutions
	Related Information

	Virus Protection

	Directory Issues
	Replication Issues
	DC Directory Stability
	DCD Instability
	Symptom
	Probable Cause
	Corrective Action
	Verification

	Application Profiles Are Not Shown for User Configuration with the DC Directory
	Symptom
	Probable Cause
	Corrective Action
	Verification

	Add a New User Does Not Work and You Cannot Access the DC Directory Administrator
	Symptom
	Probable Cause
	Corrective Action
	Verification


	Related Information

	Device Issues
	Voice Quality
	Lost or Distorted Audio
	Symptom
	Probable Cause
	Corrective Action

	Correcting Audio Problems from the Cisco�IP�Phone
	Symptom
	Probable Cause
	Corrective Action
	Verification

	Echo
	Symptom
	Probable Cause
	Corrective Action

	One-Way Audio or No Audio
	Symptom
	Probable Cause
	Corrective Action
	Verification


	Codec and Region Mismatches
	Location and Bandwidth
	Phone Issues
	Phone Resets
	Symptom
	Probable Cause
	Corrective Action

	Dropped Calls
	Symptom
	Probable Cause
	Corrective Action


	Gateway Issues
	Gateway Reorder Tone
	Symptom
	Probable Cause
	Corrective Action

	Gateway Registration Failure
	Symptom
	Probable Cause
	Corrective Action


	Gatekeeper Issues
	Intercluster Trunks or H.225 Trunks
	Admission Rejects
	Symptom
	Probable Cause
	Corrective Action

	Registration Rejects
	Symptom
	Probable Cause
	Corrective Action


	Cisco�CallManager Locks the B-Channel and Sends Restart
	Channel Restarts
	Symptom
	Probable Cause
	Corrective Action

	B-Channel Remains Locked When Restart_Ack Does Not Contain Channel�IE
	Symptom
	Probable Cause
	Corrective Action
	Verification



	Dial Plans and Routing Issues
	Route Partitions and Calling Search Spaces
	Dial Plan Issues
	Problem When Dialing a Number
	Symptom
	Probable Cause
	Corrective Action

	Secure Dial Plan


	Cisco�CallManager Services Issues
	Conference Bridge Issues
	No Available Conference Bridge
	Symptom
	Probable Cause
	Corrective Action


	Transcoding Issues
	Hardware Transcoder Not Working As Expected
	Symptom
	Probable Cause
	Corrective Action


	MTP Resource Issues
	No Supplementary Services Available On An Established Call
	Symptom
	Probable Cause
	Corrective Action



	Voice Messaging Issues
	Voice Messaging
	Voice Messaging Stops After 30 Seconds
	Symptom
	Probable Cause
	Corrective Action


	Unity Issues
	Unity Does Not Roll Over: Receive Busy Tone
	Symptom
	Probable Cause
	Corrective Action

	Calls Forwarded to Voice Messaging Are Treated as a Direct Call to Unity
	Symptom
	Probable Cause
	Corrective Action

	Administrator Account Not Associated with Cisco�Unity Subscriber
	Symptom
	Probable Cause
	Corrective Action

	Noise in Recorded Message on Cisco�Unity 3.1.2 or 3.1.3
	Symptom
	Probable Cause
	Corrective Action



	Cisco�CallManager Attendant Console Issues
	Initialization of Telephony Error Message Displays
	Initialization of Telephony Fails
	Symptom
	Probable Cause
	Corrective Action

	Attendant Cannot Access Server Error Message Displays
	Symptom
	Probable Cause
	Corrective Action


	Problems Making and Receiving Calls
	Unable to Place Calls to Pilot Point
	Symptom
	Probable Cause
	Corrective Action

	Line Not Available
	Symptom
	Probable Cause
	Corrective Action

	Lines Disabled on Phone
	Symptom
	Probable Cause
	Corrective Action


	Directory Issues
	Directory Window Does Not Display Users
	Symptom
	Probable Cause #1
	Corrective Action #1
	Probable Cause #2
	Corrective Action #2


	Voice Mail Issues
	Incorrect Voice Mail Greeting Played
	Symptom
	Probable Cause
	Corrective Action


	Problems Using Cisco�CallManager Attendant Console Interface
	Text Displays Incorrect Language
	Symptom
	Probable Cause
	Corrective Action

	Speed Dial and Directory Windows Display Incorrect Line State
	Symptom
	Probable Cause
	Corrective Action

	Directory Numbers Appear in an Unknown Line State
	Symptom
	Probable Cause
	Corrective Action


	Cisco�CallManager Serviceability Does Not Generate JTAPI Logs
	JTAPI Logs Do Not Generate
	Symptom
	Probable Cause
	Corrective Action


	Collecting Server Logs
	Solution To Collect All Server Logs
	Symptom
	Probable Cause
	Corrective Action



	Opening a Case With TAC
	Required Preliminary Information
	Network Layout
	Problem Description
	General Information

	TAC Web
	CCO Cases
	Attachments
	Cisco Live!
	Remote Access
	Cisco Secure Telnet
	Firewall Protection
	Cisco Secure Telnet Design
	Cisco Secure Telnet Structure
	Where to Find More Information

	Case Study: Troubleshooting Intracluster Phone Calls
	Sample Topology
	Cisco�IP�Phone Initialization Process
	Cisco�CallManager Initialization Process
	Self-Starting Processes
	Cisco�CallManager Registration Process
	Cisco�CallManager KeepAlive Process
	Cisco�CallManager Intracluster Call Flow Traces

	Case Study: Troubleshooting Cisco�IP�Phone-to-Cisco�IOS�Gateway Calls
	Call Flow Traces
	Debug Messages and Show Commands on the Cisco�IOS�Gatekeeper
	Debug Messages and Show Commands on the Cisco�IOS�Gateway
	Cisco�IOS�Gateway with T1/PRI Interface
	Cisco�IOS�Gateway with T1/CAS Interface

	Case Study: Troubleshooting Intercluster Phone Calls
	Sample Topology
	Intercluster H.323 Communication
	Call Flow Traces
	Failed Call Flow

	Index

